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While Deltek has attempted to verify that the information in this document is accurate and 
complete, some typographical or technical errors may exist. The recipient of this document is 
solely responsible for all decisions relating to or use of the information provided herein. 

The information contained in this publication is effective as of the publication date below and is 
subject to change without notice. 

This publication contains proprietary information that is protected by copyright. All rights are 
reserved. No part of this document may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, or translated into another language, without the prior written 
consent of Deltek, Inc. 

This edition published November 2015. 

© Deltek, Inc. 

Deltek’s software is also protected by copyright law and constitutes valuable confidential and 
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related 
documentation, is provided for use only in accordance with the terms of the license agreement. 
Unauthorized reproduction or distribution of the program or any portion thereof could result in 
severe civil or criminal penalties. 

All trademarks are the property of their respective owners.  
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Overview 
Welcome to the Deltek Vision 7.5 Release Notes: Technical Considerations. These release notes 
contain a summary of the following: 

 Installation information 

 Software issues resolved 

 Known issues 

 Database changes 

 

For information regarding the new features and enhancements in this release, see the Deltek 
Vision 7.5 Release Notes: New Features and Enhancements. 

Important Information  

Before You Upgrade from an Earlier Version of Vision 

 

The Vision 7.5 release contains major technology and configuration changes that affect the 
typical upgrade scenario. Do not uninstall your previous version of Vision. 

If you have any custom DLLs or reports, do not uninstall your previous version since the 
uninstall process may remove all files. 

The installer has built-in intelligence to detect the previous installation – it automatically backs 
up the folder containing your previous installation files and migrates certain custom settings to 
the new version.   

Before performing the upgrade, review the Summary of Upgrade Installation Changes to 
understand how these changes will affect your deployment. 

 

If you are using a Sage Abra (formerly Best Software Abra) application stored in a FoxPro 
database, do not upgrade to Deltek Vision 7.5 

Deltek Vision 7.5 is now running as a native 64-bit application and is unable to integrate with 
the Sage Abra database stored in a FoxPro database for the following reasons: 

• Microsoft FoxPro ODBC/OLEDB drivers are only 32-bit. 

• Microsoft Extended Support for Microsoft Visual FoxPro 9.0 Professional Edition 
ended in January 2015: https://msdn.microsoft.com/en-us/vfoxpro/bb308952.aspx , 
http://support.microsoft.com/lifecycle/?p1=7992  

   

 

See the Deltek Vision Advanced Technical Administration Guide for more complex topics 
related to the Vision deployment, including HTTP compression, central location for weblink 
entries (shared databases.enc), reverse proxies, and integrated security. This document is 
available on the Knowledge Center tab of the Deltek Customer Care Connect site 
(http://support.deltek.com). 

https://msdn.microsoft.com/en-us/vfoxpro/bb308952.aspx
http://support.microsoft.com/lifecycle/?p1=7992
http://support.deltek.com/


Overview 

 

Release Notes: Technical Considerations 2 

 

Revenue Generation and Gains and Losses  
This applies if you are upgrading from a Vision 6.x version to 7.5 and you use all of the following 
in Vision: 

 Revenue Generation 

 Revenue categories for Revenue Generation 

 Multiple currencies 

Before you run Revenue Generation in 7.5, be sure that you have specified a different unbilled 
service account for each revenue category on the Revenue tab in Configuration » Accounting » 
Company Settings. 
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For Additional Information 

Customer Care Connect Site 
The Deltek Customer Care Connect site is a support Web site for Deltek customers who 
purchase an Ongoing Support Plan (OSP). 

The following are some of the many options that the Customer Care Connect site provides: 

 Search for product documentation, such as release notes, install guides, technical 
information, online help topics, and white papers 

 Ask questions, exchange ideas, and share knowledge with other Deltek customers 
through the Deltek Connect Customer Forums 

 Access Cloud specific documents and forums 

 Download the latest versions of your Deltek products 

 Search Deltek’s knowledge base 

 Submit a support case and check on its progress 

 Transfer requested files to a Customer Care analyst 

 Subscribe to Deltek communications about your products and services 

 Receive alerts of new Deltek releases and hot fixes 

 Use Quick Chat to submit a question to a Customer Care analyst online 

 

For more information regarding Deltek Customer Care Connect, refer to the online help available 
from the Web site. 

Access Customer Care Connect 

To access the Customer Care Connect site, complete the following steps: 
1. Go to http://support.deltek.com. 

2. Enter your Customer Care Connect Username and Password. 

3. Click Log In. 

 

If you forget your username or password, you can click the Account Assistance button on the 
login screen for help. 

http://support.deltek.com/
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Documentation for this Release 
Release notes and other guides are available for this release. You can download these 
documents in two ways. 

Deltek Software Manager 
The Documents tab in Deltek Software Manager lists all of the documents associated with a 
release and lets you download the ones that you want.  

To download documents, complete the following steps: 

1. On the Deltek Customer Care site, click the Product Downloads tab, then select Launch 
Deltek Software Manager. 

2. When the Deltek Software Manager opens, highlight a release in the left pane. 

 

Do not enter a check next to the release name or click Add to Download 
Queue. If you do so, you will download the software as well as any 
documentation that you want. 

3. Click the Documents tab to display a list of available documents for the release. 

4. Select the documents that you want. 

5. Click View Download Queue to see a list of documents that you selected. 

6. Click Download. 

Customer Care Site Enterprise Search 
Use the search feature to find specific documents or to see a list of all documents associated with 
a release. Then open or download the ones that you want. 

To download documents, complete the following steps: 

1. On the Deltek Customer Care site, click Enterprise Search. 

2. Select Release Documentation as the Source. 

3. Perform one of the following actions:  

 To see a list of all available documentation for a release, enter the product and 
release number (for example, Vision 7.5) in the search field. 

 To find a specific document, enter a description of the document (for example, Vision 
7.5 release notes) in the search field. 

4. Click on the document, and then choose to open or save it. 

 

https://deltek.custhelp.com/app/home
https://deltek.custhelp.com/app/home
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Pre-Installation Information 
Review the contents of this section before you install Deltek Vision 7.5. 

For a complete list of the supported and non-supported platforms and other technical 
considerations that apply for Vision 7.5, see the following Vision documentation: 

 Deltek Product Support Compatibility Matrix 

 Deltek Vision 7.5 Technical Installation Guide 

You can download these documents from the Deltek Customer Care Connect site. 

Changes to Supported Environments and Technical 
Considerations in Vision 7.5 
The following technical changes apply to Vision, starting with version 7.5: 

Technical 
Consideration  Description 

64-bit Support Vision 7.5 will now run natively as a 64-bit application on the web/application 
server. The Vision client side components are still 32-bit. 

Vision will now install to the \Program Files directory by default. Upgrade 
installations will install clean to \Program Files and will rename the \Program 
Files (x86) installation directly by appending OLD.  

See the Deltek Vision 7.5 Installation Guide for detailed instructions on 
important installation and upgrade notes. 

Client Operating 
System 

Windows 10 and Microsoft Edge browser are supported with Vision 7.5. 

Microsoft Windows 
Server 2008 R2 

Vision can no longer be run on Microsoft Windows Server 2008 R2. 

 

Microsoft NET 
Framework 

Microsoft .NET Framework 4.5.2 is required for Vision 7.5. 

You must install it on all tiers where Vision will be installed and on the client 
tier. 

The following are no longer supported: 

 .NET Framework 4.5, 4.5.1 

 .NET Framework 3.5 SP1 

Microsoft SQL Server The following CU versions are now supported with Vision 7.5: 

 Microsoft SQL Server 2014 SP1 CU1 

 Microsoft SQL Server 2012 SP2 CU6  

Microsoft SQL Server 2008 R2 is no longer supported. 

http://support.deltek.com/
http://www.microsoft.com/en-us/download/details.aspx?id=42642
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Technical 
Consideration  Description 

Tableau Server Tableau Server 9.0.4 is the required version for Vision 7.5 Performance 
Management. 

If you have one of the following, you must upgrade to Tableau Server 9.0.4 
after you upgrade to Vision 7.5: 

 Tableau Server 8.0.2 installed (with Vision 7.1 or 7.2),  

 Tableau Server 8.1.6 installed (with Vision 7.3)  

 Tableau 8.2 installed (with Vision 7.4) 

If you upgraded to Tableau 9.0.4 with Vision 7.4 CU11, no changes are 
required to your Tableau Server installation. 

See the Deltek Vision 7.5 Installation and Configuration Guide for 
Performance Management for detailed instructions on performing the upgrade. 

Export Reports as Files 
The new Export Reports as Files options allow you to save reports, including invoices, on the 
Vision application server or a server of your choice.  

If you want to allow reports to be exported to the application server, you can choose from the 
following options on the Miscellaneous Tab in General System Settings (Configuration » 
General » System Settings): 

 Allow Reports to be Exported to Application Server – Select this option to export 
reports to a file on the application server. The export process occurs when you select the 
Export Reports as Files When Printing option on the Print Setup dialog box. On this 
dialog box, you can define the format for saving the report. For example, you might want 
to save an invoice file on the application server when the invoice is final printed but not 
when the draft invoice is created.  

 Allow Reports to be Uploaded via SFTP – Select this option to use Secure File 
Transfer Protocol (SFTP) to export and save invoices to an application server of your 
choice. When you choose to upload via SFTP, Vision enables options so that you can 
specify the SFTP Host Name, User Name, and Password to ensure that your files are 
securely transferred to the appropriate location. The export process occurs when you 
select the Upload Reports via SFTP when Printing option on the Printer dialog 
box. On this dialog box, you can define the format for saving the report. For example, for 
Billing Invoices you might want to save an invoice file on the application server when the 
invoice is final printed but not when the draft invoice is created. 

Supported Versions and Compatible Versions 
Supported versions are the most current, actively tested technologies that are used to deploy 
Vision. Compatible versions are recent technologies that have been previously supported and 
tested for deploying Vision. Compatible versions are not actively undergoing testing but are 
believed to be compatible with Vision. 

For a full explanation of supported versus compatible versions as well as a detailed list of 
Microsoft SQL Server releases (R), service packs (SP), and cumulative updates (CU) that Vision 
supports, see the Deltek Product Support Compatibility Matrix. You can download this document 
at the Deltek Customer Care Connect site. 

http://support.deltek.com/
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KB article 65226 at the Customer Care Connect site also provides a list of the currently supported 
versions of Microsoft SQL Server. 

Summary of Upgrade Installation Changes 
In previous Vision releases, when you installed an upgrade, the upgrade installed directly into the 
existing folder structure and used existing settings.  

The Vision 7.5 release contains such major technology and configuration changes that installing 
into the existing folder structure is not possible. Instead, Vision 7.5 installs into a new folder 
structure while preserving and “remembering” settings from your previous Vision installation.  

The Vision 7.5 installation: 

 Detects the existing deployment model and makes recommendations and prepopulates 
settings based on that deployment model.  

 Takes settings from your existing web.config and databases.enc files and uses them to 
create a script that you can apply after the installation to upgrade your database. This 
script is created only during the installation on the Web/Application tiers because that is 
where the web.config and databases.enc files are located.  

 Supports upgrades from Vision 6.x and 7.x. on all tiers: Web, Application, Process 
Server, Report, and Database.  

Future upgrades (7.6, 7.7, and so on) will use the previous model, in which the new release is 
installed into the previous installation location. 

Do Not Uninstall Prior Version Before Installing Vision 7.5 
Because the Vision 7.5 installer preserves and applies settings from your existing 
implementation, you should not uninstall Vision before installing Vision 7.5.  

You should also save any custom DLLs or reports for use by Vision 7.5. 

After you perform the installation and confirm that your settings migrated correctly, you can delete 
the old installation directories. 

Migrating/Upgrading To a New Server 
If your existing Vision Web/Application Server is on a version of Windows that is no longer 
supported, you must perform a new installation. Any custom reports, DLLs, web.config settings or 
other configuration changes that are on the server will not be migrated.   

Review the summary of changes below. If you customized your previous version, you will have to 
apply the customization again to the new deployment, keeping in mind the changes listed in the 
tables below. 

If your existing Vision Database/Report server is on a version that is no longer supported, you 
must restore or move your database to the new server prior to performing the installation. 
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Installation Location/Configurations 

Configuration Previous New 

Installation 
Location  

<drive>:\Program Files 
(x86)\Deltek\Vision 

 The new default folder location is  
<drive>:\Program Files\Deltek\Vision 

 The previous folder (typically found in the 32-bit 
program files folder) is renamed. 

 “OLD” is appended to the end of the folder 
name. For example VisionOLD. 

 A readme.txt file is inserted into the renamed 
folder. It contains the text:  “This is a 
previously used Deltek Vision directory that is 
no longer used and can be safely removed 
after ensuring that all of your custom DLLs 
and custom reports have been copied to the 
new directory (<drive>:\Program 
Files\Deltek\Vision\)”  

Programs and 
Features 

Deltek Vision 7.4 The previous version (Deltek Vision 7.4) is removed 
from Add/Remove Programs and replaced with new 
Deltek Vision 7.5 product name and release GUID. 

Registry Key 
Location 

HKLM\Software\Wow6432
\Deltek\Vision 

 HKLM\Software\Deltek\Vision 

 The entries in the previous registry location below 
the Vision folder are removed. 

Application Pool Application Pools is not 
removed 

 The existing Application Pool is updated with the 
following: 

Updates the Enable32bitOnWow64 from True to 
False 

Virtual 
Directories/ 
Applications 

Virtual 
Directories/Applications 
remains. 

The Virtual Directories/Applications physical directory 
changes to the new “<drive>:\Program 
Files\Deltek\Vision” TARGETDIR. 

Process Server 
Configuration 
and executable 

Process Server service   The Process Server executable uses the new 
“<drive>:\Program Files\Deltek\Vision” 
TARGETDIR location. 

 If you changed the Process Server service identity 
account after installing a previous version of 
Vision, Vision prompts you to enter the credentials 
password for the account during the upgrade 
installation on any tier that contains the Process 
Server service.  

If you do not know the password, enter the text 
bypass and the installation continues without 
setting the password on the identity for the 
service. After installation, you must update the 
Deltek Vision Process Server service account with 
the correct password or the service will not start. 
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Custom Web.Config Settings Migration 
Some custom settings added to the web.config file on the web/application server have been 
migrated to the database and can be configured from within the application. Because of this 
change, database upgrades are only supported from any deployment option that includes the 
Web/Application tier installations. 

During any installation using a deployment option with the web/application tier installations, setup 
copies the prior version’s web.config file and uses it. It reads the web.config from the prior 
deployment and dynamically creates a v_WebConfigMigration.sql script file containing the custom 
settings noted below and builds the master upgrade script with those new settings so that the 
database is updated accordingly. You can still choose to upgrade databases post installation. 

On upgrades, unused web.config values are commented out and others not being used anymore 
are removed. 

Original Setting 
New Location in Database 
(Table.Field) 

How to Edit:   

Launch Application » Navigate to 
Configuration » General » 
System Settings » 

MaxEmailSize CFGEmail.MaxEmailSize Email Tab » Email Size Limit 
(Megabytes) 

EmailChunkSize CFGEmail.EmailChunkSize Email Tab » Number of Emails to 
Send at Once 

WebAPI.EnableW
orkflow 

FW_CFGSystem.WebAPIEnableWorkfl
ow 

Miscellaneous Tab » Workflow 
section » Allow APIs to Trigger 
Workflows 

SessionTimeout FW_CFGSystem.SessionTimeout Miscellaneous Tab » Application 
Session Timeout (minutes) 

AllowFileSave FW_CFGSystem.AllowFileSave Miscellaneous Tab » Export Reports 
as Files Section 

Custom Changes applied at Customer Sites 
If you previously customized Vision: 

 Custom DLLs – You need to test all custom workflow DLLs (and any third party DLLs) to 
verify that they work in 64-bit mode. If they are compiled with AnyCPU, they should work. 
After testing, you can copy them into the new installation folder 

 Custom Reports (not in the database) – You need to copy all custom reports not 
stored in the report server database to the new installation folder and Load Report Files  
into the database.  

Option to Use HTTPS for Reporting Services Server-Side Calls 
A new check box, Use HTTPS for Reporting Services server-side calls, has been added to the 
Report Server tab in Weblink. It allows you to use HTTPS for server-side calls.  

Running reports involves both server-side calls (from the web/application server to the SSRS 
server) and client-side calls (from the Vision Smart Client to the SSRS server). By default, all 



Pre-Installation Information 

 

Release Notes: Technical Considerations 10 

 

server-side calls to SSRS will use HTTP and client-side calls to SSRS will use whatever protocol 
(HTTP or HTTPS) was used to access the Vision application. 

 Select Use HTTPS for Reporting Services server-side calls to use HTTPS for server-
side calls to the SSRS server. This will not affect client-side calls. 

 If you are using HTTP to access Vision, do not select this check box. It is designed to be 
used only with an SSL configuration.   

 If you are using HTTPS for Vision and you select this check box, HTTPS will be used for 
both server-side and client-side calls to SSRS. 

Shared databases.enc File Path 
You can now use a shared databases.enc file path. If your Vision deployment includes multiple 
web/application servers, or even just a dedicated process server, the shared path will eliminate 
the need to synchronize changes made to databases.enc across your servers. 

 

See the Deltek Vision Advanced Technical Administration Guide for more information. 

Changes to the Upgrade Installation Process 
This section includes a list of changes affecting the tiers in all the deployment/installation models.  

For example, if you are performing a Web/Application/Process Server installation for the Dual 
Server (Two-Tier) Configuration 1 deployment, the details listed in the Web/Application and 
Process Server tiers below will apply. 

 

For an overview of the logical tiers and deployment models, see: 

 Logical Tiers 

 Installation/Deployment Models 

Database Tier 

 

The installer will not create a deltekvision75.sql database conversion script file. The database 
conversion script file is created only on the web/application server because the web.config file 
exists only on the web/application tier. 

 The Installer attempts to detect previous tier installations (deployment model) and makes 
a recommendation about what you should select on the dialog boxes. 

 A readme.txt file is inserted into the renamed folder, containing the following text:  

“This is a previously used Deltek Vision directory that is no longer used and can be safely 
removed after ensuring that all of your custom DLLs and custom reports have been 
copied to the new directory (<drive>:\Program Files\Deltek\Vision\).”  

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 

 The Installer removes Deltek Vision 7.4 (or previous version) from Add/Remove 
Programs. 
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Report Tier 
 The Installer attempts to detect previous tier installations (deployment model) and makes 

a recommendation about what you should select in the dialog boxes. 

 A readme.txt file is inserted into the renamed folder, explaining that the original 
installation folder was renamed. On the report only tier, the folder may contain custom 
report images that must be moved to the new folder location.  

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 

 The installer removes Deltek Vision 7.4 (or previous version) from Add/Remove 
Programs. 

Web / Application Tier 
 The Installer attempts to detect previous tier installations (deployment model) and makes 

a recommendation about what you should select in the dialog boxes. 

 The Installer attempts to detect a previous installation directory. 

 The Installer copies the databases.enc and web.config files from the previous 
installation and uses them for the new installation.   

 The Installer applies applicable web.config changes detected from your old 
web.config file to the new installation (depending on the previous version from which 
it is upgrading). 

 The Installer creates the deltekvision75.sql script file for upgrading the database only on 
the web/application server tier because the web.config file exists only on the 
web/application tier. 

 The Installer attempts to detect the existing DeltekVisionAppPool and detects Vision and 
VisionClient IIS application/virtual directories. It keeps the existing application pool and 
virtual directory custom configuration changes. 

This step is performed because some environment configurations may use different 
Application Pool identities, non-standard AppPool or virtual directory settings, non-
standard ports, SPNs, SharePoint, and so on. 

 
 
 

 A readme.txt file is inserted into the renamed folder, containing the text: “This is a 
previously used Deltek Vision directory that is no longer used and can be safely removed 
after ensuring that all of your custom DLLs and custom reports have been copied to the 
new directory (<drive>:\Program Files\Deltek\Vision\).” 

 The Installer uninstalls SQLXML 4.0 (SP2). 

 The Installer uninstalls Solid Documents (COM) and replaces it with Solid Documents 
(.NET). 

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 

 The Installer removes Deltek Vision 7.4 (or previous version) from Add/Remove 
Programs. 
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Process Server Tier 
 Process Server is uninstalled from the previous installation directory and then installed 

using the new installation directory. 

 Service Identity 

 New Installations 

 Set to local DeltekVision. Uses the default password for the account created by 
the installer and sets start up mode to Automatic. 

 Upgrades 

 Identity is configured with the Deltek Vision default account. If setup cannot 
validate the local account, it will prompt you to enter a password for the identity. 
You can enter the text bypass as a password if validation fails or if you do not 
want to set the password during installation. You must set the password on the 
Process Server service after the installation or the service will fail to start. 

 Identity is configured with a domain account. Setup prompts you to enter a 
password. You can enter the text bypass as a password if validation fails or if 
you do not want to set the password during installation. You must set the 
password on the Process Server service after the installation or the service will 
fail to start. 

 

 If the Process Server identity is configured with a domain account 
and, when performing the upgrade, you are logged into the server 
using a domain account, when you are asked for the domain 
password for the Process Server service identity, the account 
validation will be performed successfully. 

 If the Process Server is configured with a domain account and, 
when performing the upgrade, you are logged into the server using 
a local (non-domain) account, when you are asked for the domain 
password for the Process Server service identity, the account 
validation will fail, even when the credentials are entered 
correctly. To continue with the installation you must enter the text 
bypass. Then reset the password to the domain account password 
in the Services application after the installation is completed.  

 Identity is configured with the Windows LocalSystem account. Setup sets the 
identity to use the LocalSystem account after the upgrade. 

 The Installer sets the service start up mode to be the same as it was before the 
upgrade. 

 

If you entered the text bypass so that the installer could continue without validating the 
Process Server service identity, after the installation is complete, you must set the 
password on the Process Server service identity or the service will fail to start. 

 
 
 

 A readme.txt file is inserted into the renamed folder, containing the text:  “This is a 
previously used Deltek Vision directory that is no longer used and can be safely removed 
after ensuring that all of your custom DLLs and custom reports have been copied to the 
new directory (<drive>:\Program Files\Deltek\Vision\)” . 

 The Installer renames the previous product installation directory by appending “OLD” to 
the end of the folder name. For example, “C:\Program Files (x86)\Deltek\VisionOLD.” 
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 The Installer removes Deltek Vision 7.4 (or previous version) from Add/Remove 
Programs. 

 

If you are performing a Process Server tier upgrade and had made any edits to the 
Deltek.Vision.ProcessServer.Server.exe.config file to customize Process Server 
behavior, such as the number of emails being sent at a time (EmailChunkSize) or the 
maximum size of an email (MaxEmailSize), log in to the application after the 
installation is completed and follow the steps in the Custom web.config Settings 
Migration section to ensure that they are applied. If they are not applied, apply them 
as needed. 

Considerations Prior to Upgrading 

Known Issue with the Vision Installation 
If you are upgrading from a 6.x version of Vision and you use a Microsoft SQL Server Session 
State that is located in a database other than your Vision database, see KB article # 72573 for 
additional instructions.  

During the Vision upgrade process from version 6.x or earlier, the SessionState table is renamed. 
However, if the table is not located in the Vision transaction database, it will not be renamed. You 
must manually rename the table using the instructions in the KB article. 

Upgrading from Version 5.1 or Earlier 
 If you plan to upgrade your database during the installation, refer to the table in the 

Converting a Database During Installation section below. 

 Vision 5.1 installations did not support the currently supported Windows Operating 
Systems, so all your deployment tiers will be run as a new installation.   

 

Before uninstalling your previous version of Vision, ensure that your hardware and software 
meet the minimum requirements for running this current Vision release. 

 

If you are using Vision 5.1 and have users connecting from the Internet outside of a Virtual 
Private Network (VPN), see the Deltek Vision Advanced Technical Administration Guide for 
advanced topics for configuring and securing connections to Vision. 

Database Upgrades 
 Vision database upgrades from Vision 6.x or 7.x are supported. 

 You cannot upgrade any Vision database from version 5.1 or older. 

 If your database is older than version 6.x, a message will display during the installation, 
letting you know that there are no valid databases to convert. You must manually convert 
those databases to a minimum of version 6.0 and then upgrade to the current release.  

 

See Converting a Database During Installation below for more information. 
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 Web Server installations create a deltekvision75.sql file in the \program 
files\Deltek\Vision\Databases\Scripts folder that you can use to manually upgrade the 
database to the current version.  

To convert your database manually, create a backup of your database before you run the 
database conversion using the Deltekvision75.sql script file. Do not run 
UnicodeDeltekVision75.sql or other script files unless your database is Unicode. If you 
plan to convert your Vision database to Unicode, see the Vision online help for the 
appropriate steps. 

Converting Vision 5.x or Earlier Databases 
When completing the database portion of the installation process, Vision checks to see if there 
are any existing 6.x databases. If so, the Database to Upgrade screen displays. If you are 
migrating from a version prior to Vision 6.x, follow the steps listed in the table below on how to 
upgrade.  

Database Migration Path Table 

Database 
Migration Path Steps 

5.x to 6.x Log on to the Deltek Customer Care website. 

Select KB article # 43088, titled How to upgrade the Vision database. 
Download and run either the DeltekVision61SP4_upgradescripts.zip or 
DeltekVision61SP2_upgradescripts.zip conversion script to convert your 
database to version 6.x. 

4.x to 6.x Log on to the Deltek Customer Care website. 

1. Select KB article # 37233, titled How to Upgrade Vision from 3.0 to 5.0. 
Download and run the DeltekVision50.sql conversion script to convert 
your database to version 5.x. 

2. Select KB article # 43088, titled How to upgrade the Vision database. 
Download and run either the DeltekVision61SP4_upgradescripts.zip 
or DeltekVision61SP2_upgradescripts.zip conversion script to 
convert your database to version 6.x. 

3.x to 6.x Log on to the Deltek Customer Care website. 

1. Select KB article # 37233, titled How to Upgrade Vision from 3.0 to 5.0. 

a. Download and run the DeltekVision41RTM.sql conversion script 
to convert your database to 4.x. 

b. Download and run the DeltekVision50.sql conversion script to 
convert your database to version 5.x. 

2. Select KB article # 43088, titled How to upgrade the Vision database. 
Download and run either the DeltekVision61SP4_upgradescripts.zip 
or DeltekVision61SP2_upgradescripts.zip conversion script to 
convert your database to version 6.x. 

  

https://deltek.custhelp.com/app/answers/detail/a_id/43088/kw/43088
https://deltek.custhelp.com/app/answers/detail/a_id/37233/related/1
https://deltek.custhelp.com/app/answers/detail/a_id/43088/kw/43088
https://deltek.custhelp.com/app/answers/detail/a_id/37233/related/1
https://deltek.custhelp.com/app/answers/detail/a_id/43088/kw/43088
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Custom Programming, Including Custom Invoices and Custom 
Reports 
Before you upgrade to Vision 7.5: 

 Review all existing custom work, including custom invoices and custom reports, at least 
eight weeks prior to your intended go-live date. 

 Compare your custom work to the new functionality provided in this release. 

 If this new version possesses the functionality contained in your custom work, these 
custom programs may no longer be needed. If the functionality contained in your custom 
work is not provided in this release, you must ensure the custom work remains intact 
through the upgrade process. 

 Identify any hot fixes or patches that you plan to deploy with your Vision 7.5 upgrade. 
Ensure that, following the hot fix or patch deployment, you retain all custom functionality. 

 Deltek strongly recommends that when you upgrade, you first deploy an instance of 
Vision 7.5 in your test environment. This allows for functional User Acceptance Testing 
(UAT) to ensure that all mission-critical custom features are still available to the user 
community. Typical deployments call for a 30–45 day test period before you upgrade 
Vision in your production environment. 

 If you are upgrading to Vision 7.5 from a version earlier than Vision 6.0, and you have 
developed custom programming and/or reports in the earlier versions of Vision, all 
existing custom programming developed prior to the Vision 6.0 release must be rewritten 
in Smart Client. 

 

Deltek’s Technical Services team is available to support you as you plan for this upgrade. We 
offer both technical and custom services. Contact DGSCONSULTANTS-PES@Deltek.com. 

Custom Database Objects 
If you created any custom objects on your existing Vision database (including custom tables and 
custom triggers), you must review these objects before you upgrade to Vision 7.0 or later 
versions. If you have created custom triggers, you must turn them off before you begin the 
upgrade process because they might cause the upgrade to fail. 

Vision Screen Designer 
Screen design changes that you applied in versions earlier than Vision 6.0—using the Vision 
Screen Designer—may not display correctly in Vision 7.0 and later versions because Vision now 
uses different font and field sizes than those used in previous releases. Review any screens that 
you previously changed using the Screen Designer and modify them as needed. 

mailto:DGSCONSULTANTS-PES@Deltek.com
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Important Notes about the Vision Installation 
This section provides important information specific to the Vision 7.5 installation. 

Setup Log File 
If you encounter problems during the Vision installation and you are unable to continue with the 
installation on the server, contact Deltek Customer Care for assistance and include the 
information listed in the DeltekVisionSetupLog.txt file. 

For security reasons, the temporary log file is stored in the 
C:\Users\%Username%\AppData\Local folder of the administrator performing the installation on 
the Vision server. To navigate to the file, an administrator can enter the environmental variable 
%LocalAppData% at a Run prompt or in the Windows Search Box on the server. 

Microsoft SQL Server Express Edition 
Vision 7.5 supports Microsoft SQL Server Express. If you are implementing SQL Server Express, 
Deltek recommends that you use the SQL Server 2014 SP1 Express edition with Advanced 
Services. The Express edition contains the Database Engine and Reporting Services that are 
required for managing the Vision database and running reports. 

 

See “Appendix B: Microsoft SQL Server Edition and Version Information,” in the Deltek Vision 
7.5 Technical installation Guide for details, including Microsoft links for downloading and using 
SQL Server Express Edition. 

Microsoft SQL Server Reporting Services—Custom Reports and 
Custom Invoices 
After you upgrade to Vision 7.5 from an earlier 7.x version, you must upgrade your existing 
custom reports and custom invoices to the supported RDL 2010 schema that is now required. 

 

For instructions on how to upgrade your custom reports and invoices to the RDL 2010 schema, 
see the “Custom Reports Created with Microsoft SQL Server Reporting Services Versions 2005 
and 2008” section in the Deltek Vision 7.5 Custom Reports and Microsoft SQL Server Reporting 
Services Guide. 

For an overview of the Microsoft SSRS report-writing tools that are and are not supported in 
Vision 7.5, see the “Changes to Supported Environments and Technical Considerations that Are 
New for Vision 7.5” section on page 5 of these release notes.  

Custom Report Business Objects 
When you install the Vision 7.5 upgrade to your Vision server (web server tier), Vision 7.5 custom 
report business objects are installed into the <Deltek Vision Installation Directory>\Support\SDK 
folder. In this folder, extract the contents from the VBReporting.exe self-extracting file to access 
the custom report business objects. 
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Connect for Microsoft Outlook  
This section applies if you are upgrading to Connect for Microsoft Outlook 7.5 from an earlier 
version. Connect for Microsoft Outlook and any updates to it are now included in the Vision 7.5 
installation and Vision Cumulative updates on the web/application tier.  

 

See the Deltek Vision 7.5 Connect for Microsoft Outlook Installation Guide for specific 
instructions for performing new and upgrade deployments. 

Revenue Generation and Gains and Losses   
This applies if you are upgrading from a Vision 6.x version to 7.5 and you use all of the following 
in Vision: 

 Revenue Generation 

 Revenue categories for Revenue Generation 

 Multiple currencies 

Before you run Revenue Generation in 7.5, be sure that you have specified a different unbilled 
service account for each revenue category on the Revenue tab in Configuration » Accounting » 
Company Settings. 

In Vision 6.x versions, you were not required to have different unbilled service accounts, but in 7.x 
versions, you must have a different unbilled service account for each revenue category. If you 
have the same account for multiple revenue categories in Vision 7.5, gains and losses 
adjustments are calculated automatically whenever Revenue Generation is processed, even 
when exchange rates have not changed and no new transactions have been posted to a project. 

After you change an unbilled service account for revenue categories, the next time that you run 
Revenue Generation, you will see a one-time swing in revenue gains/losses to update the new 
unbilled service account. 

Known Issues with the Vision 7.5 Installation 
 In certain circumstances, the databases.enc entries for the Report Server Configuration 

tab are not being filled in. Check your database entries using Weblink, and test the 
database and Report Server configurations to ensure that they are accurate. 

 If you are upgrading from a 6.x version of Vision and you use a Microsoft SQL Server 
Session State that is located in a database other than your Vision database, see KB 
article #72573 for additional instructions. During the Vision upgrade process, the 
SessionState table is renamed. However, if the table is not located in the Vision 
transaction database, it will not be renamed. You must manually rename the table using 
the instructions in the KB article. 

 

If you encounter any problems with your installation, contact Deltek’s Global Services team at 
DGSConsultants-PES@deltek.com. 

mailto:DGSConsultants-PES_Vision@deltek.com
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Download and Install Vision 7.5 

 

See the Deltek Vision 7.5 Technical Installation Guide for instructions on how to download and 
install or upgrade the Vision software. You can also refer to the Deltek Product Support 
Compatibility Matrix for more information about supported and non-supported environments. 
Download these guides from the Deltek Customer Care Connect site. 

Upgrade Considerations 
Deltek encourages clients to upgrade to the latest version of Vision because: 

 New features are added only to the latest version. 

 Except in critical situations, Deltek fixes software issues only in the latest version.  

 Deltek support is typically available only for the latest and the next previous versions. 

 The latest version incorporates the newest technologies and tools. 

Before you upgrade, you should first review these release notes and perform a test conversion 
and test installation of the new version to ensure that your firm’s business processes are working 
properly in the new version. 

After you upgrade to Vision 7.5, Deltek recommends that you run the Microsoft SQL Server 
Update Statistics maintenance program using the default option that uses a sample of the data. 
This is especially important for larger Vision databases, to help prevent performance issues. 

 

If you are upgrading to Vision 7.5 from a version earlier than Vision 6.1, see the 6.1 release 
notes. You can download them from the Deltek Customer Care Connect site. You can also 
download copies of the prior versions of the Vision documentation at the Deltek Customer 
Connect site. 

 

Deltek’s Global Services team is available to support you as you plan for an upgrade. They offer 
both technical and custom services to ensure the best possible Deltek experience. Contact 
DGSConsultants-PES@deltek.com. 

 

http://support.deltek.com/
http://support.deltek.com/
mailto:DGSConsultants-PES@deltek.com
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Deploy Vision 7.5 on Client Workstations 
The switch to Smart Client technology beginning with Vision 6.0 requires that compiled 
application code be stored on each user’s PC. ClickOnce is the Microsoft technology used to 
install this code without requiring that IT manually install Vision on each user’s machine. The 
code is downloaded automatically when Vision is opened on the user’s PC. 

 

You must manually install .NET 4.5.1 on each workstation on which Vision 7.5 will be run. 

Each time that you open Vision, the application automatically checks the server for any changes, 
such as a hot fix or a version upgrade. If no change is detected, Vision opens. If software updates 
are available (and they have been pushed out by your IT department) the updates are 
downloaded automatically. 

When you open Vision 7.5 for the first time, complete the following steps: 
1. When the Deltek Vision launch page displays, click Run on this page to continue. Vision 

downloads the files required to open the Login screen. 

2. On the Deltek Vision Login screen, enter your Username and Password, select a 
Database, and click Login. 

Vision downloads a zip file to your workstation (an Application Downloader dialog box 
displays during this process). This zip file is extracted into the local ClickOnce cache on 
your workstation. This is similar to the way that temporary Internet files are stored for 
browser applications. 

After the zip file is extracted, the Vision application opens and you can start working. 

Subsequent Logins 
On subsequent logins, assuming that no software updates have been received from Deltek, the 
Vision application opens on your workstation when you log in—no download will be necessary. 
When Deltek provides a new version of the software, or a hot fix, and your IT administrator 
installs the new version or hot fix, Vision will detect and download the update automatically when 
you log in. 
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Software Issues Resolved in Vision 7.5 Since the 
Vision 7.4 Release 
This section identifies software issues that were resolved in Vision 7.4. It includes the issues that 
were fixed after the 7.4 release that were not fixed in the 7.4 cumulative updates (7.4 CUs). The 
issues that were resolved in the 7.4 cumulative updates are also resolved in the 7.4 release.  

These resolved issues are described in “Appendix A: Software Issues Resolved and 
Enhancements in Vision 7.4 Cumulative Updates,” where they are organized by cumulative 
update number and date. 

Whether you installed one or more of the 7.4 cumulative updates, or you moved directly to the 
latest release without installing any of the 7.4 cumulative updates, all of the issues described in 
this section and Appendix A have been resolved. 
 
 

Accounting 

Accounting » Accounts Payable » Create Voucher from PO 
Defect 477421: A vendor with many purchase orders may load very slowly on the Create 
Voucher from PO screen. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: Apply the following script to your database: 

CREATE NONCLUSTERED INDEX POMasterVendorIDX ON POMaster(Vendor) 
WITH FILLFACTOR = 90 
GO 
Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 485070: This issue applies if you use the Purchasing application and you do not maintain 
separate balance sheets. In Create Voucher from PO, when you clicked Cost Distribution on the 
toolbar of the Open to Voucher grid for an inventory item, you received an error message that 
informed you that a project was not permitted with a balance sheet account. You were unable to 
close the Cost Distribution dialog box. 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround Before Fix: None. 
Additional Notes: None. 
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Files Updated 

Deltek.Vision.PORoutines.Server.dll 
Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Accounting » Accounts Payable » Form 1099 Processing 
Defect 546194: The Vision 1099-MISC form was printed using font size 8, when the IRS 
requirement is font size 12.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: Submit 1099 data electronically. 
 

Additional Notes: None. 

Files Updated 

aprptForm1099.rdl 

aprptForm1099Custom.rdl 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
 

Accounting » Accounts Receivable » Invoice Review 
Defect 520299: When the Status was changed to Unpaid on the Invoice Review form in 
Accounting » Accountings Receivable, the Project Name column was blank for the projects 
that had retainage billing but not with outstanding invoices. 

Customers Impacted: This defect applies to Vision 7.3.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Accounting » Bank Reconciliation 
Defect 475040: The accrual and cash basis general ledger entries were incorrect when you 
cleared checks on the Payments tab in Bank Statement Reconciliation in the following situation: 
An AP Payment Processing run or Employee Payment Processing run had a mix of EFT and non-
EFT (regular) payments. On the Payments tab in Bank Statement Reconciliation, you cleared all 
of the EFT payments and only some of the non-EFT checks from the payment run in the same 
bank statement. 

Customers Impacted: This defect applies to Vision 7.0 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
Deltek.Vision.BankReconciliation.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 527033: If a receipt was cleared in a future period, that receipt displayed as uncleared on 
the Receipts tab in Bank Reconciliation. However, the uncleared balance on the Summary tab 
was not updated to match. The uncleared balance on the Summary tab did not include the receipt 
that was cleared in a future period.

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.BankReconciliation.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Accounting » Check Review 
Defect 434351: In Accounting » Payment Review, when you selected AP Payment/EFT in the 
Transaction Type field on the Search Criteria tab, not all payments with an AP Payment/EFT 
payment type displayed in the Payments grid. 

Customers Impacted: This defect applies to Vision 7.4.  
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Workaround Before Fix: Use other search criteria. 

Additional Notes: None.
 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Accounting » Credit Card » Credit Card Reconciliation 
De471296: If you attempted to import a credit card file and the primary code included a dash (for 
example, AMEX-PC), you received the error: "Incorrect syntax near '-'. "

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: Remove the dash.
 

Additional Notes: None.
 

Files Updated 

 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 475111: If you created a new credit card statement and then immediately imported 
charges, the currency code field of the imported entry was blank instead of having the currency 
code of the credit card.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: Reload the statement before importing any charges. 
 

Additional Notes: None.  

Files Updated 
Deltek.Vision.CreditCardReconciliation.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Defect 479940: This issue applies when more than one employee is authorized to use the same 
credit card. On the Charges tab of the Credit Card Reconciliation form, the amount in the Posted 
Amount column was incorrectly doubled when the following occurred:

 

1. You posted expense reports for two different employees who used the same credit card 
for the expenses. In Credit Card Reconciliation, these two expenses correctly displayed 
on two separate rows in the grid on the Charges tab. 

2. You imported a charge from a credit card company, which applied for both of the 
expenses for the two different employees. 

3. You manually tied both of the posted expense charges to the imported credit card charge 
amount by entering a transaction ID on the Details dialog box in Credit Card 
Reconciliation. 

4. When you saved the credit card reconciliation statement, the two expenses now 
displayed incorrectly in one line in the grid on the Charges tab. The amount in the Posted 
Amount column was doubled. 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.CreditCardReconciliation.Client.dll 

Deltek.Vision.CreditCardReview.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 489845: If you attempted to import a credit card file when logged into Vision using a 
username that included a dash (for example, ADMIN-NY), you received the error: "Incorrect 
syntax near '-'. "

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: Perform the import using a username that does not include a dash.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Defect 490002: In Configuration » Accounting » Credit Cards » General tab, the Use to 
separate import into secondary credit cards field identifies the value that your credit card 
company uses on statements to identify a secondary credit card account (for example, the 
secondary account number). If this value was blank in an import file, the record imported without 
error, but no Secondary Account number displayed on the Credit Card Charges grid in Credit 
Card Statement Reconciliation. 

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: You can still import a record with an empty field, but now the Secondary 
Account number displays.  

Files Updated 

Deltek.Vision.CreditCardReconciliation.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 498327: In a database that did not use Cash Basis reporting, an error message displayed 
when a new row was inserted in Credit Card Reconciliation for a credit card that did not use the 
Import feature.  

Customers Impacted: This defect applies to Vision 7.4. 
 

Workaround Before Fix: Temporarily turn on Cash Basis Reporting when manually entering new 
credit card charges.  

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

Deltek.Vision.CreditCardReconciliation.Client.dll 

Database Changes 
 

System File Dependencies 
 

Accounting » Gains and Losses Revaluations 
Defect 545020: Vision froze when you ran Accounting » Gains/Losses and Revaluations on 
some databases. 

Customers Impacted: This defect applies to Vision 7.2 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: None. 
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Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Accounting » Project Review 
Defect 466906: In Project Review, if you had a Budget Source of Project Planning, then 
changed the Budget Source to Budget Worksheet, the value sometimes reverted back to 
Project Planning when you logged out of Vision and logged back in.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: Manually change the value to Budget Worksheet. 
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.ProjectPTDReview.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 533245: The Project Review screen was slow to display. 

Customers Impacted: This defect applies to Vision version 7.0 and later. 

Workaround Before Fix: On the Accounts Receivable tab on the Project Review screen, select 
Unpaid in the Status field to help reduce the amount of data. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.ProjectPTDReview.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Accounting » Tax File Generation 
Defect 542489: When you created a tax file in Tax File Generation using any of the file formats, 
the tax file and the backup report correctly showed any negative tax amount for an invoice. 
However, invoices with negative tax amounts were missing from the grid on the Review tab of the 
Tax File Generation form.

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Billing 
Defect 477493: If the Print Total in Invoice Header option was selected on the Totals tab of the 
Invoice Template Editor, an error occurred when you previewed the retainage invoice. The error 
message was: "SQL Reporting Error creating RetainageHeader RDL file: The Value expression 
for the text box ‘textboxTotalColumn’ refers to a non-existing report parameter ‘InvoiceTotal’. 
Letters in the names of parameters must use the correct case." 

Customers Impacted: This defect applies to Vision 7.4 and later versions. 

Workaround Before Fix: Clear the Print Total in Invoice Header option when billing retainage.  

Additional Notes: None. 

Files Updated 

RetainageHeader.rdl 
RetainageInvoice.rdl 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Billing » Batch Billing 
Defect 479090: If you selected the Email invoices option on the Batch Billing screen, then 
clicked Insert Field to insert a field in the Message section of the email, the field was not 
inserted. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: Use the Insert Field button to insert a field in the Subject line, then cut 
and paste the field into the Message section. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 519769: When an error was encountered while printing to a server in Batch Billing, the 
following generic framework exception displayed: "The process cannot access the file 
'BatchInvoiceReports.pdf' because it is being used by another process. "  

Customers Impacted: This defect applies to Vision 7.2. 

Workaround Before Fix: None. 

Additional Notes: The correct printing error will now be displayed; for example, "Printer is not 
valid." 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 

Defect 546294: If you used invoice approvals, when you accepted an invoice in Batch Billing, 
multiple blank lines were created in the Invoice Data Entry file.

 

Customers Impacted: This defect applies to Vision 7.4 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Billing.Server.dll 

Other Applications Affected 
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Database Changes 
 

System File Dependencies 

 

Billing » Interactive Billing 
Defect 527889: If you had a voucher line for shipping charges that was created from a purchase 
order, you could not perform a partial hold, partial write off, or partial transfer of the line because 
you could not edit the Amount field for the line.

 

Customers Impacted: This defect applies to Vision 7.4. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
Deltek.Vision.interactiveBilling.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Billing » Invoice Approvals 
Defect 524935: On the Invoice Approvals screen, if you clicked Comments to display the Billing 
Comments dialog box, you could not type directly into the Comment Entry field. This only 
happened if another user had made the prior comment. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: Click Edit and type into the text editor. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Calendar 

Activity Manager 
Defect 476604: If you added an activity in Activity Manager or through the Opportunity Info 
Center, and the activity should have had a default Type of Milestone, the Type was blank 
instead. 

Customers Impacted: This defect applies to Vision 7.4 and later versions. 

Workaround Before Fix: Either select the Type manually, or reselect or refresh the activity, 
which will cause the Type to display as Milestone. 

Additional Notes: None. 

 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Configuration  
Defect 541842: If you enabled the Multicompany feature, credit cards were not correctly assigned 
to a company. Now they are assigned to the default company. 

Customers Impacted: This defect applies to Vision 7.4 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
sp_EnableMulticompany.SQL 

Other Applications Affected 
 

Database Changes 

The EnableMulticompany stored procedure was updated. 

System File Dependencies 

Configuration » General » Alerts 
Defect 528413: When a Timesheet Approval was configured to alert a supervisor for a project, 
for example, but the project in the respective timesheet did not have an assigned supervisor, an 
error occurred when the timesheet was submitted: “The Timesheet Approval Process failed with 
message: Object Reference not set to an instance of an Object”. 
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Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: Click OK and the timesheet will submit without further issue. 
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Configuration » Approvals 
Defect: 543012 When an employee's Record Level View access rights were set to Is Me (on the 
Record Access tab of Configuration » Security), the Employee lookup on the Reassign dialog 
box in AP Invoice Approvals (available from the Progress tab of Accounting » AP Invoice 
Approvals) incorrectly limited the Employee lookup results.  

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 544467: An extra Past Due Notification email alert was sent for Approval Workflow items.  

Customers Impacted: This defect applies to Vision 7.4 and later versions.  

Workaround Before Fix: Ignore the extra email. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Configuration » Billing » General 
Defect 519183: A new warning message has been added to Configuration » Billing » General 
» Fees tab. The warning displays if a user enters any account except a revenue account in the 
Over/Under Billed Account field. Normally, only a revenue account should be used for this 
purpose. 

Customers Impacted: This defect applies to all users of Vision Billing.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.BillingSetup.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Configuration » General » Code Tables 
Defect 466921: When you set up codes on the Code Table Maintenance screen, you should 
have been able to enter Suffix codes of up to 20 characters, but you could only enter 10 
characters.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.CodeTableMaint.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Configuration » Security » Users and Passwords 
Defect 519242: Users who did not have permission to change global saved searches were able 
to delete global saved searches from the Global Searches folder in any Info Center. These users 
had the Favorites Organizing field set to Save Personal Only in Security » Roles » General 
tab.

 

Customers Impacted: This defect applies to Vision 6.2 (SP2) and later versions. 
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Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Lookup.Client.dll 
Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
 

Defect 532612: If you use Vision in a cloud environment, when you created a new user, no 
default printer was assigned to the user. Now <Local Printer> is assigned by default.

 

Customers Impacted: This defect applies to Vision 7.4 and later versions.
 

Workaround Before Fix: Assign <local printer> to the new user.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Configuration » Workflow » User Initiated Workflows 
Defect 485298: If you changed the Active setting for an approval action on the Approvals 
Configuration screen, that setting was not copied over to the User Initiated Workflow screen. 

Customers Impacted: This defect applies to Vision 7.4 and later versions. 

Workaround Before Fix: Manually update the settings. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Dashboard 
Defect 551011: User-defined Info Center dashparts were lost after upgrading Vision to 7.4. This 
was fixed so that the old dashparts were restored if not re-configured in 7.4.  

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Vision Help 

Defect 524072: In the online help for the Cost tab of the Project Review Form, the formula for Net 
Revenue was incorrect. The correct formula is Net Revenue = Revenue / (Direct expenses + 
Reimbursable Expenses ). 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
 

Human Resources 

ABRA Interface 
Defect 551233: When you used the ABRA interface to import payroll data into Vision, you 
received the following error: “Invalid column name ‘TalentUserID. No record imported. Please 
check”.  
Customers Impacted: This defect applies to Vision 7.4.
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Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Info Center 
Defect 370189: When the Display Search Text checkbox was selected on the Advanced Search 
Project Lookup dialog box, the scroll bar displayed but did not scroll down. This occurred when 
there were several items on the Search results list.  

Customers Impacted: This defect applies to Vision 7.0 and later versions.  

Workaround Before Fix: Cut and paste from the Search results list to view the full list (use Ctrl + 
A to select all and then Ctrl + C to copy).  

Additional Notes: None. 

Files Updated 

Deltek.Framework.Lookup.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 460054: If you created a user-defined memo field and then applied a lock to it, a locked-
out user could not copy the contents of the memo field for use elsewhere.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Defect 474156: This problem occurred with all lookups in Info Centers, when you performed an 
advanced lookup using two search criteria and an OR condition (search for this OR that). The 
search returned only the results of the first criterion (this) and not the second (that).

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: In the second line, containing the second criterion, put a left 
parenthesis in the left parenthesis column and a right parenthesis in the right parenthesis column. 

 

Additional Notes: None. 

Files Updated 
Deltek.Framework.Lookup.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Info Center » Employees 
Defect 252614: The License Last Renewal field was not included on the Advanced Lookup in 
the Employee Info Center. 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 

Workaround: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Lookup.Server.dll 

Lookup_Employee.xml  

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Info Center » Projects 
Defect 263039: Two problems occurred if you used the Screen Designer to make change to the 
Project Info Center Contract Management tab:

 

 If you changed the width of grids, your change was not saved when you logged out of 
Vision. 

 You could not hide columns. 

Customers Impacted: This defect applies to Vision 7.0 (SP1) and later versions. 
 

Workaround Before Fix: None. 
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Additional Notes: These fixes only apply to the tab and not to the properties of the dialog box 
that displays if you select Edit. Dialog box issues will be addressed in a future release.  

Files Updated 

Deltek.Vision.ProjectInfoCenter.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
 

Defect 498569: When searching at the WBS2 level in the Project Lookup/ Advanced Search, the 
search results were not always correct. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: Manually edit the where clause in SQL view to include an additional 
condition for WBS2.

 

Additional Notes: None. 

Files Updated 

Lookup_Project.xml 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
 

Defect 529027: When using Vision Multicurrency, if the Project Currency and Billing Currency 
fields were not defined in the Project Info Center and in Configuration » General » Project 
Defaults, you could still save a project record. The issue occurred when the Project Currency 
and Billing Currency fields were hidden in the Screen Designer. Vision continued to allow you to 
save the project record but an error message displayed when posting an invoice because there 
was no exchange rate available due to the blank currency fields. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: Enter currency information in Configuration » General » Project 
Defaults so they will still default even though the currencies are hidden in the designer.

 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ProjectInfoCenter.Client.dll 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 

 
 

Defect 530155: When a phase was added to an existing project using a project template, the 
project and billing currencies changed to the currency of the template. This occurred at all WBS 
levels, which resulted in incorrect values for the transactions. 

Customers Impacted: This defect applies to Vision 7.3. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.ProjectInfoCenter.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 548474: If you performed an Advanced Search in a project lookup, and you searched on 
both the Contract Type and Contract Status fields, you received the error message, "The multi-
part identifier "CFGContractType.Description" could not be bound. "

 

Customers Impacted: This defect applies to Vision 7.4 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Lookup.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
 

Installation 
Defect 498934: When you tried to add new columns to a user-defined grid in the Contracts Info 
Center, the process failed with the error message: "Error: Cannot enable Audit Trail. Table 
‘Projects_ModificationsTemplate’ does not have a primary key defined."

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: Run the following script: 
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ALTER TABLE [dbo].[Projects_ModificationsTemplate] 
 

ADD CONSTRAINT [Projects_ModificationsTemplatePK] PRIMARY KEY NONCLUSTERED 
 

([WBS1], [WBS2], [WBS3], [Seq])
 

WITH FILLFACTOR = 90
 

GO
 

 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
Defect 533465: The Vision upgrade script incorrectly removed access to Project Planning from 
the Navigator/iAccess tab. 

Customers Impacted: This defect applies Vision 7.2. 

Workaround Before Fix: None. 

Additional Notes: Set access rights manually after upgrade 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Log In/Out 
Defect 484586: If a user was on the login screen, entered an invalid User ID, and clicked on 
Forget your password or User ID?, the following message displayed: "The User ID XXXX does 
not exist in the selected database. Please contact your administrator." This message could 
encourage fishing for valid User IDs. Now the message reads: "Account maintenance operation 
failed. Please contact your administrator." 

Customers Impacted: This defect applies to all Vision users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
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Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 502182: If Vision timed out because it was left open for too long, and you tried to log back 
in by clicking the ENTER key, you received the prompt: "Cancel will close the application and all 
pending changes will be lost. Are you sure you want to close the application?” The ENTER key 
should have behaved the same way as clicking the OK button, not the Cancel button. 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: Click the OK button instead of using the ENTER key.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Microsoft Office Desktop Integration 
Defect 460929: When you merged a PowerPoint presentation, and the merge included a memo 
field with bulleted items, the bullets displayed with HTML codes exposed. To address this 
problem, all formatting is now removed when a memo field is merged into a PowerPoint 
presentation, meaning that there are no bullets, bold text, italics, and so on.

 

Customers Impacted: This defect applies to Vision 7.1 and later versions. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Mobile Time 
Defect 485573: In Touch CRM, if you tapped on Tasks and Other Activities, the list of available 
activities did not honor the Activity Access settings in Vision security. These security settings are 
in Configuration » Security » Roles, on the Record Access tab. 

Customers Impacted: This defect applies to all Touch CRM users. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Planning 
Defect 463612: When the Copy Service Estimate into Plan option was selected on the New » 
New Plan from Existing Opportunity dialog box, the Planned Qty and Planned Cost amounts 
on the Units tab displayed negative amounts. This was inconsistent with the amounts that 
displayed on the Service Estimates tab in the Opportunities Info Center.  

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Planning » Project Planning 
Defect 435495: The effective date range for the Labor Rate proration was applying the Overflow 
period's End Date instead of the Assignment row's End Date. Applying the wrong dates to the 
calculation resulted in an incorrect value in the Overflow column. 

 

Customers Impacted: This defect applies to Vision 7.0 SP1 and later versions.
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Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 483769: An error occurred when using the New » New Plan from Existing Project menu 
option to create a project from a plan that was mapped to two projects.  

Customers Impacted: This defect applies to Vision 7.3. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 523971: Processing was very slow when the dragging the bar left or right to resize the 
Planning grids.  

Customers Impacted: This defect applies to Vision 7.3. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
k.Vision.ResourcePlanning.Client.DLL 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Defect 547296: In certain circumstances, performance was poor when you opened an existing 
project plan. 

Customers Impacted: This defect applies to Vision 7.4 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 
 

Proposals 
Defect 412993: If you merged proposal data using an opportunity merge template, a problem 
occurred if you merged a number field from a User-Defined Info Center. Instead of retrieving the 
number that you entered in the Info Center, the merge process retrieved an internal ID number.

 

Customers Impacted: This defect applies to Vision 7.1 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 

Defect 483421: When you used InDesign to create proposals, you could not include .PSD 
(Adobe Photoshop) graphic files in the proposals. You can now use .PSD files, but you cannot 
see the .PSD images when you preview the proposal. 

Customers Impacted: This defect applies to all users of Vision Proposals. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
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Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 
 

Defect 498578: On the SF330, text displayed in Section E, Box 18, with missing formatting.
 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 
 

Defect 501926: The InDesign template merge based the font size setup on Text editor and not 
the font size in the InDesign template. 

Customers Impacted: This issue affects Vision 7.2 and later releases. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

SF254 Proposals 
Defect 538081: The following error sometimes occurred when you clicked Edit » Template 
Editor on the SF254 Form: "Exception of type 'System.OutOfMemoryException' was thrown."  

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
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Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
 

SF330 Proposals 
Defect 256479: When you tried to merge SF330 Section E, Vision would crash if it encountered 
the character string "/P" (without quotation marks) in text that was being merged into the 
proposal.

 

Customers Impacted: This defect applies to Vision 6.1 (SP4) and later versions. 

Workaround: Remove any instance of "/P" in the text or add a space between the slash and the 
P (for example, change Controls Technician/Programmer to Controls Technician / 
Programmer).

 

Additional Notes: None.  

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

 

Defect 447962: The footer of the SF330 Proposals form contained the label STANDARD FORM 
330 (6/2004). It should say STANDARD FORM 330 (REV. 3/2013). 

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 
 

Purchasing  
Defect 549073: The following applies if you enabled the Modify Not to Exceed Values via 
Change Order check box on the General tab in Configuration » Purchasing & Inventory » 
Company Settings.

 

When you tried to create an AP voucher from a purchase order in Accounting » Accounts 
Payable » Create Voucher from PO, you were unable to create the AP voucher if all of the 
following applied:

 

 The purchase order was a service or blanket type purchase order. 

 You entered a not-to-exceed amount for the purchase order. 

 You entered a change order with a not-to-exceed amount for the purchase order. 

 The amount of the AP voucher exceeded the original not-to-exceed limit that you entered 
for the purchase order, but it did not exceed the combined total of the not-to-exceed 
amount entered for the purchase order and the change order.  

You should have been able to create the AP voucher as long as its total did not exceed the 
combined total of the not-to-exceed amount entered for the purchase order and for the change 
order.

 

Customers Impacted: This defect applies if you use Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

 

Purchase Orders 
Defect 546212: The image included in a Purchase Order Template did not display correctly on 
the purchase order.  

Customers Impacted: This defect applies to Vision 7.4 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
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Receiving 
Defect 478526: If a purchase order had many line items and receiving activities, it would load on 
the Purchase Order Receiving screen very slowly.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Reporting 
Defect 445281: If you viewed a report in print layout or downloaded it to PDF or RTF format, only 
the first line of the report footer's contents displayed. Any subsequent lines did not display. The 
report footer displayed correctly in the preview view and in Word format. 

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: Use preview view or the Word format.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 
 

Defect 484575: If you ran a report with the HTML Formatting option turned off on the Layout tab 
in reporting options, an extra return was added after text on the report. This created blank lines 
on the report.

 

Customers Impacted: This defect applies to Vision 7.2 and later versions. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
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Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 
 

Defect 500815: The Timesheet Audit Detail report was missing the header on page 2 and 
subsequent pages. 

 

Customers Impacted: This defect applies to Vision 7.3.
 

Workaround Before Fix: None.
 

Additional Notes: This was the result of two different problems, one with a known Microsoft 
issue and one with a Vision issue. The Vision issue has been fixed but the Microsoft issue may 
still cause missing headers. 

Files Updated 
Timesheet ADT Detail.rdl 
TimesheetADTPerEmployee.rdl 
TimesheetADTUnitPerEmployee.rdl 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 
 

Defect 520671: If you ran a report with Millimeters as the Unit of Measure, the report files were 
much larger in size than if the same report had been run using Inches as the Unit of Measure. In 
some cases. the reports would not run at all.

 

Customers Impacted: This defect applies to Vision 7.2 and later versions.
 

Workaround Before Fix: Use Inches as the Unit of Measure.
 

Additional Notes: Reports run using millimeters are now the same size as those run using 
inches. 

Files Updated 
 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Defect 520885: Some words changed into scrambled characters when reports are downloaded 
or edited to RTF format. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Download the report to MS Word instead of RTF, or downgrade the 
version of SQL Server. For example, If you are using Cumulative Update 4 for SQL Server 2014, 
Cumulative Update 2 for SQL Server 2012 SP2, or 

Cumulative Update 11 for SQL Server 2008 R2 SP2, downgrade to the previous cumulative 
update. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Reporting » Accounting 
Defect 499302: Two problems occurred in the Payment Register report:

 

 The Amount field was empty if the vendor name was changed after the payment was 
generated. 

 The Amount field was empty if the check had an EFT detail record with a zero amount. 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Check Register.rdl 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
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Reporting » Accounts Receivable 
Defect 479738: The following formatting issues occurred in the AR Statement report:

 

 The top of the address displayed lower on the report than the Address Start setting in 
report options indicated that it should. 

 If you set the Statement Footer report option to have bold or italic text in the footer, 
these properties were not applied. Instead, the HTML tags for these properties displayed 
in the footer of the report. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 
Deltek.Vision.ReportingAccountsReceivable.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 
 

Defect 534801: The Description was omitted from the Accounts Receivable Statement report. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

k.Vision.ReportingAccountsReceivable.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 538116: On the Invoice Transaction Detail report, timesheet comments displayed with 
HTML coding whether or not the HTML Formatting option was selected on the Layout tab in 
reporting options. 

 

Customers Impacted: This defect applies to Vision 7.4 and later versions.
 

Workaround Before Fix: None. 
 

Additional Notes: None.  

Files Updated 
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Deltek.Vision.ReportingAccountsReceivable.Server.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
 

Reporting » Employee 
Defect 476923: Many column headers and pieces of data did not display on the Employee Labor 
Audit report if the user's role did not have full access rights to all reports.

 

Customers Impacted: This defect applies to Vision 7.2 and later versions. 
 

Workaround Before Fix: Run the report using a user role that has full access to all reports. 
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Report.Server.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 

Defect 503607: When you generate a Timesheet Audit Detail report on Reporting » Employees, 
projects on timesheets that never had associated hours are displayed on the report with zero 
hours.  

Customers Impacted: This defect applies to Vision 7.2. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
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Reporting » Opportunity 
Defect 260148: When you ran the Opportunity Hit Rate List and selected two or more fields on 
the Sorting/Grouping tab, the hit rate displayed only for the top grouping level. Any lower levels 
displayed a 0% hit rate. 

 

Customers Impacted: This defect applies to Vision 6.1 (SP4) and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 
 

Defect 544758: When you ran the Opportunity List report, Opportunity Forecast report, or 
Opportunity Hit Rate List report, you received a framework exception error '‘Report item name 
must be unique..." if you selected all of the following before you ran the report:

 

 You selected multiple columns to sort and group by on the Sorting/Grouping tab of the 
report options dialog box. 

 You added Opportunity fields to the report that were new in Vision 7.4 or GovWin 
Capture Management 7.4. You placed these fields after numeric/currency columns. 

 The new Opportunity fields that were added to Vision 7.4 are: NAICS and Our Role. 

 The new Opportunity fields that were added to GovWin Capture Management 7.4 
are: Award Type, Competition Type, Contract Type, NAICS, Our Role, and 
Solicitation. 

Customers Impacted: This defect applies to Vision 7.4 and GovWin Capture Management 7.4. 
 

Workaround Before Fix: Perform one of the following actions:
 

 Select only one column for sorting/grouping. 

 Move the numeric/currency fields down on the Sorting/Grouping tab of the report options 
dialog box to ensure that they are placed after the other fields. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
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Reporting » Project 
Defect 261093: On the Project Earnings report, if you used the Project Base Rollup option with 
the Subtotal on Base Number option, each project's number and name displayed twice on the 
report. 

Customers Impacted: This defect applies to Vision 7.0. 

Workaround Before Fix: None.  

Additional Notes: This problem occurred on the standard Project Earnings report and when the 
report was run as a favorite. 

Files Updated 
Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

Defect 442568: On the Labor Detail report, the Secondary Overtime Percentage was incorrect 
for unposted labor. The regular Overtime Percentage was being applied instead of the Secondary 
Overtime Percentage. 

 

Customers Impacted: This defect applies to Vision 5.1 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 
 

 

Reporting » Purchasing 
Defect 539918: If you had text in the Extra Notes field in the Items Master, the text could be 
truncated when it displayed in the Purchase Order Line Detail dialog box. This happened if the 
text was over 2000 characters long.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 
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Files Updated 

Deltek.Vision.POShipping.Client.dll 

Deltek.Vision.POReceiving.Client.dll 

Deltek.Vision.ReportingPurchasing.Server.dll 

Form Purchase Order Detail.rdl 

Form Request for Price Quote-Detail.rdl 

Form Requisition.rdl 

FormRequisition_RequiredDetail.rdl 

Request for Price Quote.rdl 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 
 

Defect 541893: The Purchase Order Detail report incorrectly displayed fully vouchered POs even 
when the Include Unvouchered Items Only option was selected on the General tab of the 
Purchase Order Detail report in Reporting » Purchasing. 

Customers Impacted: This defect applies to Vision 5.1 through Vision 7.4.
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Reporting » Vendor 
Defect 485715: An error occurred when you ran the Vendor List report, if you:

 

1. Selected Contacts in the Grid Type field of the reporting options General tab. 

2. Selected one of the Contacts columns (Contacts - Name, Contacts - Title, and so on) 
on the reporting options Columns tab.  

Customers Impacted: This defect applies to Vision 7.4. 
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Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
 

Text Editor 
 

Defect 467402: An error occurred when you opened an Info Center record that had a Memo field 
that contained text that had been copied and pasted from another application.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
 

Defect 469953: If a Memo field was read-only and contained a hyperlink, such as 
www.deltek.com, you could not click on the hyperlink to open the web page.

 

Customers Impacted: This defect applies to Vision 7.2 and later versions. 
 

Workaround Before Fix: You could open the text editor window and then click the hyperlink to 
open the web page. 

 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
 

http://www.deltek.com/
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Defect 489842: When you build a resume in Custom Proposals and view the resume with the 
Text Editor, the bullet lists after the 20th page are no longer formatted correctly.

 

Customers Impacted: This defect applies to Vision 7.3.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 
 

Defect 532704: An error occurred when you opened a record that included a text field containing 
superscripted text. You received the error message: "The 'sup' start tag on line 13 position 256 
does not match the end tag of 'span'. Line 13, position 328."

 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 
 

Defect 542212: A numbered list in a Memo field displayed with bullets instead of numbers when 
it was merged to a Word Template. 

 

Customers Impacted: This defect applies to Vision 7.0 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
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System File Dependencies 

 
 

Defect 547945: If you clicked a hyperlink, such as www.deltek.com,, on the Text Editor dialog 
box, the link did not work.

 

Customers Impacted: This defect applies to Vision 7.4 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
 

Time and Expense 

Expense Report 
Defect 504165: The Credit Card Expense List in the Expense Report form displayed the wrong 
columns.

 

Customers Impacted: This defect applies to Vision 7.3.
 

Workaround Before Fix: Reload the Expense Report application and reselect the employee 
record.

 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Expensekeeper.Client.dll 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 
 

Defect 523233: If you inserted a line on an Expense Report, the amount could be incorrect if the 
Expense Category rate is a negative value and the Company Expense rate is a positive value. 

 

Customers Impacted: This defect applies to all Vision versions.
 

Workaround Before Fix: Manually enter the correct amount.
 

http://www.deltek.com/
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Additional Notes: None. 

Files Updated 

Deltek.Vision.Expensekeeper.Client.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 
 

Defect 531407: Posted tax transactions were not displayed on the Detailed Expense Report 
when there was no SortOrder 1 in the ekdetailtax table.  

Customers Impacted: This defect applies to Vision 7.2 and later versions. 

Workaround Before Fix: Complete one of the following:  

 Delete and re-enter the line that is missing from the detail (or script updating sortorder in 
ekDetailTax from 2 to 1). 

 Open the tax dialog box and click OK to close it.  

Additional Notes: None. 

Files Updated 

Detailed Expense Report Landscape.rdl 
Detailed Expense Report Portrait.rdl 
Summarized Expense Report Landscape.rdl 
Summarized Expense Report Portrait.rdl 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 
 

Timesheet 
Defect 389184: If a comment was required for a timesheet entry, a user could enter and save a 
blank space instead of a comment. When the user saved the entry, the blank space "comment" 
was saved in the drop-down list of comments that could be reused in future timesheet entries.

 

Customers Impacted: This defect applies to Vision 7.0 (SP1) and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
Deltek.Vision.Timekeeper.Client.dll 

Other Applications Affected 
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Database Changes 
 

System File Dependencies 

 
 

Defect 458579: You can set up timesheets so that employees cannot charge time to labor codes 
that are not budgeted. However, a problem was occurring that allowed an employee to enter time 
to an unbudgeted labor code when the labor code was the employee's default labor code. If the 
labor code was entered automatically on the timesheet, as the default, the employee could save 
the entry without receiving an error or warning message.

 

Customers Impacted: This defect applies to Vision 7.2 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 
Deltek.Vision.Timekeeper.Client.dll 

Deltek.Vision.Lookup.Client.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 
 

Defect 462256: If you used the Up Arrow key to move among timesheet lines, you received the 
error message: "Object reference not set to an instance of an object." 

 

Customers Impacted: This defect applies to Vision 7.1 and later versions. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Controls.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 
 

Defect 475068: The Title of the Timesheet Detail report did not apply the default font setting.  

Customers Impacted: This defect applies to Vision 7.3. 
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Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 

Defect 486470: In Timesheet, accessing the Show-Planned Hours option resulted in the circle 
continuously spinning and not displaying results. 

 

Customers Impacted: This defect applies to Vision 7.2.
 

Workaround Before Fix: Apply the script that is provided.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 
 

 

Defect 541766: Vision prompted a user to sign a timesheet before verifying that the timesheet 
was complete and could be saved without an error. Now Vision verifies the timesheet first.

 

Customers Impacted: This defect applies to Vision 6.2 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None.  

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
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Defect 548075: When the project number was changed on a unit timesheet entry line 
(Timesheet » Unit Quantities), the Unit Table was updated but the unit number remained even 
when the number was not included on the new unit table. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: Manually update the record.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 
 

Transaction Center 
Defect 535544: If you modified an existing voucher, then changed the voucher number, then tried 
to reverse a voucher line, a duplicate line was created, reversing the amount of the line twice.

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: Now, when you modify an existing voucher and then change the voucher 
number, Vision blanks out the invoice date. Likewise, if you change the invoice number or invoice 
date, Vision blanks out the voucher number. 

 

This prevents the creation of duplicate vouchers. 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 
 

Transaction Entry and Transaction Posting 
Defect 412542: The Delete Receipt button in Transaction Center » Transaction Entry » Cash 
Receipt was incorrectly enabled for approved transactions. 

 

Customers Impacted: This defect applies to Vision 6.1 SP4 and later versions. 
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 
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Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 
 

Defect 544513: When you unposted a voucher, orphan records were left behind, meaning that 
you could not re-enter the voucher using the same invoice number. If you tried, you received the 
message: “Invoice for XXX already exists. Additional entries will modify this voucher."  

Customers Impacted: This defect applies to Vision 7.0 (SP1) and later versions.  

Workaround Before Fix: Run the following script to delete the records:  

Select * From VO 

Where Not Exists (Select 'X'  

From LedgerAP 

Where VO.Vendor = LedgerAP.Vendor and VO.Voucher = LedgerAP.Voucher) 

Order By VO.Vendor, VO.Voucher 

Additional Notes: None.  

Files Updated 

 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 486923: If you clicked Voucher Lookup on the AP Voucher Transaction Entry screen, the 
Amount for each voucher was the actual amount multiplied by the number of documents 
attached to the voucher. 

 

Customers Impacted: This defect applies to Vision 7.2 and later versions. 
 

Workaround Before Fix: None. 
 

Additional Notes: None.
 

Files Updated 

 

Other Applications Affected 

 

Database Changes 
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System File Dependencies 

 

Defect 519497: When the Maintain Separate Balance Sheets option in Configuration » 
Organization » General Setup was not selected, posting a voucher with Reverse Lines 
incorrectly posted to the default organization instead of the project organization. 

 

Customers Impacted: This defect applies to Vision 7.2 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Posting.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
 

 

Utilities 
Defect 481666: In Advanced Utilities, the Refresh Inventory utility did not reset the Quantity 
Reserved amount correctly for items that did not have item request and inventory issue 
transactions . 

 

Customers Impacted: This defect applies to Vision 7.0 and later versions. 
 

Workaround Before Fix: After you post an item request or inventory issue transaction, run the 
Refresh Inventory utility to correct the Quantity Reserved amount.

 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 
 

Defect 489113: User Activity listed in Audit Trail could not be purged if a Log Out time stamp did 
not exist for it. This has been fixed so that even those listed without will a Log Out time stamp will 
be purged. 

Customers Impacted: This defect applies to Vision 7.4.
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Workaround Before Fix: Apply the following script, replacing the yellow highlighted area with the 
proper date based on their need. Delete from FW_UserActivity 

Where LastAccess is null and StartTime < '2015-01-01' 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.UserActivity.Server.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
 

Advanced Utilities » AR Paid Update 
Defect 474416: If you ran the Refresh AR Paid Period utility, the refresh process did not work for 
projects with project numbers over 20 characters. 

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
 

Advanced Utilities » Data Import 
Defect 486918: The Unit Import Utility did not require that Cost Currency and Project Currency 
values were provided for imported units when the Multicurrency feature was enabled. 

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ImportUtility.Server.dll 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 

 
 

Defect 536219: When there was more than one employee record with the same name, the Data 
Import Utility ignored the Employee ID that was entered and instead updated all records with the 
same name. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None. 
 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ImportUtility.Server.dll 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 
 

Defect 538109: When you imported data, the ModDate field was set to 1900-01-01 00:00:00 in 
the audit trail table, instead of the correct date. This caused the audit trail table to grow over time, 
because Vision did not automatically delete records with such an early date.

 

Customers Impacted: This defect applies to Vision 7.4. 
 

Workaround Before Fix: None. 
 

Additional Notes: None.
 

 

Files Updated 
Deltek.Vision.ImportUtility.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 544731: An error occurred when you attempted to import contacts with the Allow Update 
option selected. This option causes Vision to treat any duplicate record as an update, rather than 
an error. 

Customers Impacted: This defect applies to Vision 7.4 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 
 

Files Updated 
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Deltek.Vision.ImportUtility.Server.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 

Advanced Utilities » Key Conversions 
Defect 478215: When you ran a Project Key Conversion and selected the Combine existing 
projects option, you could receive a "Violation of Primary Key constraint" error. This happened if 
both projects were referenced in any of the following tables:

 

 billFeeAllocation 

 billLabWriteOffDelete 

 billExpWriteOffDeletePK 

 billUnitWriteOffDelete 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: Run a SQL script to delete one set of duplicate records before you run 
the conversion.

 

Additional Notes: None. 

Files Updated 

sp_KeyCvtWBS1.sql 

sp_KeyCvtWBS2.sql 

sp_KeyCvtWBS3.sql 

Other Applications Affected 
 

Database Changes 

The KeyCconvertWBS1, KeyConvertWBS2 and KeyConvertWBS3 stored procedures were 
updated. 

System File Dependencies 

 
 

Defect 499111: When you tried to open a plan after performing a Phase/Task Key Conversion, 
the following error occurred: “An entry with the same key already exists." 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None. 
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Files Updated 

sp_KeyCvtWBS2.sql 

sp_KeyCvtWBS3.sql 

Other Applications Affected 

 

Database Changes 

The KeyCconvertWBS1, KeyConvertWBS2 and KeyConvertWBS3 stored procedures were 
updated. 

System File Dependencies 
 

Advanced Utilities » Key Conversions » Employees 
Defect 502982: The Employee Number in the Expense Table Tax Detail was not converted when 
performing a Key Conversion on an employee.

 

Customers Impacted: This defect applies to Vision 7.3.
 

Workaround Before Fix: None. 
 

Additional Notes: None.
 

Files Updated 

sp_insertKeyConvertDriver.sql 

Other Applications Affected 
 

Database Changes 

The InsertKeyCvtDriver stored procedure was updated. 

System File Dependencies 
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Known Issues 
Following are known issues with the Vision 7.5 release. These will be resolved in the Cumulative 
Updates that are scheduled for release on December 18, 2015 and January 22, 2016. 

Reporting 

Client 
Defect 561298: The Client Employee Assignment and Activity Status report displayed with no 
records (blank), even though records were selected in the Selection Criteria or directly in the 
Client Info Center. 

Customers Impacted: This defect applies to Vision 7.5 clients using the CRM application.  

Workaround Before Fix: You must use the Shift key on your keyboard to select all of the records 
in the search results of the Client Lookup dialog before you select Apply. This will populate the 
report with the records. 

Additional Notes: None. 

Asset Management  

Depreciation Processing 
Defect 560801: When processing depreciation for an asset, the history loading of accumulated 
depreciation was not included in the calculation. 

Customers Impacted: This defect applies to Vision 7.5. 

Workaround Before Fix: None. 

Additional Notes: None. 

Info Center » Equipment 
Defect 559832: When using Vision Multicurrency with Asset Management, assets that were 
created from Purchase Orders or AP Vouchers were not displaying in the correct currency in the 
Equipment Info Center.  

Customers Impacted: This defect applies to Vision 7.5. 

Workaround Before Fix: You can manually adjust the depreciation basis on the GL Cost tab 
prior to running depreciation. 

Additional Notes: None. 
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Database Changes 
This section lists the database table and column changes included in this release. 

 

Deltek creates the Vision Data Dictionary using a live connection to the Vision development 
database. Tables and columns related to features in a future release may appear in the data 
dictionary without descriptions, or with the phrase reserved for future use. You may also see 
tables and columns for features that you have not purchased or enabled. 

New Tables 

Table Name 

AbsenceRequests 

AbsenceRequestsHours 

APApprovalDocuments 

APApprovalMaster 

APApprovalNotes 

APApprovalPO 

APApprovalWBS 

APApprovalWBSTax 

ApprovalAssignmentHierarchy 

BankRecAssoc 

BankRecImport 

BankRecTransaction 

CABGroup 

CABGroupDetail 

CFGAbsReqStatusData 

CFGAbsReqStatusDescriptions 

CFGAPApprovalStatusData 

CFGAPApprovalStatusDescriptions 

CFGAssetMain 
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Table Name 

CFGBankEntriesCodeData 

CFGBankEntriesCodeDescriptions 

CFGBankImport 

CFGBankImportDetailData 

CFGBankImportDetailDescriptions 

CFGBankPaymentMatchingRule 

CFGBankReceiptMatchingRule 

CFGBankTypeMapping 

CFGCitizenshipData 

CFGCitizenshipDescriptions 

CFGEMLocationData 

CFGEMLocationDescriptions 

CFGEMRegistrationStatusData 

CFGEMRegistrationStatusDescriptions 

CFGEMRegistrationTypeData 

CFGEMRegistrationTypeDescriptions 

CFGEMSkillUsageData 

CFGEMSkillUsageDescriptions 

CFGFAAssetTypeData 

CFGFAAssetTypeDescriptions 

CFGFABookData 

CFGFABookDescriptions 

CFGFADepMethodData 

CFGFADepMethodDescriptions 
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Table Name 

CFGFADepMethodSum 

CFGFAPropertyTypeData 

CFGFAPropertyTypeDescriptions 

CFGFARepairTypeData 

CFGFARepairTypeDescriptions 

CFGFASec179Main 

CFGIntegrationWS 

CFGProjectTemplateData 

CFGProjectTemplateDescriptions 

CVDocuments 

CVDocumentsDetail 

EMCitizenship 

EMCompany  

EMMain  

EQICBooks 

EQICCost 

EQICEMAssoc 

EQUnit 

IntegrationWSLog 

IntegrationWSLogStatus 

IQWebServiceLog 

SavedOptionsDetail 

SavedReportsMain 

SavedSelectionsMain 
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Table Name 

SEApprovalWorkflow 

TLSyncFields 

VendorPhoto 

Removed Tables 
CFGINPUTConfig (columns in this table 
were moved to CFGVisionSystem) 
EM 

Renamed Tables 

INPUTWebServiceLog (renamed to 
IQWebServiceLog) 

New Columns Added to Existing Tables 

Table Name Column Name DataType 

Activity ContactIDForVendor varchar(32) 

Activity Vendor varchar(20) 

apControl AllowAssetEntries varchar(1) NOT NULL 

apDetail AssetType varchar(10) 

apDetail CreateAsset varchar(1) NOT NULL 

apDetail EquipmentID varchar(32) 

apDetail Item varchar(30) 

ApprovalConditions WorkflowAction_UID varchar(32) 

ApprovalWorkflow AssignmentSelection smallint NOT NULL 

ApprovalWorkflowActions Description varchar(250) 

AR RetainageDate datetime 

ARC CommentType varchar(10) 

BIED BookCode varchar(10) 
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Table Name Column Name DataType 

BIED EmOrg varchar(30) 

BIED EquipmentID varchar(32) 

BTLaborCatsData Code varchar(10) 

CAB AvailableForReporting varchar(1) NOT NULL 

CAB CreateDate datetime 

CAB CreateUser varchar(20) 

CAB ModDate datetime 

CAB ModUser varchar(20) 

CAB Notes varchar(max) 

CAB Status varchar(1) 

CAB SubmittedBy varchar(20) 

CAB SubmittedDate datetime 

CABDetail Notes varchar(max) 

CFGAPMain ApprovalWorkflowAP varchar(32) 

CFGAPMain EnableApprovalWorkflowAP varchar(1) NOT NULL 

CFGApprovalType AllowReopen varchar(1) NOT NULL 

CFGApprovalType AutoApprove varchar(1) NOT NULL 

CFGApprovalType EmployeeReopen varchar(max) 

CFGApprovalType ProcessServerMinimum smallint NOT NULL 

CFGApprovalType UseProcessServer varchar(1) NOT NULL 

CFGBanks DisplayGLBalanceOnSummaryTab varchar(1) NOT NULL 

CFGEMail EmailChunkSize int NOT NULL 

CFGEMail MaxEmailSize int NOT NULL 

CFGEMail PrefixEmailSender varchar(1) NOT NULL 

CFGFormat equipmentAutoNumOverride varchar(50) 

CFGFormat equipmentAutoNumSeqLen decimal(19,4) NOT 
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Table Name Column Name DataType 

NULL 

CFGFormat equipmentAutoNumSeqPos smallint NOT NULL 

CFGFormat equipmentAutoNumSeqStart int NOT NULL 

CFGFormat equipmentAutoNumSrc varchar(50) 

CFGFormat VariableOrgLevels varchar(1) NOT NULL 

CFGMainData ApprovalWorkflowGLBud varchar(32) 

CFGMainData EnableApprovalWorkflowGLBud varchar(1) NOT NULL 

CFGPYAccrualsData ApprovalWorkflow varchar(32) 

CFGPYAccrualsData EnableApprovalWorkflow varchar(1) NOT NULL 

CFGRMSettings Hrdecimals smallint NOT NULL 

CFGRMSettings StartingDayOfWeek smallint NOT NULL 

CFGTKMain HideReverseOption varchar(1) NOT NULL 

CFGVisionSystem AddRecs varchar(1) NOT NULL 

CFGVisionSystem AuditUserTag varchar(20) NOT 
NULL 

CFGVisionSystem DefaultOppStage varchar(10) 

CFGVisionSystem IQAccessToken varchar(255) 

CFGVisionSystem IQNotificationEmail varchar(50) 

CFGVisionSystem IQPassword varchar(50) 

CFGVisionSystem IQRefreshToken varchar(255) 

CFGVisionSystem IQURLAdminPath varchar(255) 

CFGVisionSystem IQUserName varchar(50) 

CFGVisionSystem NextAPApprovalID varchar(13) 

CFGVisionSystem UpdRecs varchar(1) NOT NULL 

CL AjeraSync varchar(1) NOT NULL 

CL TLInternalKey varchar(40) 
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ConsolidationBudgets Notes varchar(max) 

ConsolidationBudgetsDetail Notes varchar(max) 

Contacts TLInternalKey varchar(40) 

CR BankAmount01 decimal(19,4) NOT 
NULL 

CR BankAmount02 decimal(19,4) NOT 
NULL 

CR BankAmount03 decimal(19,4) NOT 
NULL 

CR BankAmount04 decimal(19,4) NOT 
NULL 

CR LastCreateEntries datetime 

ekMaster EmployeeCompany varchar(14) NOT 
NULL 

EMAccrual EmployeeCompany varchar(14) NOT 
NULL 

EMAccrualDetail EmployeeCompany varchar(14) NOT 
NULL 

EMDirectDeposit EmployeeCompany varchar(14) NOT 
NULL 

EMInitiation EmployeeCompany varchar(14) NOT 
NULL 

EMInitiation HomeCompany varchar(14) NOT 
NULL 

EMInitiation Location varchar(10) 

EMInitiation TalentUserID varchar(40) 

EMInitiation TLInternalKey varchar(40) 

EMLocale EmployeeCompany varchar(14) NOT 
NULL 

EMPayroll EmployeeCompany varchar(14) NOT 
NULL 

EMPayrollContribution EmployeeCompany varchar(14) NOT 
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NULL 

EMPayrollContributionWage EmployeeCompany varchar(14) NOT 
NULL 

EMPayrollWithholding EmployeeCompany varchar(14) NOT 
NULL 

EMPayrollWithholdingWage EmployeeCompany varchar(14) NOT 
NULL 

EMProjectAssoc CRMHours decimal(19,4) NOT 
NULL 

EMProjectAssocTemplate CRMHours decimal(19,4) NOT 
NULL 

EMRegistration RegistrationType varchar(10) 

EMRegistration Status varchar(10) 

EMResume DefaultInd varchar(1) NOT NULL 

EMSkills SkillUsage smallint NOT NULL 

Equipment AccumulatedDeprAccount varchar(13) 

Equipment AcquisitionDate datetime 

Equipment AdditionalCostInformation varchar(max) 

Equipment AssetStatus varchar(1) 

Equipment AssetType varchar(10) 

Equipment BusinessUsePercent decimal(19,4) NOT 
NULL 

Equipment Calculation varchar(1) 

Equipment DepMethod varchar(10) 

Equipment DepreciationExpAccount varchar(13) 

Equipment DisposalDate datetime 

Equipment InServiceDate datetime 

Equipment LeaseContactID varchar(32) 

Equipment LeaseEndDate datetime 
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Equipment LeaseStartDate datetime 

Equipment LeaseVendor varchar(20) 

Equipment Manufacturer varchar(100) 

Equipment PropertyType varchar(10) 

Equipment RepairAsset varchar(32) 

Equipment RepairType varchar(10) 

Equipment SalvageValue decimal(19,4) NOT 
NULL 

Equipment UsefulLifeYr int NOT NULL 

FW_CFGInfoCenterFieldsData CodeTable varchar(125) 

FW_CFGInfoCenterFieldsData CodeTableCodeCol varchar(125) 

FW_CFGInfoCenterFieldsData CodeTableDescCol varchar(125) 

FW_CFGInfoCenterFieldsData ColLength int NOT NULL 

FW_CFGInfoCenterFieldsData ColumnName varchar(125) 

FW_CFGInfoCenterFieldsData DataType varchar(30) 

FW_CFGInfoCenterFieldsData Decimals smallint NOT NULL 

FW_CFGInfoCenterFieldsData DefaultValue varchar(30) 

FW_CFGInfoCenterFieldsData GridID varchar(125) NOT 
NULL 

FW_CFGInfoCenterFieldsData MaxValue varchar(30) 

FW_CFGInfoCenterFieldsData MinValue varchar(30) 

FW_CFGInfoCenterFieldsData Required varchar(1) NOT NULL 

FW_CFGInfoCenterFieldsData Tablename varchar(125) NOT 
NULL 

FW_CFGInfoCenterFieldsDesc Tablename varchar(125) NOT 
NULL 

FW_CFGSysConfig ClientSecret varchar(32) 

FW_CFGSystem AllowFileSave varchar(1) NOT NULL 
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FW_CFGSystem HideiAccessMenu varchar(1) NOT NULL 

FW_CFGSystem HideKonaMenu varchar(1) NOT NULL 

FW_CFGSystem MarketType varchar(10) 

FW_CFGSystem ProductType varchar(30) 

FW_CFGSystem SessionTimeout int NOT NULL 

FW_CFGSystem SFTPHostName varchar(255) 

FW_CFGSystem SFTPPassword varchar(100) 

FW_CFGSystem SFTPUsername varchar(100) 

FW_CFGSystem WebAPIEnableWorkflow varchar(1) NOT NULL 

FW_CFGSystem WebAPIGenerateCustomPackages varchar(1) NOT NULL 

FW_CFGUserSettingsData ColumnName varchar(125) 

FW_CFGUserSettingsData TableName varchar(125) 

FW_CustomGridsData PropertyBag varchar(max) 

ItemData Manufacturer varchar(100) 

jeControl AllowAssetEntries varchar(1) NOT NULL 

jeDetail EquipmentID varchar(32) 

LedgerAP BookCode varchar(10) 

LedgerAP EmOrg varchar(30) 

LedgerAP EquipmentID varchar(32) 

LedgerAR BookCode varchar(10) 

LedgerAR EmOrg varchar(30) 

LedgerAR EquipmentID varchar(32) 

LedgerEX BookCode varchar(10) 

LedgerEX EmOrg varchar(30) 

LedgerEX EquipmentID varchar(32) 

LedgerMisc BookCode varchar(10) 



Database Changes 

 

Release Notes: Technical Considerations 79 

 

Table Name Column Name DataType 

LedgerMisc EmOrg varchar(30) 

LedgerMisc EquipmentID varchar(32) 

PR AjeraBilledConsultant decimal(19,4) NOT 
NULL 

PR AjeraBilledLabor decimal(19,4) NOT 
NULL 

PR AjeraBilledReimbursable decimal(19,4) NOT 
NULL 

PR AjeraCostConsultant decimal(19,4) NOT 
NULL 

PR AjeraCostLabor decimal(19,4) NOT 
NULL 

PR AjeraCostReimbursable decimal(19,4) NOT 
NULL 

PR AjeraReceivedConsultant decimal(19,4) NOT 
NULL 

PR AjeraReceivedLabor decimal(19,4) NOT 
NULL 

PR AjeraReceivedReimbursable decimal(19,4) NOT 
NULL 

PR AjeraSpentConsultant decimal(19,4) NOT 
NULL 

PR AjeraSpentLabor decimal(19,4) NOT 
NULL 

PR AjeraSpentReimbursable decimal(19,4) NOT 
NULL 

PR AjeraWIPConsultant decimal(19,4) NOT 
NULL 

PR AjeraWIPLabor decimal(19,4) NOT 
NULL 

PR AjeraWIPReimbursable decimal(19,4) NOT 
NULL 

PR ProjectTemplate varchar(10) 
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PR TLInternalKey varchar(40) 

PRAdditionalData PRAdditionalDataID varchar(32) NOT 
NULL 

PRAdditionalData TaskID varchar(32) 

PRDefaults AjeraBilledConsultant decimal(19,4) NOT 
NULL 

PRDefaults AjeraBilledLabor decimal(19,4) NOT 
NULL 

PRDefaults AjeraBilledReimbursable decimal(19,4) NOT 
NULL 

PRDefaults AjeraCostConsultant decimal(19,4) NOT 
NULL 

PRDefaults AjeraCostLabor decimal(19,4) NOT 
NULL 

PRDefaults AjeraCostReimbursable decimal(19,4) NOT 
NULL 

PRDefaults AjeraReceivedConsultant decimal(19,4) NOT 
NULL 

PRDefaults AjeraReceivedLabor decimal(19,4) NOT 
NULL 

PRDefaults AjeraReceivedReimbursable decimal(19,4) NOT 
NULL 

PRDefaults AjeraSpentConsultant decimal(19,4) NOT 
NULL 

PRDefaults AjeraSpentLabor decimal(19,4) NOT 
NULL 

PRDefaults AjeraSpentReimbursable decimal(19,4) NOT 
NULL 

PRDefaults AjeraWIPConsultant decimal(19,4) NOT 
NULL 

PRDefaults AjeraWIPLabor decimal(19,4) NOT 
NULL 

PRDefaults AjeraWIPReimbursable decimal(19,4) NOT 
NULL 
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PRDefaults ProjectTemplate varchar(10) 

PRDefaults TLInternalKey varchar(40) 

PRDescriptions DefaultInd varchar(1) NOT NULL 

PRDescriptionsTemplate DefaultInd varchar(1) NOT NULL 

PRTemplate AjeraBilledConsultant decimal(19,4) NOT 
NULL 

PRTemplate AjeraBilledLabor decimal(19,4) NOT 
NULL 

PRTemplate AjeraBilledReimbursable decimal(19,4) NOT 
NULL 

PRTemplate AjeraCostConsultant decimal(19,4) NOT 
NULL 

PRTemplate AjeraCostLabor decimal(19,4) NOT 
NULL 

PRTemplate AjeraCostReimbursable decimal(19,4) NOT 
NULL 

PRTemplate AjeraReceivedConsultant decimal(19,4) NOT 
NULL 

PRTemplate AjeraReceivedLabor decimal(19,4) NOT 
NULL 

PRTemplate AjeraReceivedReimbursable decimal(19,4) NOT 
NULL 

PRTemplate AjeraSpentConsultant decimal(19,4) NOT 
NULL 

PRTemplate AjeraSpentLabor decimal(19,4) NOT 
NULL 

PRTemplate AjeraSpentReimbursable decimal(19,4) NOT 
NULL 

PRTemplate AjeraWIPConsultant decimal(19,4) NOT 
NULL 

PRTemplate AjeraWIPLabor decimal(19,4) NOT 
NULL 

PRTemplate AjeraWIPReimbursable decimal(19,4) NOT 
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NULL 

PRTemplate ProjectTemplate varchar(10) 

PRTemplate TLInternalKey varchar(40) 

RPTask ChargeType varchar(1) 

RPTask ClientID varchar(32) 

RPTask Org varchar(30) 

RPTask ProjectType varchar(10) 

RPTask ProjMgr varchar(20) 

RPTask Status varchar(1) 

SE AllowAssetEntries varchar(1) NOT NULL 

SE AllowEditPriorDepreciation varchar(1) NOT NULL 

SE NavCRMWorkspace varchar(1) NOT NULL 

SEUser APIRefreshToken varchar(255) 

SEUser APIRefreshTokenIssued datetime 

SEUser APITicket varchar(max) 

SEUser ODBCEnabled varchar(1) NOT NULL 

SEUser ODBCPassword varchar(255) 

SEUser ODBCUsername varchar(255) 

TaxReporting Diary varchar(10) 

TaxReporting DiaryNo int NOT NULL 

tkBreakTime EmployeeCompany varchar(14) NOT 
NULL 

tkDetail EmployeeCompany varchar(14) NOT 
NULL 

tkMaster EmployeeCompany varchar(14) NOT 
NULL 

tkRevisionDetail EmployeeCompany varchar(14) NOT 
NULL 
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Table Name Column Name DataType 

tkRevisionMaster EmployeeCompany varchar(14) NOT 
NULL 

tkUnitDetail EmployeeCompany varchar(14) NOT 
NULL 

unDetail EmployeeCompany varchar(14) 

upDetail EmployeeCompany varchar(14) 

VE AjeraSync varchar(1) NOT NULL 

VE Market varchar(10) 

WorkflowActionEmails AddAttachment varchar(1) NOT NULL 

WorkflowActivity ContactIDForVendor varchar(250) 

WorkflowActivity Vendor varchar(250) 

Changes to Existing Columns 

Table Name Column Name New 
DataType 

Old 
DataType 

apppChecks Org varchar(30) varchar(14) 

ApprovalConditions SQLExpression varchar(max) varchar(1000) 

ApprovalRoleAssignment Org varchar(30) 
NOT NULL 

varchar(14) 
NOT NULL 

BIED AutoEntryOrg varchar(30) varchar(14) 

BIED Org varchar(30) varchar(14) 

BILD EmOrg varchar(30) varchar(14) 

BILD PrOrg varchar(30) varchar(14) 

BillingTemplate FilterOrg varchar(30) varchar(14) 

BTEA FilterOrg varchar(30) varchar(14) 

BTEC FilterOrg varchar(30) varchar(14) 

BTEV FilterOrg varchar(30) varchar(14) 
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Table Name Column Name New 
DataType 

Old 
DataType 

BTRCT FilterOrg varchar(30) varchar(14) 

BTRLT FilterOrg varchar(30) varchar(14) 

BTROT FilterOrg varchar(30) varchar(14) 

BTRRT FilterOrg varchar(30) varchar(14) 

CAB Org varchar(30) varchar(14) 

CFGAPLiability Org varchar(30) varchar(14) 

CFGAutoNumCustomMethodArgs SQLElseExpression varchar(max) varchar(1000) 

CFGAutoNumCustomMethodArgs SQLExpression varchar(max) varchar(1000) 

CFGAutoNumCustomMethodArgs SQLIfExpression varchar(max) varchar(1000) 

CFGAutoNumSprocArgs SQLElseExpression varchar(max) varchar(1000) 

CFGAutoNumSprocArgs SQLExpression varchar(max) varchar(1000) 

CFGAutoNumSprocArgs SQLIfExpression varchar(max) varchar(1000) 

CFGAutoNumWebServiceArgs SQLElseExpression varchar(max) varchar(1000) 

CFGAutoNumWebServiceArgs SQLExpression varchar(max) varchar(1000) 

CFGAutoNumWebServiceArgs SQLIfExpression varchar(max) varchar(1000) 

CFGAwardTypeDescriptions Description varchar(255) 
NOT NULL 

varchar(120) 
NOT NULL 

CFGBanks Org varchar(30) varchar(14) 

CFGCompetitionTypeDescriptions Description varchar(255) 
NOT NULL 

varchar(70) 
NOT NULL 

CFGContactRelationshipData InverseCode varchar(10) varchar(10) 
NOT NULL 

CFGContractTypeGovConDescriptions Description varchar(255) 
NOT NULL 

varchar(70) 
NOT NULL 

CFGEMail AuthPassword varchar(200) varchar(50) 

CFGMasterContractDescriptions Description varchar(255) 
NOT NULL 

varchar(80) 
NOT NULL 
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Table Name Column Name New 
DataType 

Old 
DataType 

CFGOrgCodesData Code varchar(30) 
NOT NULL 

varchar(14) 
NOT NULL 

CFGOrgCodesDescriptions Code varchar(30) 
NOT NULL 

varchar(14) 
NOT NULL 

CFGOrgSetup OrgIntercompany varchar(30) varchar(14) 

CFGOrgSetup PayrollDefOrg varchar(30) varchar(14) 

CustomProposal Org varchar(30) varchar(14) 

CustomProposalEmployee Org varchar(30) varchar(14) 

CustomProposalMktCampaign Org varchar(30) varchar(14) 

CustomProposalOpportunity Org varchar(30) varchar(14) 

CustomProposalProject Org varchar(30) varchar(14) 

EmailTemplates EmailSubject varchar(max) varchar(100) 

EMInitiation Org varchar(30) varchar(14) 

exChecks Org varchar(30) varchar(14) 

FirmOrgAssociations Org varchar(30) 
NOT NULL 

varchar(14) 
NOT NULL 

FW_CFGSystem DefaultOrg varchar(30) varchar(14) 

GLSummary Org varchar(30) 
NOT NULL 

varchar(14) 
NOT NULL 

GLTable FilterOrg varchar(30) varchar(14) 

GR Org varchar(30) varchar(14) 

ICBillingWK OriginatingOrg varchar(30) varchar(14) 

ICBillingWK TargetOrg varchar(30) varchar(14) 

KeyConvertWorkPROrg NewOrg varchar(30) 
NOT NULL 

varchar(14) 
NOT NULL 

LD EmOrg varchar(30) varchar(14) 

LD PrOrg varchar(30) varchar(14) 
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Table Name Column Name New 
DataType 

Old 
DataType 

LD WBS1 varchar(255) varchar(30) 

LedgerAP AutoEntryOrg varchar(30) varchar(14) 

LedgerAP Org varchar(30) varchar(14) 

LedgerAR AutoEntryOrg varchar(30) varchar(14) 

LedgerAR Org varchar(30) varchar(14) 

LedgerEX AutoEntryOrg varchar(30) varchar(14) 

LedgerEX Org varchar(30) varchar(14) 

LedgerMisc AutoEntryOrg varchar(30) varchar(14) 

LedgerMisc Org varchar(30) varchar(14) 

MktCampaign Org varchar(30) varchar(14) 

Opportunity Org varchar(30) varchar(14) 

Opportunity Solicitation varchar(255) varchar(60) 

OpportunityProposals Org varchar(30) varchar(14) 

Organization Org varchar(30) 
NOT NULL 

varchar(14) 
NOT NULL 

OverheadAllocation Org varchar(30) varchar(14) 

OverheadAllocation OrgToDistribute varchar(30) varchar(14) 

PNPlan Org varchar(30) varchar(14) 

PR Org varchar(30) varchar(14) 

PR Solicitation varchar(255) varchar(60) 

PRAdditionalData WBS1 varchar(255) 
NOT NULL 

varchar(30) 
NOT NULL 

PRDefaults Org varchar(30) varchar(14) 

PRDefaults Solicitation varchar(255) varchar(60) 

PRTemplate Org varchar(30) varchar(14) 
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Table Name Column Name New 
DataType 

Old 
DataType 

PRTemplate Solicitation varchar(255) varchar(60) 

RPAssignment WBS1 varchar(255) varchar(30) 

RPConsultant WBS1 varchar(255) varchar(30) 

RPExpense WBS1 varchar(255) varchar(30) 

RPPlan Org varchar(30) varchar(14) 

RPPlan PlanNumber varchar(255) varchar(30) 

RPPlan WBS1 varchar(255) varchar(30) 

RPTask WBS1 varchar(255) varchar(30) 

RPUnit WBS1 varchar(255) varchar(30) 

UN FilterOrg varchar(30) varchar(14) 

VE Org varchar(30) varchar(14) 

WorkflowActionColumnUpdate SQLElseExpression varchar(max) varchar(1000) 

WorkflowActionColumnUpdate SQLExpression varchar(max) varchar(1000) 

WorkflowActionColumnUpdate SQLIfExpression varchar(max) varchar(1000) 

WorkflowActionDashboard DashboardSummary varchar(max) 
NOT NULL 

varchar(100) 
NOT NULL 

WorkflowActionDashboard ToListRoles varchar(max) varchar(250) 

WorkflowActionDashboard ToListSpecial varchar(max) varchar(250) 

WorkflowActionDashboard ToListSpecialDisplay varchar(max) varchar(500) 

WorkflowActionDashboard ToListUsers varchar(max) varchar(250) 

WorkflowActionEmails BCCListRoles varchar(max) varchar(250) 

WorkflowActionEmails BCCListSpecial varchar(max) varchar(250) 

WorkflowActionEmails BCCListSpecialDisplay varchar(max) varchar(250) 

WorkflowActionEmails BCCListUsers varchar(max) varchar(250) 

WorkflowActionEmails CCListRoles varchar(max) varchar(250) 
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DataType 

Old 
DataType 

WorkflowActionEmails CCListSpecial varchar(max) varchar(250) 

WorkflowActionEmails CCListSpecialDisplay varchar(max) varchar(250) 

WorkflowActionEmails CCListUsers varchar(max) varchar(250) 

WorkflowActionEmails EmailSubject varchar(max) varchar(100) 

WorkflowActionEmails ToListRoles varchar(max) varchar(250) 

WorkflowActionEmails ToListSpecial varchar(max) varchar(250) 

WorkflowActionEmails ToListSpecialDisplay varchar(max) varchar(250) 

WorkflowActionEmails ToListUsers varchar(max) varchar(250) 

WorkflowActionMethodArgs SQLElseExpression varchar(max) varchar(1000) 

WorkflowActionMethodArgs SQLExpression varchar(max) varchar(1000) 

WorkflowActionMethodArgs SQLIfExpression varchar(max) varchar(1000) 

WorkflowActionSprocArgs SQLElseExpression varchar(max) varchar(1000) 

WorkflowActionSprocArgs SQLExpression varchar(max) varchar(1000) 

WorkflowActionSprocArgs SQLIfExpression varchar(max) varchar(1000) 

WorkflowActionWebServiceArgs SQLElseExpression varchar(max) varchar(1000) 

WorkflowActionWebServiceArgs SQLExpression varchar(max) varchar(1000) 

WorkflowActionWebServiceArgs SQLIfExpression varchar(max) varchar(1000) 

WorkflowConditions SQLExpression varchar(max) varchar(1000) 

XChargeWk EmpOrg varchar(30) varchar(14) 

XChargeWk ProjOrg varchar(30) varchar(14) 
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Removed Columns 

Table Name Column Name DataType 

CFGPOMain NextEquipment int NOT NULL 

VE Competitor varchar(1) NOT NULL 

VE GovernmentAgency varchar(1) NOT NULL 

Renamed Columns 

None 

New Objects 

Object Name Object Type 

FK_Activity_ContactIDForVendor_Con ForeignKey 

FK_Activity_Employee_EMMain ForeignKey 

FK_Activity_Vendor_VE ForeignKey 

FK_ADPExport_Employee_EMMain ForeignKey 

FK_BTRCTEmpls_Employee_EMMain ForeignKey 

FK_BTROTEmpls_Employee_EMMain ForeignKey 

FK_BTRRTEmpls_Employee_EMMain ForeignKey 

FK_CustomProposalEmployee_Employee_EMMain ForeignKey 

FK_CustomProposalEmployeeGraphics_Employee_EMMain ForeignKey 

FK_CustomProposalProjTeam_Employee_EMMain ForeignKey 

FK_ekDetail_Employee_EMMain ForeignKey 

FK_ekMaster_Employee_EMMain ForeignKey 

FK_EMAccrual_Employee_EMMain ForeignKey 

FK_EMAccrualDetail_Employee_EMMain ForeignKey 
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FK_EMActivity_Employee_EMMain ForeignKey 

FK_EMClientAssoc_Employee_EMMain ForeignKey 

FK_EMContactAssoc_Employee_EMMain ForeignKey 

FK_EMDegree_Employee_EMMain ForeignKey 

FK_EMEKGroups_Employee_EMMain ForeignKey 

FK_EMMain_Vendor_VE ForeignKey 

FK_EmployeeCustomTabFields_Employee_EMMain ForeignKey 

FK_EmployeeFileLinks_Employee_EMMain ForeignKey 

FK_EMProjectAssoc_Employee_EMMain ForeignKey 

FK_EMProjectAssoc_WBS_PR ForeignKey 

FK_EMRegistration_Employee_EMMain ForeignKey 

FK_EMResume_Employee_EMMain ForeignKey 

FK_EMSkills_Employee_EMMain ForeignKey 

FK_EMTKGroups_Employee_EMMain ForeignKey 

FK_erDetail_Employee_EMMain ForeignKey 

FK_EX_Employee_EMMain ForeignKey 

FK_EXAdvance_Employee_EMMain ForeignKey 

FK_exChecks_Employee_EMMain ForeignKey 

FK_exMaster_Employee_EMMain ForeignKey 

FK_laDetail_Employee_EMMain ForeignKey 

FK_laMaster_Employee_EMMain ForeignKey 

FK_LedgerAP_Employee_EMMain ForeignKey 

FK_LedgerAR_Employee_EMMain ForeignKey 
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Object Name Object Type 

FK_LedgerEX_Employee_EMMain ForeignKey 

FK_LedgerMisc_Employee_EMMain ForeignKey 

FK_MktCampaign_CampaignMgr_EMMain ForeignKey 

FK_MktCampaign_Manager3_EMMain ForeignKey 

FK_MktCampaign_MktgMgr_EMMain ForeignKey 

FK_OpportunityEMAssoc_Employee_EMMain ForeignKey 

FK_OpportunityProposals_Employee_EMMain ForeignKey 

FK_SEUser_Employee_EMMain ForeignKey 

FK_SF255Employees_Employee_EMMain ForeignKey 

FK_SF330Personnel_Employee_EMMain ForeignKey 

FK_tkBreakTime_Employee_EMMain ForeignKey 

FK_tkDetail_Employee_EMMain ForeignKey 

FK_tkMaster_Employee_EMMain ForeignKey 

FK_tkUnitDetail_Employee_EMMain ForeignKey 

FK_tsDetail_Employee_EMMain ForeignKey 

FK_tsMaster_Employee_EMMain ForeignKey 

FK_WorkflowEMActivity_EMMain ForeignKey 

FK_XChargeWk_Employee_EMMain ForeignKey 

getICMetadata Function 

GetLaborCodeDesc Function 

ngRP$tabCalendarInterval Function 

ngRP$tabPeriodETC Function 

ngRP$tabResources Function 
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Object Name Object Type 

CFGLCCodesDescriptions Index 

CLNameClientIDIDX Index 

EMCompanyTimeAnalysisIDX Index 

EQICCostEquipIDPeriodIDX Index 

LedgerAPEquipIDBookCodeIDX Index 

LedgerAREquipIDBookCodeIDX Index 

LedgerMiscEquipIDBookCodeIDX Index 

POMasterVendorIDX Index 

PROrgRestrictChargeCompaniesIDX Index 

SavedOptionsDetailParentKeyIDX Index 

SavedReportsMainUsernameIDX Index 

SavedSelectionsMainUsernameIDX Index 

DeleteCFGAbsReqStatusTrigger Trigger 

DeleteCFGAPApprovalStatusTrigger Trigger 

DeleteCFGBankEntriesTrigger Trigger 

DeleteCFGBankImportDetailTrigger Trigger 

DeleteCFGCitizenshipTrigger Trigger 

DeleteCFGEMLocationTrigger Trigger 

DeleteCFGEMRegistrationStatusTrigger Trigger 

DeleteCFGEMRegistrationTypeTrigger Trigger 

DeleteCFGEMSkillUsageTrigger Trigger 

DeleteCFGFAAssetTypeTrigger Trigger 

DeleteCFGFABookTrigger Trigger 
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Object Name Object Type 

DeleteCFGFADepMethodTrigger Trigger 

DeleteCFGFAPropertyTypeTrigger Trigger 

DeleteCFGFARepairTypeTrigger Trigger 

DeleteCFGProjectTemplateTrigger Trigger 

DeleteEMTrigger Trigger 

DeleteEMAllCompanyTrigger Trigger 

InsertCFGAbsReqStatusTrigger Trigger 

InsertCFGAPApprovalStatusTrigger Trigger 

InsertCFGBankEntriesTrigger Trigger 

InsertCFGBankImportDetailTrigger Trigger 

InsertCFGCitizenshipTrigger Trigger 

InsertCFGEMLocationTrigger Trigger 

InsertCFGEMRegistrationStatusTrigger Trigger 

InsertCFGEMRegistrationTypeTrigger Trigger 

InsertCFGEMSkillUsageTrigger Trigger 

InsertCFGFAAssetTypeTrigger Trigger 

InsertCFGFABookTrigger Trigger 

InsertCFGFADepMethodTrigger Trigger 

InsertCFGFAPropertyTypeTrigger Trigger 

InsertCFGFARepairTypeTrigger Trigger 

InsertCFGProjectTemplateTrigger Trigger 

InsertEMTrigger Trigger 

InsertEMAllCompanyTrigger Trigger 
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UpdateCFGAbsReqStatusTrigger Trigger 

UpdateCFGAPApprovalStatusTrigger Trigger 

UpdateCFGBankEntriesTrigger Trigger 

UpdateCFGBankImportDetailTrigger Trigger 

UpdateCFGCitizenshipTrigger Trigger 

UpdateCFGEMLocationTrigger Trigger 

UpdateCFGEMRegistrationStatusTrigger Trigger 

UpdateCFGEMRegistrationTypeTrigger Trigger 

UpdateCFGEMSkillUsageTrigger Trigger 

UpdateCFGFAAssetTypeTrigger Trigger 

UpdateCFGFABookTrigger Trigger 

UpdateCFGFADepMethodTrigger Trigger 

UpdateCFGFAPropertyTypeTrigger Trigger 

UpdateCFGFARepairTypeTrigger Trigger 

UpdateCFGProjectTemplateTrigger Trigger 

UpdateEMTrigger Trigger 

UpdateEMAllCompanyTrigger Trigger 

CFGAbsReqStatus View 

CFGAPApprovalStatus View 

CFGBankEntries View 

CFGBankImportDetail View 

CFGCitizenship View 

CFGEMLocation View 
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CFGEMRegistrationStatus View 

CFGEMRegistrationType View 

CFGEMSkillUsage View 

CFGFAAssetType View 

CFGFABook View 

CFGFADepMethod View 

CFGFAPropertyType View 

CFGFARepairType View 

CFGProjectTemplate View 

EM View 

EMAllCompany View 

IntGLBudgetGroups View 

Removed Objects 

Object Name Object Type 

FK_Activity_Employee_EM ForeignKey 

FK_ADPExport_Employee_EM ForeignKey 

FK_BTRCTEmpls_Employee_EM ForeignKey 

FK_BTROTEmpls_Employee_EM ForeignKey 

FK_BTRRTEmpls_Employee_EM ForeignKey 

FK_CustomProposalEmployee_Employee_EM ForeignKey 

FK_CustomProposalEmployeeGraphics_Employee_EM ForeignKey 

FK_CustomProposalProjTeam_Employee_EM ForeignKey 
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Object Name Object Type 

FK_ekDetail_Employee_EM ForeignKey 

FK_ekMaster_Employee_EM ForeignKey 

FK_EM_Vendor_VE ForeignKey 

FK_EMAccrual_Employee_EM ForeignKey 

FK_EMAccrualDetail_Employee_EM ForeignKey 

FK_EMActivity_Employee_EM ForeignKey 

FK_EMClientAssoc_Employee_EM ForeignKey 

FK_EMContactAssoc_Employee_EM ForeignKey 

FK_EMDegree_Employee_EM ForeignKey 

FK_EMEKGroups_Employee_EM ForeignKey 

FK_EmployeeCustomTabFields_Employee_EM ForeignKey 

FK_EmployeeFileLinks_Employee_EM ForeignKey 

FK_EMProjectAssoc_Employee_EM ForeignKey 

FK_EMRegistration_Employee_EM ForeignKey 

FK_EMResume_Employee_EM ForeignKey 

FK_EMSkills_Employee_EM ForeignKey 

FK_EMTKGroups_Employee_EM ForeignKey 

FK_erDetail_Employee_EM ForeignKey 

FK_EX_Employee_EM ForeignKey 

FK_EXAdvance_Employee_EM ForeignKey 

FK_exChecks_Employee_EM ForeignKey 

FK_exMaster_Employee_EM ForeignKey 

FK_laDetail_Employee_EM ForeignKey 
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Object Name Object Type 

FK_laMaster_Employee_EM ForeignKey 

FK_LedgerAP_Employee_EM ForeignKey 

FK_LedgerAR_Employee_EM ForeignKey 

FK_LedgerEX_Employee_EM ForeignKey 

FK_LedgerMisc_Employee_EM ForeignKey 

FK_MktCampaign_CampaignMgr_EM ForeignKey 

FK_MktCampaign_Manager3_EM ForeignKey 

FK_MktCampaign_MktgMgr_EM ForeignKey 

FK_OpportunityEMAssoc_Employee_EM ForeignKey 

FK_OpportunityProposals_Employee_EM ForeignKey 

FK_SEUser_Employee_EM ForeignKey 

FK_SF255Employees_Employee_EM ForeignKey 

FK_SF330Personnel_Employee_EM ForeignKey 

FK_tkBreakTime_Employee_EM ForeignKey 

FK_tkDetail_Employee_EM ForeignKey 

FK_tkMaster_Employee_EM ForeignKey 

FK_tkUnitDetail_Employee_EM ForeignKey 

FK_tsDetail_Employee_EM ForeignKey 

FK_tsMaster_Employee_EM ForeignKey 

FK_WorkflowEMActivity_EM ForeignKey 

FK_XChargeWk_Employee_EM ForeignKey 

EMTimeAnalysisIDX Index 

DelFW_CFGInfoCenterFields Trigger 
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Object Name Object Type 

InsFW_CFGInfoCenterFields Trigger 

UpdFW_CFGInfoCenterFields Trigger 

Renamed Objects 

None 
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Appendix A: Software Issues Resolved and 
Enhancements in Vision 7.4 Cumulative Updates 
The following resolved software issues and enhancements in the Vision 7.4 cumulative updates 
(issued after the 7.4 release) are also included in the Vision 7.5 release. 
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Cumulative Update 11 — Released October 23, 
2015 

Software Enhancements 

Upgrading Tableau Software 
When upgrading to a version of Vision that has a new version of Tableau, the following Tableau 
components will also need to be updated.  

 Tableau Server software. This is part of the Deltek Vision Performance Management 
installation. 

 Tableau Worker software (distributed environments only). 

 TabCmd command line utility. As of Vision 7.4 CU 11 the TabCmd utility is included as 
part of the Deltek Vision Web/Application tier installation and is located in the 
\Vision\Support\Utilities\TabCmd folder. 

 Tableau Desktop software. Available via the Deltek Software Manager. 

 

With the release of Vision 7.4 CU 11, all Tableau software components previously in use will require 
upgrading to Tableau 9.0.4. Additionally, Deltek is only supporting the Tableau Server 64-bit installation. If 
you have previously installed Tableau 8.0.2 on a 32-bit server a new 64-bit server will be required to install 
Tableau 9.0.4. 

The Performance Management installation for Vision 7.4 CU 11 will check for previous 
installations of Tableau software and prompts you to uninstall that software before continuing. 

Tableau software component upgrades are not typical software upgrades, in that you must 
uninstall the previous version before you can install the new one. However, the uninstall process 
does preserve all previously installed configuration settings. In the case of Tableau Server, this 
means that you will not lose any information (workbooks, users, or any other configuration 
settings). 

The Tableau software for Vision Performance Management is specifically branded for Deltek, and 
Deltek must be your source for that software. Do not attempt to upgrade Tableau with software 
from a source other than Deltek (e.g. from Tableau directly). 

Tableau 8.2, 8.1.6 and 8.0.2 Security Vulnerability 
 

 

Tableau versions 8.2, 8.1.6 and 8.0.2 have a security vulnerability that can cause an escalation of 
privilege. Deltek is supporting Tableau version 9.0.4 for Vision 7.4 CU 11 and 7.5 which includes the 
correction to this security vulnerability. All customers currently using Tableau 8.2, 8.1.6 or 8.0.2 are 
encouraged to upgrade to Vision 7.4 CU 11 Wand upgrade Tableau to version 9.0.4. More information on 
this security vulnerability can be found in the link below: 

http://kb.tableau.com/articles/knowledgebase/security-advisory-users-can-be-impersonated 

System Requirements 
There is also a change in the minimum system requirements to install Tableau 9.0. These 
requirements are a server with 4 cores and 8 GB of RAM: 

http://kb.tableau.com/articles/knowledgebase/security-advisory-users-can-be-impersonated?utm_campaign=9.0.4%20OEM%20Notification%20-%20USCA%20en-US%20-%202015-07-21&utm_medium=email&utm_source=Eloqua&domain=deltek.com&eid=CTBLS000005698929&elq=b051c86973874c309df9ae813ff88632
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 The Deltek VPM installer will check for the required Tableau minimum system 
requirements which are no longer a warning as in previous versions. If your system does 
not meet the minimum requirements you will not be able to proceed with the installation. 

 Similarly, the Tableau installation (if run separately) will provide the following failure if the 
system does not meet the minimum specifications and you will not be able to proceed 
with the installation: 

 

 -- Verification result: FAILED 

 

Setup cannot continue because the system does not meet minimum requirements. 
Please make sure that the system meets the minimum recommended Tableau Server 
requirements: http://www.tableausoftware.com/products/server/specs 

 

Reason: 

Processor (cores): 1 (minimum required is 4) 

Memory: 2 GB (minimum required is 8 GB) 

 

Other resources found: 

Available disk space: 27.66 GB 

Operating System: Microsoft Windows Server 2012 Standard 

 

Edit Domain Nicknames With Active Directory Authentication: 
If you use Active Directory with Tableau Server and you need to add user accounts from a trusted 
domain, the first time you attempt to add the user using the standard domain nickname (for 
example DOMAIN\User) Tableau server will not be able to recognize the domain nickname. In 
this situation, you must enter the domain using the fully qualified domain name (for example 
DOMAIN.COMPANY.COM\User). In addition, because of a defect in Tableau Server, it assumes 
that the first word before the period in the fully qualified domain name is the domain nickname 
(DOMAIN for the example above). This may or may not be correct for your organization. If it is not 
correct, users cannot to authenticate to Tableau Server until you correct the domain nickname. 

To resolve this problem, complete the following steps. The editing of the domain nickname was 
previously available through the Tableau Administration application. As of Tableau 9.0 this must 
be done via the TabCmd utility: 

1. Ensure that the TabCmd utility is installed on the Vision application server. 

2. From an Administrative command prompt on the Vision application server, change 
directory to <drive>:\Program Files\Tableau\Tableau Server\9.0\extras\Command Line 
Utility. 

3. Enter the following Tableau command: 
 
tabcmd listdomains --username <Tableau administrator domain username> --server 
<Tableau server> 
 
You will be prompted for the password for the Tableau administrator domain username. 

4. The result of this command will be similar to the following: 
 

http://www.tableausoftware.com/products/server/specs
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===== Listing domains from the server... 
===== 
ID  Nickname    Name 
1  local     local 
2  <domain1>   <FQDN of domain1>. 
3  <domain2>   <FQDN of domain2> 

5. Identify the domain ID where the Nickname is incorrect. 

6. Enter the following Tableau command: 
 
tabcmd editdomain --id 3 --nickname "<correct nickname>" 

7. The result of this command will show the updated Domain nickname and your users from 
that domain should now be able to login automatically. 

VisionXtend — DupeCheckFields and DupeUpdateExcludeFields 
Two new attributes have been added to VisionXtend that allow you to turn inserts to tables into 
updates, based on a given set of fields. 

The new attributes are:  

DupeCheckFields — This applies only for SendDataToDeltekVisionWithReturn calls. This 
attribute is a comma-delimited list of fields that, if provided, is used as a key value for any 
INSERTS in the DataXML. If those values already match a record in the database, then the 
INSERT will become an UPDATE. 

DupeUpdateExcludeFields — This attribute is checked only if the DupeCheckFields attribute is 
present and has a value. DupeUpdateExcludeFields is a comma-delimited list of fields that will 
be excluded from the update when a record is being converted from an INSERT to an UPDATE. 

Software Issues Resolved 

Accounting 

Revenue » Revenue Generation 
Defect 542986: When running Revenue Generation, the revenue amount doubled for certain 
projects. This was due to project format where project numbers were different lengths and had 
multiple delimiters.  

Customers Impacted: This defect applies to Vision versions 7.4 and earlier.  

Workaround Before Fix: Run key conversion on the number in a separate run. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.RevenueGeneration.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Tax File Generation 
Defect 550983: This applies if you use the Dutch or German languages in Vision. For the VAT 
Declaration XML file format, a column heading in the XML Tax Declaration Detail report was 
translated incorrectly and has been corrected.  

 For the Dutch language, the column heading was Transfer type or Type Over. Now it is 
Tran Type. 

 For the German language, the column heading was Trans.-typ or Tran Umb. Now it is 
Tran Typ. 

Customers Impacted: This defect applies to Vision 7.4 if you use the Dutch or German 
languages in Vision. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportLabels.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Billing 

Batch Billing 
Defect 546330: When web.config was set to S to save on the SFTP server, invoices were 
incorrectly saved to the App server. This occurred when Batch Billing was run from the Process 
Server. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: Invoices will save to the SFTP server from Batch Billing after updating 
Deltek.Vision.ProcessServer.Server.exe.config with 

</configSections> 

<appSettings> 

<add key="AllowFileSave" value="S" /> 

</appSettings> 

Files Updated 
 

Other Applications Affected 
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Database Changes 
 

System File Dependencies 

 

Defect 550022: A new web service API method ExecuteStoredProcedure has been added to 
support executing a stored procedure. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

Configuration  

General » Merge Templates 
Defect 546306: This applies if you use Deltek First Vision Essentials (the SaaS version of 
Vision). When you merged documents using a Microsoft Word merge template, periodically the 
merge would fail, and you received a File not Found exception error. 

This occurred when all of the following were true: 

 Load balanced web/application servers are configured. 

 Load balancing is configured to not use sticky sessions. 

 Database session state is being used. 

Customers Impacted: This defect applies to Vision First Vision Essentials versions 7.0–7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.MergeBO.Server.dll 

Deltek.Vision.Merge.Client.dll 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Dashboard 
Defect 530289: User-defined vendors, employees, and clients were not available for selection as 
dashparts. In addition, the only option for tab selection was "All."  

Customers Impacted: This defect applies to Vision 7.4 

Workaround Before Fix: None.  

Additional Notes: None 

Files Updated 

Deltek.Vision.CustomTabs.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 550968: User-defined Info Center dashparts were lost after upgrading Vision to 7.4. This 
was fixed so that the old dashparts were restored if not re-configured in 7.4.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
DeltekVision74GACU011.sql 

Other Applications Affected 
 

Database Changes 

Removed old Dashparts with new class name that have default columns. Also updated old 
Dashparts with the new class name that do not have default columns. 

System File Dependencies 

Human Resources 

ABRA Interface 
Defect 551235: When you used the ABRA interface to import payroll data into Vision, you 
received the following error: “Invalid column name ‘TalentUserID. No record imported. Please 
check”. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated  
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DeltekVision74GACU011.sql 

Other Applications Affected 
 

Database Changes 

The TalentUserID column was added to the EMInitiation table. 

System File Dependencies 

Purchasing 
Defect 547969: The following applies if you enabled the Modify Not to Exceed Values via 
Change Order check box on the General tab in Configuration » Purchasing & Inventory » 
Company Settings. 

When you tried to create an AP voucher from a purchase order in Accounting » Accounts 
Payable » Create Voucher from PO, you were unable to create the AP voucher if all of the 
following applied: 

 The purchase order was a service or blanket type purchase order. 

 You entered a not-to-exceed amount for the purchase order. 

 You entered a change order with a not-to-exceed amount for the purchase order. 

 The amount of the AP voucher exceeded the original not-to-exceed limit that you entered 
for the purchase order, but it did not exceed the combined total of the not-to-exceed 
amount entered for the purchase order and the change order.  

You should have been able to create the AP voucher as long as its total did not exceed the 
combined total of the not-to-exceed amount entered for the purchase order and for the change 
order. 

Customers Impacted: This defect applies if you use Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.PORoutines.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Reporting 

Defect 550974: The Transaction Type field was translated incorrectly on the Account Analysis 

and Tax Analysis reports.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None.  
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Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportLabels.Server.dll 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 

Accounts Receivable  
Defect 547024: When To Billing Contact was selected as the Email/Schedule option for 
emailing the AR Statement report in Reporting » Accounts Receivable, the following error 
occurred if a large range of billing clients or contacts were included: "TranslateDBF unknown 
function DBF_IDX] ON 
##AS_ARStatementCustom__96FCCAE53EE6466F90DF6E2D0CD1BDBF" 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Run this report with smaller batches. If the error occurs on a batch, run 
that individual batch again.  

Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportingAccountsReceivable.Server.dll 

Deltek.Vision.Report.Server.dll 

DeltekVision74GACU011.sql 

Other Applications Affected 
 

Database Changes 
Rebuilt index PRWBS1IDX to include the following columns: BillingClientID and BillingContactID. 

System File Dependencies 
 

Time and Expense 

Timesheet 
Defect 254935: When two different users were logged into Vision at the same time, both users 
could post the same timesheet file. This resulted in Vision posting the file twice.  

Customers Impacted: This issue applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 
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Files Updated 

Deltek.Vision.Posting.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Utilities 

Advanced Utilities » HRsmart Web Service 
Defect 546155: When using a French Canadian database, the Web Service Call log message in 
Utilities » Advanced Utilities » Talent Management Web Service was not translated.  

Customers Impacted: This defect applies to Vision 7.4 

Workaround Before Fix: None 

Additional Notes: None. 

Files Updated 

Deltek.Vision.TalentWebService.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Vision XTend 
Defect 495346: If you used the UpdateProject API to update a project record, the process halted 
if the Billing Currency field was not in the imported data. This field should not be required.

 

Customers Impacted: This defect applies to Vision 7.2 and later versions. 
 

Workaround Before Fix: Have the API re-use the Billing Currency data that is already in the 
project record. 

 

Additional Notes: None.
 

 

 

Files Updated 

 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 

 
Defect 524083: This applies if you use VisionXtend to update records in Vision. You were unable 
to update the Utilization Ratio field for employee records.  

Customers Impacted: This defect applies to VisionXtend if you use Vision 7.3 and later. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Defect 501388: This applies if you use VisionExtend. The new columns that were added in Vision 
7.3 to the Contract Details table were missing from the API schema, which prevented the 
columns from being updated and inserted in Vision. 

Customers Impacted: This defect applies to Vision 7.3 and 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Defect 550102: This applies when you use VisionXtend and the Deltek Costpoint Connector 
software. When you used an insert via the API call SendDataToDeltekVisionWithReturn to send 
an EMProjectAssoc record that already exists and you used the SessionID attribute in the 
ConnXML parameter, you received the following error: “Object reference not set to an instance of 
an object.” 

Customers Impacted: This defect applies when you use VisionXtend 7.3 or 7.4 and the Deltek 
Costpoint Connector software, which is used to import data into Deltek GovWin Capture 
Management from Deltek Costpoint.  

Workaround Before Fix: Do not use the SessionID attribute. Use the userName and 
userPassword attributes instead. 

Additional Notes: None. 
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Files Updated 

Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Defect 548119: VisionXtend allowed you to insert data in the ProjectCustomTabFields table 
when no matching record was found in the PR table. 

Customers Impacted: This defect applies if you use VisionXtend in Vision versions 7.4 and 
earlier. This also affects Costpoint to GovWin CRM Integration and any calling application that 
inserts records in ProjectcustomTabFields via API. 

Workaround Before Fix: Use update statements instead of insert statements for changes to the 
ProjectCustomTabFields table. VisionXtend automatically inserts a record in 
ProjectCustomTabFields when a record is added into the PR table. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Cumulative Update 10 — Released September 18, 
2015 

Regulatory Enhancements 

2015 Connecticut Income Tax Withholding 
The following tables are updated for Connecticut:

 

 Personal Exemptions (Table A) for filing status F 

 Withholding Tax Calculation (Table B) for all filing statuses (A, B, C, D, and F) 

 Tax Recapture (Table D) for all filing statuses (A, B, C, D, and F) 

 Personal Tax Credits (Table E) for filing status F 
 

Withholding Tax Calculation 

The Department of Revenue released the updated percentage withholding tables that reflect the 
two new income tax rates for high earners. The tables are effective January 1, 2015. Employers 
should implement the tables by August 31, 2015, but do not have to adjust previous withholding 
during 2015.

 

The new income tax rates are as follows:
 

 Income of single taxpayers that is more than $250,000 and less than $500,000 and 
income of married individuals that is more than $500,000 and less than $1 million are to 
be taxed at 6.9%.  

 Income of single employees that is more than $500,000 and income of married 
individuals that is more than $1 million are to be taxed at 6.99%.  

Connecticut's previous top income tax rate was 6.7%. 
 

For more information, see http://www.ct.gov/drs/lib/drs/forms/2015withholding/tpg-
211_20150805.pdf.

 

Files Updated 

Deltek.Vision.PayrollBO.Server.dll
 

Other Applications Affected 

PRMSTI 

PRMSSD 

PRMSTT 

Database Changes 
 

System File Dependencies 
 

http://www.ct.gov/drs/lib/drs/forms/2015withholding/tpg-211_20150805.pdf
http://www.ct.gov/drs/lib/drs/forms/2015withholding/tpg-211_20150805.pdf
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Software Enhancements 

Purchase Template Editor 
A new Print Firm Name From Configuration check box was added to the General tab of the 
Purchase Template Editor form in Purchasing » Purchase Template Editor. This check box 
controls whether or not your firm's name (entered on the General tab in Configuration » General 
» Company Settings) will print in the upper left of a purchase order or request for price quote. 
The check box is selected by default. In previous Vision versions, your firm's name printed 
automatically in the upper left, and you could not remove it.

 

Note: The Print Firm Name check box in the Firm Block section on the General tab of the 
Purchase Template Editor form, controls whether or not your firm's name (entered on the Misc 
tab of the Purchase Template Editor form in Purchasing » Purchase Template Editor) prints in 
the firm block on the purchase order and request for price quote. The firm block is at the top 
center of a purchase order and request for price quote. 

 

Files Updated 

Deltek.Vision.ReportingPurchasing.Server.dll
 

Deltek.Vision.PurchaseTemplateEditor.Client.dll
 

Form Purchase Order.rdl 
 

Form Request for Price Quote.rdl 
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Tax Analysis Report 
A Tax Payable column was added to the Tax Analysis report in Reporting » Accounting. The 
new column displays the payable portion of the input tax for a transaction. 

 

If you are using the Multicurrency feature and you have tax auditing enabled, you have the option 
to have the report display net amounts, tax basis amounts, and tax amounts in any of the 
following types of currency: transaction currency, functional currency, or tax currency. You specify 
the type of currency that you want to use in the report on the General tab of the Options for Tax 
Analysis dialog box. 

 

Files Updated 

Deltek.Vision.ReportingAccount.Server.dll
 

Tax Analysis.rdl
 

Deltek.Vision.ReportLabels.server.dll
 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 

 

Deltek Talent Management Integration 

Overview 
You can now use Deltek Talent Management (formerly named Deltek HRsmart) with Vision. This 
integration gives you the ability to create employee data in Vision for new hires that were recently 
on-boarded within Talent Management. You use Vision’s new Talent Management Web Service 
application to complete the import/export process on demand, or you can schedule it to run at a 
certain time.  

The following data is included in the integration from Vision to Talent Management: 

Vision Talent 
Management Notes 

Employees Users Provides Talent Management user records for 
existing employees in Vision. This will grant all users 
access to the Talent Management suite of products.  

Company/Organizations Org Levels Provides Talent Management with both Vision 
Company and Organization structure.  

 

 

Based on integration options, the integration can be used to provide data initialization from 
Talent Management to Vision or a synchronization based on what has changed in Vision since 
last time it was executed. 

From Talent Management to Vision, the integration currently supports only the creation of new 
hires in Vision. 

Pre-Installation Information 
Minimum System Requirements 
You must have the following software installed to use the Vision and Talent Management 
integration: 

 Vision 7.4 CU 10 and later (required) 

 Talent Management version 12.2.13.1 and later (required) 

Data Mapping and Troubleshooting 
For information about the mapping of data between Vision and Talent Management, refer to the 
Deltek Vision 7.4 Talent Management Integration Technical Guide. This guide provides field-level 
data mapping information that the integration uses. 

If you encounter any issues while transferring data, you can view the log files and error files 
created by the integration process and use the information for troubleshooting. The steps for 
viewing these files are discussed in the “Troubleshooting” section of the Deltek Vision 7.4 Talent 
Management Integration Technical Guide. 
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Enhancements in Vision 7.4 to Support the Talent Management Integration 
To support the integration between Vision and Talent Management, the following changes were 
made in Vision: 

Configuration 

You enable the Talent Management Web Service by selecting the Enable Talent Management 
Web Service check box on the Configuration tab in Utilities » Advanced Utilities » Talent 
Management Web Service. Then you need to enter values for the Talent Management Web 
Service URL, Password, and Number of Rows Per Call fields. Click the Test Connection 
button to check if the settings are correct.  

Talent Management Web Service  

You can run the Talent Management Web Service to receive employee data from Talent 
Management and send it to Vision. Conversely, you can make changes to organizational data 
and employee data in Vision and use the Talent Management Web Service to update the records 
in Talent Management.  

On the General Tab in Utilities » Advanced Utilities » Talent Management Web Service, you 
can select the data you want to receive or send. You can also run the service or set a schedule 
for when to run the web service. 

Talent Management User ID  

The Talent Management application automatically assigns a Talent Management user ID to 
employee records that were created in the system or those that were sent from Vision. In Vision, 
the Talent Management user ID appears as a read-only field on the General tab of the Employee 
Info Center form. 

Alerts 

When you run the Talent Management Web Service, any errors or warning conditions are 
displayed in the Talent Management Web Service Call log. You can view the call log on the 
General tab in Utilities » Advanced Utilities » Talent Management Web Service. You can also 
view alerts on the Process Queue Manager screen in Utilities » Process Server » Queue 
Manager. 

You can create a user-initiated workflow in Configuration » Workflow to notify specific 
employees when Vision receives new employee records from Talent Management. 

Files Updated 
DeltekVision74GACU010.sql 

\Reports\Standard\DataExport\EmployeeDataSource.rdl 

\Reports\Standard\Employee\Employee List.rdl 

Deltek.Vision.EmployeeInfoCenter.Client.dll 

Deltek.Vision.EmployeeInfoCenter.Server.dll 

Deltek.Vision.GeneralCompanySetup.Client.dll 

Deltek.Vision.GeneralCompanySetup.Server.dll 

Deltek.Vision.Lookup.Server.dll 

Deltek.Vision.ReportLabels.Server.dll 

Deltek.Vision.SysLogin.Server.dll 

Deltek.Vision.TalentWebService.Client.dll 
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Deltek.Vision.TalentWebService.Server.dll 

Deltek.Vision.ReportingDataExport.Client.dll 

Deltek.Vision.ReportingDataExport.Server.dll 

Deltek.Vision.ReportingEmployee.Client.dll 

Deltek.Vision.ReportingEmployee.Server.dll 

\Web\Xml\Lookup_Employee.xml 

\Web\Xml\navigationMenu.xml 

\Web\Xml\TalentMapping.xml 

Database Changes 

Added the CFGIntegrationWS table and code to initialize.  

Tax File Generation: Belgium Client Listing XML File  
Two new fields have been added to the Tax File Specific Variables section of the General tab on 
the Tax File Generation form in Accounting » Tax File Generation. The two new fields are 
Gross >= and Gross<=. They display when you select Belgium Client Listing XML in the File 
Format field on the Tax File Generation form.

 

These fields determine which Belgian client’s will be included in the tax file, based on the total 
gross amount of all of a client's invoices for the time period and other criteria that you enter on 
this tab. 

 

• Gross >= — Enter the total gross invoice amount above which a client will be included in 
the tax file. To be included in the tax file, a client’s total gross invoice amount must be 
greater than or equal to the amount that you enter in this field.  

• Gross <= — Enter the total gross invoice amount below which a client will be included in 
the tax file. To be included in the tax file, a client’s total gross invoice amount must be 
less than or equal to the amount that you enter in this field.  

Enter a negative number with a negative sign in front of it, such as –250.00. 
 

Files Updated 

Deltek.Vision.TaxFileGeneration.Client.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 
 

Intra EU Community XML Backup Report 
The Diary Code and Diary Number columns were added to the Intra EU Community XML 
Backup report. The columns are available for companies that are configured to use diaries on the 
Diary Autonumbering tab on Configuration » Accounting » System Settings.
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The Diary Code column displays the Diary Code associated with the transaction. The Diary 
Number column displays the Diary Number associated with the transaction.

 

Files Updated 

Deltek.Vision.TaxFileGeneration.Client.dll
 

Deltek.Vision.ReportLabels.Server.dll
 

TaxXML.rdl
 

TaxXMLClient.rdl 

DeltekVision74GACU010.sql
 

Other Applications Affected 
 

Database Changes 
Added a Diary and DiaryNo column to the TaxReporting table. 

System File Dependencies 
 

Xml 

 Declaration XML Backup Report 
The Diary Code and Diary Number columns were added to the VAT Declaration XML Backup 
report. The columns are available for companies that are configured to use diaries on the Diary 
Autonumbering tab on Configuration » Accounting » System Settings.

 

The Diary Code column displays the Diary Code associated with the transaction. The Diary 
Number column displays the Diary Number associated with the transaction.

 

Files Updated 

Deltek.Vision.TaxFileGeneration.Client.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Additional Database Changes 
The following changes were made to the Vision database for internal purposes: 

A new IntegrationWS and IntegrationWSLogStatus table were added. 

The following columns were added to the FW_CFGSystem table: 

 SFTPHostName varchar(255) 
 SFTPUsername varchar(100) 
 SFTPPassword varchar(100) 
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Software Issues Resolved 

Accounting » Tax File Generation 
Defect 488876: When you created a tax file in Tax File Generation using any of the file formats, 
the tax file and the backup report correctly showed any negative tax amount for an invoice. 
However, invoices with negative tax amounts were missing in the grid on the Review tab of the 
Tax File Generation form.

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 
Deltek.Vision.TaxFileGeneration.Client.dll

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Configuration » Approvals 
Defect 536731: When an employee's Record Level View access rights were set to Is Me (Record 
Access tab of Configuration » Security), the Employee lookup on the Reassign dialog box in AP 
Invoice Approvals (Progress tab of Accounting » AP Invoice Approvals) incorrectly limited the 
Employee lookup results. 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 
Deltek.Vision.Approvals.Client.dll

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Navigator 
Defect 544545: When using the Copy Another Timesheet into this One option in the Employee 
Workspace, the drop-down list of available timesheet periods for Copy a Timesheet took a long 
time to load.  
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Customers Impacted: This defect applies to Vision 7.4 and iAccess clients.  

Workaround Before Fix: Wait for the list of timesheet periods to display or manually add the 
necessary projects.  

Additional Notes: None. 

Files Updated 
Deltek.vision.visionservices.server 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Proposals » Custom Proposals 
Defect 541913: When you merged custom proposals, extra hard returns were inconsistently 
added between paragraphs.

 

Customers Impacted: This defect affects Vision 7.3 and 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.MergeBO.Server.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Purchasing » Purchase Orders 
Defect 545687: If you added items to a purchase order that would automatically create items for 
the Equipment Info Center (equipment items or capital items), when you final printed the 
purchase order, it would hang and not complete. 
Customers Impacted: This defect applies for Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None.  

Files Updated 

Deltek.Vision.PORoutines.Server.dll 

Other Applications Affected 
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Database Changes 
 

System File Dependencies 
 

Reporting 
Defect 500526: The Tax Account column on the Tax File Generation’s Backup Report for VAT 
Declaration now displays the tax account entered in the Account fields in the Tax Codes tab of 
Configuration » Accounting » Taxes instead of the expense account at the time of posting. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.TaxFileGeneration.server.dll

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Reporting » Accounting 
Defect 526008: The Tax Account column on the Tax Analysis report now displays the tax 
account entered in the Account fields in the Tax Codes tab of Configuration » Accounting » 
Taxes instead of the expense account at the time of posting.

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 
Deltek.Vision.ReportingAccounting.Server.dll

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Reporting » Marketing Campaign 
Defect 539658: This issue applies if you do not have organization levels configured in 
Configuration » Organizations. When you added seven or more columns to the Marketing 
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Campaign List report, the report omitted the column that was in the seventh position on the 
report. 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 
Marketing Campaign List.rdl

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Reporting » Opportunity 
Defect 544755: When you ran the Opportunity List report, Opportunity Forecast report, or 
Opportunity Hit Rate List report, you received a framework exception error '‘Report item name 
must be unique..." if you selected all of the following before you ran the report: 

 You selected multiple columns to sort and group by on the Sorting/Grouping tab of the 
report options dialog box. 

 You added Opportunity fields to the report that were new in Vision 7.4 or GovWin 
Capture Management 7.4. You placed these fields after numeric/currency columns. 

The new Opportunity fields that were added to Vision 7.4 are: NAICS and Our Role. 

The new Opportunity fields that were added to GovWin Capture Management 7.4 are: Award 
Type, Competition Type, Contract Type, NAICS, Our Role, and Solicitation. 

Customers Impacted: This defect applies to Vision 7.4 and GovWin Capture Management 7.4.  

Workaround Before Fix: Perform one of the following: 

 Select only one column for sorting/grouping. 

 Move the numeric/currency fields downward on the Sorting/Grouping tab of the report 
options dialog box to ensure that they are placed after the other fields. 

Additional Notes: None. 

Files Updated 

Opportunity List.rdl 

Opportunity Forecast.rdl 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Reporting » Purchasing 
Defect 503920: The Purchase Order Detail report incorrectly included fully vouchered purchase 
orders even when the Include Unvouchered Items Only option was selected on the General tab 
of the options dialog box for the report. 

Customers Impacted: This defect applies to Vision 5.1 through Vision 7.4.
 

Workaround Before Fix: None. 
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.ReportingPurchasing.Server.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Text Editor 
Defect 541911: The text editor was not inserting spacing between paragraphs when you typeed 
text directly in a memo (text box) field in Vision and pressed the ENTER key. 

Customers Impacted: This defect applies to Vision 7.3 and 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Framework.ExternalReferences.Client.dll 

Deltek.Framework.ControlDialogs.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Time and Expense » Expense Report 
Defect 538263: When you changed the expense category in the Category field, the expense 
report did not calculate associated mileage correctly. 

 

Customers Impacted: This defect applies to Vision 7.4.
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Workaround Before Fix: After changing the category, open the Detail dialog box so the Miles 
field will update. Click OK without making any changes, and then save the expense report one 
more time. This will synchronize the Miles fields.

 

Additional Notes: None.
 

Files Updated 
Deltek.Vision.Expensekeeper.Client.dll

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Utilities » Advanced Utilities » Data Import 
Defect 541786: An error message displayed when you used the Data Import utility in Utilties » 
Advanced » Data Import to validate the import of Project - Contacts. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.ImportUtility.Server.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

Vision Performance Management 
Defect 536744: The KPIs in Vision Performance Management were not created properly because 
the Resource Kit did not honor the language for the selected data cube.

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 
DeltekVisionHelper.dll

 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 
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Cumulative Update 09 — Released August 14, 
2015 

Regulatory Enhancements 

2015 Ohio Income Tax Withholding 

The annual withholding table of Ohio is updated with changes effective August 1, 2015.  

For more information, see: 
http://www.tax.ohio.gov/Portals/0/employer_withholding/August2015Rates/WTH_PercentageMeth
od_FS_2015_073015.pdf. 

Files Updated 
Deltek.Vision.PayrollBO.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
 

2015 Idaho Income Tax Withholding 

Percentage-method withholding tables, effective retroactively to January 1, 2015, were released 
August 3 by the state tax commission. Employers are not required to retroactively adjust 
withholding for the months before the withholding tables were released. The annual withholding 
allowance increased from $3,950 to $4,000, while the supplemental withholding rate is 
unchanged.

 

For more information, see http://tax.idaho.gov/pubs/EPB00006_07-30-2015.pdf.
 

Files Updated 

Deltek.Vision.PayrollBO.Server.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
  

http://www.tax.ohio.gov/Portals/0/employer_withholding/August2015Rates/WTH_PercentageMethod_FS_2015_073015.pdf
http://www.tax.ohio.gov/Portals/0/employer_withholding/August2015Rates/WTH_PercentageMethod_FS_2015_073015.pdf
http://tax.idaho.gov/pubs/EPB00006_07-30-2015.pdf
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Software Issues Resolved 

Accounting »Project Review 
Defect 533240: The Project Review screen was slow to display. 

Customers Impacted: This defect applies to Vision version 7.0 and later.
 

Workaround Before Fix: On the Accounts Receivable tab on the Project Review screen, select 
Unpaid in the Status field to help reduce the amount of data. 

Additional Notes: None.
 

Files Updated 
Deltek.Vision.ProjectPTDReview.Client.dll

 

Deltek.Vision.ARReviewDialogs.Client.dll
 

Deltek.Vision.interactiveBilling.Client.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

API 
Defect 528375: If you used a VisionXtend API to update a user-defined field that has a data type 
of client, employee, or lead, you received an error if you did not enter a value for the field. Now 
you can leave the value blank, and you will not receive an error.

 

Customers Impacted: This applies to VisionXtend in Vision 7.2, 7.3, and 7.4.
 

Workaround Before Fix: None. 
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.WebServiceAPI.Server.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 532099: When you used a VisionXtend API to update custom date fields, you received an 
error if you left the date field blank, even if you were not required to enter a date in the custom 
field. The error you received was: “String was not recognized as a valid DateTime.”  

Customers Impacted: This defect applies to VisionXtend for Vision 7.3 and 7.4.
 

Workaround Before Fix: None.
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Additional Notes: None.
 

Files Updated 
Deltek.Vision.WebServiceAPI.Server.dll

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 532561: If you used a VisionXtend API to update an Info Center record, the update failed 
if the fields being updated triggered a Vision workflow to start. The workflow was set up in Vision 
Workflow Configuration. 

Customers Impacted: This defect applies to VisionXtend for Vision 7.1 through 7.4. 

Workaround Before Fix: Turn off the workflow in Vision Configuration » Workflow. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.WebServiceAPI.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Configuration » Purchasing and Inventory » Items Master 
Defect 530341: You received the following error when you opened the Vendor lookup in the 
Vendor field on the Vendors tab of the Items Mater form: "Ambiguous column name 'status'."  

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.POItem.Client.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Configuration » Workflow » Approval Workflows 
Defect 537113: Conditions added to approval workflows for change orders that used Total 
Amount were not evaluated and processed correctly. For example, if you had a condition for step 
1 where Total Amount for the change order is greater than $1,000 and a change order for $2,000 
was processed, the workflow incorrectly ignored step 1 (as if the condition was not met) and 
moved on to step 2. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.ApprovalsEngine.Server.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Info Center » Opportunities 
Defect 535558: The length of the Solicitation Number field on the IQ Info tab in the Opportunity 
Info Center was increased to support additional characters when importing data.

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 
DeltekVision74GACU009.sql 

Deltek.Vision.OpportunityInfoCenter.Client.dll 

Opportunities_Schema.xsd
 

Other Applications Affected 
 

Database Changes 

The following database changes were made: 

 Increase Opportunity.Solicitation field to varchar(255) 

 Truncate data value when the converted data exceeds the max field length for the other 
standard CRM fields added in 7.4 : 

 Our Role 

 Award Type (Formally named Contract Vehicle) 

 Contract Type 

 Competition Type (Formally named Procurement Type) 
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System File Dependencies 
 

Purchasing » Purchase Requisitions 
Defect 532830: In the Purchasing application, you received an error when you copied a purchase 
order, purchase requisition, or request for quote if it had a document attached to it. 
Customers Impacted: This defect applies to Vision 7.4.

 

Workaround Before Fix: Create a new purchase order, purchase requisition, or request for 
quote without copying from an existing record. 

 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.PriceQuoteRequest.Client.dll
 

Deltek.Vision.PurchaseOrder.Client.dll
 

Deltek.Vision.PurchaseRequest.Client.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Reporting » Accounts Receivable 
Defect 346928: The AR Statement by Project report was incorrectly sent to contacts that were 
not set up as Billing Contacts on the Accounting Tab of the Project Info Center. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: Print the AR Statement report by project and send manually to the 
appropriate contacts.

 

Additional Notes: None.
 

Files Updated 
Deltek.Vision.Report.Server.dll

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 



Cumulative Update 09 — Released August 14, 2015 

 

Release Notes: Technical Considerations 129 

 

Time and Expense » Timesheet 
Defect 534692: The SQL query for the Project Lookup in iAccess Timesheets did not use the 
proper index when the join to WBS2 level was missing. This resulted in a performance issue 
when searching for a project. 

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.VisionServices.Services.DLL 

DeltekVision74GACU009.sql 

Other Applications Affected 

 

Database Changes 

Indexes were added to the PR and CL tables in the database to improve the performance of the 
iAccess Project Search in Timesheets. 

System File Dependencies 
 

Transaction Center » Transaction Entry and Transaction Posting 
Defect 535935: There was a performance issue where Transaction Posting took exceptionally 
long to load. 

 

Customers Impacted: This defect applies to Vision 7.3 and later versions.
 

Workaround Before Fix: None.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.TransSelect.Client.dll
 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Cumulative Update 08 — Released July 17, 2015 

Regulatory Enhancements 

2015 Federal Electronic Filing 

Record Change 
The Location Address field (positions 274-295) of the RA Submitter Record is no longer a 
required field. 

Files Updated 

Deltek.Vision.W2Form.Server.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 

 

2015 State Electronic Filing 

Record Change 
The Location Address field (positions 274-295) of the RA Submitter Record is no longer a 
required field. 

The following are the states that use the standard EFW2 format: 

 Arkansas 

 Arizona 

 Colorado 

 Connecticut 

 District of Columbia 

 Delaware 

 Georgia 

 Idaho 

 Illinois 

 Indiana 

 Kansas 

 Kentucky 

 Louisiana 

 Maryland 
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 Maine 

 Massachusetts 

 Michigan 

 Minnesota 

 Missouri 

 Mississippi 

 Montana 

 North Carolina 

 North Dakota 

 Nebraska 

 New Jersey 

 New Mexico 

 Ohio 

 Oregon 

 Pennsylvania 

 Puerto Rico 

 Rhode Island 

 South Carolina 

 Utah 

 Virginia 

 Vermont 

 Wisconsin 

 West Virginia 

Files Updated 

Deltek.Vision.W2Form.Server.dll 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 
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2015 Louisiana SUTA Electronic Filing 
The Louisiana Workforce Commission is requiring the following information effective January 1, 
2016: 

 Nominal Hourly Rate of Pay 

 Job title or Standard Occupational Classification (SOC) code 

To accommodate this change, Vision updated the Quarterly Processing Editor screen to include 
the following fields for Louisiana: 

 Hourly Rate — Use this field to enter the hourly wage amount for the employee. 

 SOC Code/Job Title — Use this field to enter the employee's six-digit SOC code or job 
title description. The SOC code must not contain any dash or dot. 

Vision also updated the RS record to include the new fields for reporting beginning July 1, 2015 
and will become mandatory for the Q4 2015 filing. 

 July 1, 2015 (2015 2nd Quarter Filing) — Start of optional reporting of new fields. 

 January 1, 2016 (2015 4th Quarter Filing) — Mandatory reporting of new fields. 

The following table identifies the electronic file changes. 

Electronic File Changes 

Before As of May 29, 2015 

RS 360-366 

Field Name: HOURLY WAGES 

Length: 7 

  

OPTIONAL – ENTER ONLY NUMERIC 
CHARACTERS. ENTER THE AMOUNT OF 
WAGES (DOLLARS & CENTS) WHICH ARE 
THE HOURLY WAGE AMOUNT. RIGHT 
JUSTIFY AND ZERO FILL. 

RS 360-366 

Field Name: HOURLY RATE 

Length: 7 

  

OPTIONAL – (BECOMES 
MANDATORY JANUARY 1, 2016) ENTER 
ONLY NUMERIC CHARACTERS. ENTER 
THE AMOUNT OF WAGES (DOLLARS & 
CENTS) WHICH ARE THE HOURLY WAGE 
AMOUNT. ZERO FILL. FORMAT: 3 DIGITS 
DOLLARS AND 4 DIGITS CENTS AND 
FRACTIONS OF CENTS. I.E. $21.56 
SHOULD BE “0215600” IF HOURLY RATE IS 
OVER $999.9999 THEN ENTER ALL NINES. 
I.E. “9999999” 

RS 367-372 
Field Name: OES CODE 

Length: 6 

  

OPTIONAL – SEE: OCCUPATIONAL CODES 
DICTIONARY (OES/SOC) ON 
WWW.LAWORKS.NET 

RS 367-446 
Field Name: SOC CODE/JOB TITLE 

Length: 80 

  

OPTIONAL – (BECOMES MANDATORY 
JANUARY 1, 2016) ENTER EITHER 6 
DIGITS STANDARD OCCUPATIONAL 
CLASSIFICATION (SOC) OR ENTER JOB 
TITLE DESCRIPTION. NO DASH OR DOT 
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Before As of May 29, 2015 

ALLOWED IN SOC. 

RS 373-487 
Field Name: FILLER 

Length: 115 

FILL WITH BLANKS. 

RS 447-487 
Field Name: FILLER 

Length: 41 

FILL WITH BLANKS. 

RA 003-011 
Field Name: SECURED FILE 
TRANSFER PROTOCOL 

Length: 9 

  

REQUIRED – SUBMITTER’S FEIN NUMBER 

RA 003-216 
Field Name: FILLER 

Length: 214 

  

FILL WITH BLANKS. 

For more information, see http://www.laworks.net/Downloads/UI/WageUploadInstructions.pdf. 

Files Updated 

Deltek.Vision.pyFormQuarterly.Client.dll 

Deltek.Vision.QTRMagMedia.Server.dll 

Deltek.Vision.ReportLabels.Server.dll 

pyrptFormQuarterlyFL.rdl 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

 

2015 North Dakota Income Tax and Supplemental Tax Withholding 
These are the updates for North Dakota: 

 The withholding tables are updated. 

 The supplemental tax rate decreases from 2.28% to 2.05%. 

 The amount of one withholding allowance increases from $3,950 to $4,000. 

Files Updated 

Deltek.Vision.PayrollBO.Server.dll 

Other Applications Affected 

 

Database Changes 

http://www.laworks.net/Downloads/UI/WageUploadInstructions.pdf
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System File Dependencies 
 

Software Issues Resolved 

Accounting » Credit Card » Credit Card Reconciliation 
Defect 521718: This issue applies if you use Deltek First Vision Essentials (Vision cloud-based 
product). You received an “Invalid column name ‘SecondaryAccountNumber.’” error message 
when you imported charges from the Credit Card Statement Reconciliation form.  

Customers Impacted: This defect applies to Deltek First Vision Essentials 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.CreditCardReconciliation.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
 

Billing » Invoice Template Editor 
Defect 484578: The Section Order that was defined on the Sections tab of Billing » Invoice 
Template Editor did not display correctly on the actual invoice. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Select the Enable Pre-Invoices option on the Miscellaneous tab of 
Configuration » Billing » General.  

Additional Notes: None. 

Files Updated 
Deltek.Vision.ReportingInvoice.Server.dll 

Deltek.Vision.Report.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Connect for Microsoft Outlook 
Defect 526072: This applies if you use Connect for Microsoft Outlook. You received an internal 
error and Connect for Microsoft Outlook would not synchronize if you configured Connect for 
Microsoft to use Contact email or Vendor email as a duplicate record check in Configuration » 
General » Connect for Microsoft Outlook. (You inserted [Contacts.Email] in the Contacts grid 
or [Vendor.Email] in the Vendors grid on the Connect for Microsoft Outlook Configuration form.) 

Customers Impacted: This defect applies for Connect for Microsoft and Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

DeltekVision74GACU008.sql 

Other Applications Affected 

 

Database Changes 

Updated an incorrect value in the FW_CFGInfoCenterFieldsData table that was causing the 
Connect for Microsoft Outlook error.  

System File Dependencies 

 

Configuration » General » Alerts 
Defect 486123: When a Timesheet Approval was configured to alert a supervisor for a project, 
for example, but the project in the respective timesheet did not have an assigned supervisor, an 
error occurred when the timesheet was submitted: “The Timesheet Approval Process failed with 
message: Object Reference not set to an instance of an Object”. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Click OK and the timesheet will submit without further issue.  

Additional Notes: None. 

Files Updated 
Deltek.Vision.Alerts.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Human Resources » Payroll 
Defect 496985: When the Print pay rates for hourly Employees option was enabled on the 
Checks tab in Configuration » Payroll, the YTD Hours and YTD Amounts were not correct on 
payroll remittance stubs that were emailed to employees.  
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Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

EarningsHourly_Three.rdl 

EarningsHourly_Two.rdl 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Proposals » Custom Proposals 
Defect 502735: The following issue applies for a resume section of a custom proposal. On the 
Resume tab in Custom Proposals, when you selected an employee in the grid, clicked Build 
Resume » Resume By Query w/Project Restriction, and selected projects in the Project 
Lookup dialog box for the employee, this same set of projects displayed in the Project Lookup 
dialog box for the next employee for whom you selected projects. The Project Lookup dialog box 
returned the incorrect set of project records for subsequent employees added to the resume 
section. 

Customers Impacted: This defect applies to Vision 7.0 SP1 and later releases. 

Workaround Before Fix: On the Project Lookup dialog box, click Search again, and it will 
refresh the lookup list.  

Additional Notes: None. 

Files Updated 

Deltek.Framework.Lookup.Client.dll 

Deltek.Vision.Lookup.Client.dll 

Deltek.Vision.CustomProposal.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Reporting 
Defect 520878: Due to an issue with rounding, the Project Planning Analysis, Office Earnings, 
and Rev Gen reports did not pick up correct ETC amount.  
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Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

DeltekVision74GACU008.sql 

Deltek.Vision.RevenueGeneration.Server.dll 

Deltek.Vision.ReportingResourcePlanning.Server.dll 

Other Applications Affected 
 

Database Changes 
Updated the following database objects: 

 PM$tabTaskETC function 

 RP$rptTaskETC function 

 rpCalcTPD stored procedure 

 rpRptSummary stored procedure 

 rpRptAnalysis stored procedure 
 

System File Dependencies 

 

 
Defect 530484: This applies if Deltek has provided you with custom programing and the 
installation package to install the custom programming. During the installation of custom 
programming, you received an error when custom reports were loaded. 

Customers Impacted: This defect applies to Vision 7.3 and 7.4 and applies only if you use a 
custom installation package to install custom programming in Vision. 

Workaround Before Fix: Reload the custom reports in Vision Utilities » Reports 
Administration. 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Report.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Text Editor 
Defect 522049: When text was centered in the Text Editor Description field in Billing Terms, the 
text did not display as centered on the invoice. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

FrameworkReportSystemCode.xml 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

Defect 522777: Double spaces were changed to single spaces when you closed the Text Editor 
or when you saved the contents of a memo field.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Framework.ControlDialogs.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Utilities » Advanced Utilities » Data Import 
Defect 522113: When importing a file that included the State field, an error displayed if the file 
contained the State Description instead of the State Code. This impaced Clients, Vendors, 
Employees, Opportunities, Projects, Leads, PO Master Information, and Billing Terms Projects 
files. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Use the State Code instead of the State Description. 

Additional Notes: None. 

Files Updated 
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Deltek.Vision.ImportUtility.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Cumulative Update 07 — Released June 26, 2015 

Software Enhancements 

Project Management Workspace in iAccess 
The Project Management Workspace in iAccess now requires an active Project Control or 
Accounting license in Vision. When one or both of these modules are in use, you can select the 
Project Management Workspace option on the iAccess tab of Configuration» Security » 
Roles to enable this workspace. 

 

Files Updated 
Deltek.vision.visionservices.server.dll 

Deltek.vision.secroles.client.dll 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

 

Software Issues Resolved 

Time and Expense » Timesheet 
Defect 525539: When timesheet special categories were not in use, opening a new timesheet 
and then attempting to open a previously saved timesheet resulted in the following error: "Object 
reference not set to an instance of an object." 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Open the saved timesheet prior to opening a new timesheet.  

Additional Notes: None. 

Files Updated 
Deltek.Vision.Timekeeper.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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IAccess 
Defect 527284: When there were user-defined drop-down fields or lookups with the same name 
in multiple grids, opening the Business Development Workspace in iAccess resulted in an error.  

Customers Impacted: This defect applies to iAccess users with Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: To use the Business Development Workspace in the current version of 
iAccess, you must remove any grids that contain user-defined drop-down fields or lookups with 
the same name. This issue will be resolved in an upcoming release. 

Files Updated 
Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Cumulative Update 06 — Released June 12, 2015 

Software Enhancements 

Calendar\Activities  

Activity Manager » Activities Grid 
The following new columns were added to the Activities grid on the Activity Manager. 

 Vendor — This column displays the vendor that is associated with the activity. Click the 
name to open the record in the current browser window or right-click the name and then 
click the Open in new window option to open the record in a separate browser window. 

 Vendor Contact — This column displays the primary contact from the vendor that is 
associated with the activity. Click the name to open the record in the current browser 
window or right-click the name and then click the Open in new window option to open 
the record in a separate browser window. 

 Vendor Contact Bus. Phone — This column displays the vendor contact's business 
phone number that is entered in the Contact Info Center. The Contact field was updated 
to Client Contact field and the Contact Bus. Phone field was updated to Client 
Contact Bus. Phone. 

Files Updated 

Deltek.Vision.InfoCenters.Client.dll 

Deltek.Vision.VendorInfoCenter.Client.dll 

globalTabSetup.xml 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Activity Manager » Activities Dialog Box 
The Activities dialog box on the Calendar/Activities » Activity Manager application was 
renamed to Activity dialog box. On the Detail tab of the Activity dialog box, the following fields 
were added: 

 Vendor — Use this field to enter a vendor that is associated with the activity. A lookup is 
available on this field that can be used to search for a vendor. 

 Vendor Contact — Use this field to enter the contact person from the vendor. A lookup 
is available on this field that can be used to search for the vendor contact. 

 Bus. # (Vendor) — This field displays the vendor contact's business phone number. 

The Primary Contact field was also changed to the Client Contact field and the fields were 
organized more intuitively by grouping related fields. The new fields that were added and 
modified on the Activity dialog box are also available on the Activities grid on the Activity Manager 
form. With the new fields and field updates, the lookup function was also updated accordingly. 
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The client related search fields were appended with "client" to differentiate the client and vendor 
related search fields. New search fields were also added to the following lookup fields: 

 All advanced lookup fields 

 Vendor City 

 Vendor Name 

 Vendor Number 

 Vendor State/Province 

 Vendor Market 

 Vendor Zip/Post Code 

 Vendor Contact Bus. City 

 Vendor Contact Bus. State 

 Vendor Contact Bus. Zip/Post Code 

 Vendor Contact First Name 

 Vendor Contact Last Name 

 Vendor Contact Middle Name 

 Vendor Contact Preferred Name 

 Vendor Contact Source 

 Vendor Contact Status 

 Vendor Contact Title 

 Vendor advanced lookup field : 

 Activity Completion Ind. 

 Activity Notes 

 Activity Owner Number 

 Activity Start Date 

 Activity Subject 

 Activity Type 

The View by Association grid of the Activities Filter dialog box on the Calendar/Activities » 
Activity Manager application was also updated to include Vendor and Vendor Contact under the 
Type of Association column. In addition, the Contact association type was changed to Client 
Contact. 

Files Updated 

Deltek.Vision.InfoCenters.Client.dll 

Deltek.Vision.Lookup.Server.dll 

Lookup_Activity.xml 

Lookup_Vendor.xml 

Other Applications Affected 
 

Database Changes 
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The following updates were made: 

 The Vendor and ContactIDForVendor columns were added to Activity and the Audit Trail 
triggers were updated for the Activity table. 

 The Vendor and ContactIDForVendor to WorkflowActivity columns were added. 
 

System File Dependencies 
 

Deltek Toolbar in Microsoft Word 
The following changes have been made to the Deltek add-in toolbar in Microsoft Word that you 
use to create merge templates for producing Vision custom proposals and merged documents. 
You access the Deltek toolbar by clicking the Add-Ins tab on the Word toolbar (if you have 
downloaded the Deltek merge macro (DeltekWordMacro.dot) to your workstation from Vision 
Utilities » Download Merge Macro). 

New Fields and Renamed Fields 
The following fields (merge codes) were added or renamed. To access the these fields, click the 
Insert Fields icon on the Deltek toolbar, select an Info Center or Activity Manager in the Select 
Info Center dialog box, and select the new/renamed field on the Select <Info Center/Activity 
Manager> Merge Codes dialog box. 

Activity Manager 
 

 Vendor and Vendor Contact were added. 

 Contact was renamed to Client Contact. 

Opportunity Info Center 
The following new fields were added: 

 Duration —- This field applies only for GovWin Capture Management and not Vision 
(even though it displays in Vision). 

 Master Contract 

Client Info Center 

The following new fields were added: 
 

 HUB Zone 

 8a 

 Annual Revenue 

 Employee Count 

 Competitor 

 Government Agency 

Vendor Info Center 

The following new fields were added: 
 

 HUB Zone 

 8a 
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 Market 

 Annual Revenue 

 Employee Count 

New Vendor Group Codes 
The following group codes were added for vendors. To access these new fields, click the Insert 
Fields icon on the Deltek toolbar, select Vendors in the Select Info Center dialog box, and in the 
Select Vendors Merge Codes dialog box, open the Group Codes drop-down list. 

New vendor group codes: 

 Activity Attendees Codes 

 Activities Codes 

 Activity Leads Codes 

 Activity Contacts Codes 

New Activity Fields for the Activities Code Group Codes for Info Centers 

The following activity fields were added to the Activities Code group code for Info Centers that 
have activities. To access these new fields, click the Insert Field button on the Deltek toolbar, 
select any Info Center in the Select Info Center dialog box that has activities, and select 
Activities Codes from the Group Codes drop-down list in the Select Merge Codes dialog box. 
The new fields display in the pane below the Group Codes field: 

 Activity Vendor: Name 

 Activity Vendor Contact: First Name 

 Activity Vendor Contact: Last Name 

 Activity Vendor Contact: Middle Name 

 Activity Vendor Contact: Suffix 

Files Updated 

DeltekVisionMacro.dot 

MergeCodes.xml 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Client, Lead, Marketing Campaign, Opportunity, Contact, and Project Info 
Centers 
The following new fields were added to the Activities tab for the Client, Lead, Marketing 
Campaign, Opportunity, Contact, and Project Info Centers: 

 Vendor — This column displays the vendor that is associated with the activity. Click the 
name to open the record in the current browser window or right-click the name and then 
click the Open in new window option to open the record in a separate browser window. 
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 Vendor Contact— This column displays the primary contact from the vendor that is 
associated with the activity. Click the name to open the record in the current browser 
window or right-click the name and then click the Open in new window option to open 
the record in a separate browser window. 

 Vendor Contact Bus. Phone — This column displays the vendor contact's business 
phone number that is entered in the Contact Info Center. The Contact field was updated 
to Client Contact field and the Contact Bus. Phone field was updated to Client 
Contact Bus. Phone. 

Files Updated 

Deltek.Vision.Lookup.Server.dll 

Deltek.Vision.CodeTableMaint.Client.dll 

Deltek.Vision.VendorInfoCenter.Client.dll 

Lookup_Vendor.xml 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

Client Info Center 

General Tab 
The following fields were added to the General tab of the Client Info Center: 

 Competitor — Select this option to indicate that this client acts as a competitor to your 
own firm. 

 Government Agency — Select this option to indicate that this client is a government 
agency. 

 Annual Revenue — This field displays the annual revenue of the client.  

 Employee Count — This field displays the number of employees the client has. 

Additional Info Tab 
The following fields were added to the Additional Info Tab of the Client Info Center: 

 HUB Zone — Select this option to indicate that the client qualifies for a Historically 
Underutilized Business (HUB) Zone. 

 8 (a) — Select this option to indicate that the client qualifies for the small business status 
of 8 (a). 

The lookups were also updated to make the new fields available as search criteria for applicable 
lookup fields. 

Files Updated 

Deltek.Vision.Lookup.Server.dll 

Deltek.Vision.ClientInfoCenter.Client.dll 
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Lookup_Client.xml 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Opportunity Info Center 

General Tab 
The Master Contract field was added to the General tab of the Opportunity Info Center. Use the 
Master Contract field to select the master contract if the opportunity is work that your firm is 
competing for under an indefinite delivery/indefinite quantity contract (IDIQ) or similar "master" 
contract. 
 

Files Updated 
Deltek.Vision.Lookup.Server.dll 

Deltek.Vision.OpportunityInfoCenter.Client.dll 

Lookup_Opportunity.xml 

Other Applications Affected 
 

Database Changes 

The following updates were made: 

 The size of the CFGMasterContract.Description column was increased to 255. 

 Thes CFGProjectTemplateData and CFGProjectTemplateDescriptions and the 
CFGProjectTemplateDescriptions view tables were added. 

 

System File Dependencies 

Vendor Info Center 

Activities Tab 
The new Activities tab was added to the Vendor Info Center. Use the Activities tab to schedule 
activities directly from vendor records that you are viewing.  

General Tab 

The following fields were added to the General tab of the Vendor Info Center: 

 Annual Revenue — This field displays the annual revenue of the vendor.  

 Employee Count — This field displays the number of employees the vendor has. 

 Market — Select a market (type) for the vendor (for example, Commercial, Government, 
or Non-Profit).  
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Additional Info Tab 
The following fields were added to the Additional Info Tab of the Vendor Info Center: 

 HUB Zone — Select this option to indicate that the client qualifies for a Historically 
Underutilized Business (HUB) Zone. 

 8 (a) — Select this option to indicate that the client qualifies for the small business status 
of 8 (a). 

The lookups were also updated to make the new fields available as search criteria for applicable 
lookup fields. 

Files Updated 

Deltek.Vision.Lookup.Server.dll 

Deltek.Vision.CodeTableMaint.Client.dll 

Deltek.Vision.VendorInfoCenter.Client.dll 

Lookup_Vendor.xml
 

Other Applications Affected 
 

Database Changes 
The Market column was added to the VE table. 
 

System File Dependencies 

Reporting  

Calendar/Activity » Activity Manager Updates 
Because vendor information is now included in the Activity Manager and on the Activities grids 
within the Info Centers, there were several new fields added to the Activity and Info Center 
reports. In addition, field labels within the reports were updated to differentiate between client and 
vendor information. Refer to the following sections for Activity and Info Center report updates.  

Activity List Report 

Updated Fields: 

 Client Name  

 Client 

 Contact  

 Client Contact 

 Phone  

 Client Contact Bus. Phone 

 Contact Title  

 Client Contact Title 

 Contact Email  

 Client Contact Email 
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 Lead  

 Primary Lead 

New Fields: 

 Primary Lead Bus. Phone 

 Vendor 

 Vendor Contact 

 Vendor Contact Bus. Phone 

Activity Summary Report 

Updated Fields: 

 Old Field Name 

 New Field Name 

 Contact Name  

 Client Contact Name 

 Contact Title  

 Client Contact Title  

 Contact Phone  

 Client Contact Phone 

 Contact Fax  

 Client Contact Fax 

 Contact Mobile  

 Client Contact Mobile  

 Contact Home Page  

 Client Contact Home Page 

 Contact Pager  

 Client Contact Pager 

 Contact Email  

 Client Contact Email 

New Fields: 

 Vendor  

 Vendor Contact  

 Vendor Contact Bus. Phone  

Info Center Reports with Activity Manager Updates 
The following info center reports were updated with Activity Manager information: Client List, 
Client Summary, Contact List, Contact Summary, Employee List, CRM Employee Summary, 
Lead List, Lead Summary, Marketing Campaign List, Marketing Campaign Summary, Opportunity 
Forecast, Opportunity Hit Rate List, Opportunity List, Opportunity Summary, CRM Project 
Summary, Project List, and User-Defined Info Center. 
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Updated Fields: 

 Activities - Contact 

 Activities - Client Contact 

 Activities - Contact Bus. Phone 

 Activities - Client Contact Bus. Phone 
 Activities – Date (Client Summary, Contact Summary, CRM Employee Summary, CRM 

Project Summary, and Project List reports only) 

 Activities - Start Date (Client Summary, Contact Summary, CRM Employee Summary, 
CRM Project Summary, and Project List reports only) 

 Old Field Name (Client List report only) 

 New Field Name (Client List report only) 
 

New Fields: 

 Activities - Vendor  

 Activities - Vendor Contact 

 Activities - Vendor Contact Bus. Phone 

Files Updated 

Activity List.rdl 

Client List.rdl 

Contact List.rdl 

Employee List.rdl 

Lead List.rdl 

Marketing Campaign List.rdl 

Opportunity Forecast.rdl 

Opportunity List.rdl 

Project List.rdl 

UDIC List.rdl 

Deltek.Vision.Report.Server.dll 

Deltek.Vision.ReportLabels.Server.dll 

Deltek.Vision.ReportingUDIC.Client.dll 

ReportGroup_Client.xml 

ReportGroup_Contact.xml  

ReportGroup_Employee.xml 

ReportGroup_Leads.xml 

ReportGroup_MarketingCampaign.xml  

ReportGroup_Opportunity.xml 

ReportGroup_Project.xml 

ReportGroup_UDIC.xml 
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Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Opportunity, Client, and Vendor Reports 
The following fields have been added to opportunity, clients and vendor reports as follows: 

 HUB Zone — This column contains Y or N (Yes or No) to indicate whether or not the 
vendor or client is part of the HUB Zone program for small businesses. 

 8 (a) — This column contains Y or N (Yes or No) to indicate whether or not the vendor or 
client is part of the 8 (a) business development program for small and disadvantaged 
businesses. 

 Annual Revenue — This column displays the annual revenue of the vendor or client. 

 Employee Count — This column displays the number of employees of the vendor or 
client. 

 Market — This column displays the general market in which the vendor or client 
participates.  

 Competitor — This column contains Y or N (Yes or No) to indicate whether or not the 
client is a competitor. 

 Government Agency — This column contains Y or N (Yes or No) to indicate whether or 
not the client is a government agency. 

These fields, except the Market, Competitor and Government Agency fields, were added on 
the Grouping/Sorting tab of following Opportunity reports: 

 Vendor List 

 CRM Vendor Summary 

 Vendor Audit 

 Vendor Audit Detail 

 Vendor Mailing Label 

 Cash Requirements 

 Vendor Summary 

 Voucher Ledger 

 Voucher Schedule 

These fields, except the Competitor and Government Agency fields, were added on the 
Columns tab of following Opportunity reports: 

 Vendor List 

 CRM Vendor Summary 

Client Reports 

Only the Annual Revenue and Employee Count fields were added on the Grouping/Sorting tab 
of following Client reports: 

 Client List 
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 Client Summary 

 Client Audit 

 Client Audit Detail 

 Client Mailing Label 

 Client Employee Assignment and Activity  

These fields, except the Market field, are added on the Columns tab of following Client reports: 

 Client List 

 Client Summary 

Files Updated 

ReportGroup_Vendor.xml 

ReportGroup_AccountsPayable.xml 

Deltek.Vision.ReportingVendor.Server.dll 

Deltek.Vision.ReportLabels.Server.dll 

Vendor List.RDL 

Deltek.Vision.Report.Server.dll 

Deltek.Vision.Lookup.Server.dll 

Deltek.Vision.ReportingClient.Server.dll 

Client List.rdl 

ReportGroup_Client.xml  

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Opportunity Reports 
The Master Contract and Duration fields are now available on the Grouping/Sorting and 
Columns tabs of following Opportunity reports: 

 Opportunity List 

 Opportunity Summary 

 Opportunity Audit 

 Opportunity Audit Detail 

 Opportunity Hit Rate 

 Opportunity Forecast 

 Opportunity Service Estimate  

 Opportunity Fee Estimate  

Files Updated 
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ReportGroup_Opportunity.xml 

Deltek.Vision.ReportingOpportunity.Server.dll 

Deltek.Vision.ReportLabels.Server.dll 

Opportunity List.rdl 

Opportunity Forecast.rdl 

Deltek.Vision.Report.Server.dll 

Other Applications Affected 

 

Database Changes 
 

System File Dependencies 

Utilities 

Advanced » Search and Replace 

In Utilities » Advanced Utilities » Search and Replace, the following fields have been added to 
the drop-down list in the Columns to Update field: 

Opportunities Info Center: 

 Opportunity.Duration— This field applies only for GovWin Capture Management and 
not Vision (even though it displays in Vision). 

 Opportunity.MasterContract  

Clients Info Center: 

 CL.AnnualRevenue 

 CL.Competitor 

 CL.EightA 

 CL.Employees (for Employee Count) 

 CL.Hubzone 

 CL.GovernmentAgency 

Vendors Info Center: 

 VE.AnnualRevenue  

 VE.EightA 

 VE.Employees (Employee Count) 

 VE.Hubzone 

 VE.Market 

Files Updated 
 

Other Applications Affected 
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Database Changes 
 

System File Dependencies 
 

Advanced » Key Formats and Key Conversions 
When you use the Key Formats and Key Conversions utilities for vendor or contact records, all 
activities that are associated with the vendor or contact remain associated with the record through 
the format change or conversion.  

Files Updated 
sp_insertKeyConvertDriver.sql  
 

Other Applications Affected 
 

Database Changes 

The insertKeyConvertDriver procedure was updated. 
 

System File Dependencies 
 

VisionXtend 
The following new fields in Vision have been added to the schema in VisionXtend: 

Opportunity Info Center:  

 Duration —- This applies for GovWin Capture Management only. 

 MasterContract 

Client Info Center:  

 Hubzone  

 EightA (for 8(a)) 

 AnnualRevenue 
 Employees (for Employee Count) 

 Competitor 

 GovernmentAgency 

Vendor Info Center:  

 Hubzone  

 EightA (for 8 (a)) 

 Market 

 AnnualRevenue 

 Employees (for Employee Count) 

Project Info Center: This applies only for Ajera CRM, not Vision or GovWin CM. 
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ProjectTemplate (for Ajera Project Template) 

Files Updated 
ValidationInfo.xml 

Clients_Schema.xsd 

Opportunities_Schema.xsd 

Vendors_Schema.xsd 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

iAccess for Vision (Navigator) 
The “Navigator” product name was changed to “iAccess for Vision.” To support this change, all 
labels and buttons within the Vision application that referenced “Navigator” were changed to 
“iAccess.” 

Files Updated 

deltek.framework.images.client.dll 

deltek.vision.DlgCreateProjectFromPlan.client.dll 

deltek.vision.FrameUI.client.dll 

deltek.vision.GeneralSystemSetup.client.dll 

deltek.vision.keyCvt.client.dll 

deltek.Vision.reportLabels.server.dll 

deltek.vision.ResourceManagement.client.dll 

deltek.vision.ResourcePlanning.client.dll 

deltek.vision.RPCFGUtil.client.dll 

deltek.vision..rpSreadVar.client.dll 

deltek.vision.secRoles.client.dll 

deltek.vision.setupCustomTabs.client.dll 

deltek.vision..ReportingConfiguration.client.dll 

deltek.vision.VisionServices.server.dll 

Other Applications Affected 
 

Database Changes 

 

System File Dependencies 
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Security 
iAccess for Vision includes a new Business Development Workspace. Access rights for this 
workspace are set up in Configuration » Security » Roles as follows:  

 iAccess tab — Select the Business Development Workspace checkbox to allow the role 
to access the Business Development Workspace in the iAccess for Vision application. 
This option is automatically selected when CRM is the defined Type of Role on the 
General tab of Role Security. When Business Development Workspace is selected, the 
option is also included on the Role Summary Report.  

 Record Access tab — Select the Allow access to records in iAccess checkbox to allow 
the role to access records in the iAccess application. This option is available if you own 
the Vision CRM module. 

In addition, the Role Summary report now includes the new Business Development Workspace 
option when it is in use. 

Files Updated 
deltek.vision.secroles.client.dll 

Role Summary.rdl 

RoleNavigatorSection.rdl 

Deltek.Vision.ReportLabels.Server.dll 

Deltek.Vision.ReportingConfiguration.Client.dll 
 

Other Applications Affected 
 

Database Changes 

The NavCRMWorkspace column was added to the SE Table. 

System File Dependencies 

 

User Defined Components 
Vision Configuration » User Defined Components now supports the Business Development 
Workspace in iAccess. When you select the Clients, Opportunities, Vendors, or Contacts 
options from the Applications drop-down, the Tabs tab displays a new iAccess Business 
Development Space grid, and the Custom Fields and Custom Grids tabs display new fields that 
allow you to customize the tabs and fields that will display within the Business Development 
Workspace. 

Files Updated 

Deltek.Framework.SetupCustomTabs.Client.dll 

Deltek.Vision.SetupCustomTabs.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Software Issues Resolved 

Configuration 

Approvals » Approvals Configuration 
Defect 495833: This issue applies if you use approval workflows for approving records in the 
Purchasing or Inventory applications. You received an “Assignment for approval step x could not 
be created” error message via a workflow error email when you assigned an approval step to a 
buyer’s supervisor or requestor’s supervisor in either of the follow situations:  

 For approval workflows for purchase orders: In Configuration » Approvals » Approvals 
Configuration, you entered Buyer's Supervisor in the Assigned To field in the 
Approval Steps grid on the Workflow tab. 

 For approval workflows for purchase requisitions, request for price quotes, and inventory 
item requests: In Configuration » Approvals » Approvals Configuration, you entered 
Requestor’s Supervisor in the Assigned To field in the Approval Steps grid on the 
Workflow tab. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 
 

Deltek.Framework.ApprovalItems.Common.dll 

Deltek.Framework.Workflow.Server.dll 

Deltek.Vision.Approvals.Common.dll 

Deltek.Vision.Approvals.Server.dll 

Deltek.Vision.ApprovalsConfig.Common.dll 

Deltek.Vision.ApprovalsEngine.Server.dll 

Deltek.Vision.ApprovalWriteHistory.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 518906: When you tried to save an approval workflow in Configuration » Approvals » 
Approvals Configuration, you received the following error: "Invalid object name 
'ApprovalAssignmentHierarcy'." 

Customers Impacted: This defect applies to Vision 7.4.  

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 
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Deltek.Framework.Workflow.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 520111: When you tried to submit a request for price quote in Purchasing » Request for 
Price Quote or an item request in Inventory » Item Requests, you received the following error: 
"The multi-part identifier 'POPRMASTER.REQUESTEDBY' could not be bound." This occurred 
only if the approval workflow for requests for price quote or item requests (set up in 
Configuration » Approvals » Approvals Configuration) had an approval step that was 
assigned to the requester’s supervisor (Requester’s Supervisor is selected in the Assigned To 
field in the Approvals Steps grid on the Workflow tab on the Approvals Configuration form). 

Customers Impacted: This defect applies to Vision 7.4.  

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 

Deltek.Vision.Workflow.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

General » User Defined Tabs 
Defect 499392: This issue applies if you use Vision and iAccess (formerly Navigator) or Touch 
CRM. After you created a user-defined tab in Vision (Configuration » General » User Defined 
Components) that was currently in use in iAccess or Touch CRM, you were allowed to delete the 
user-defined tab. You should not have been able to delete it. 

Customers Impacted: This defect applies for Vision 7.4 if you use iAccess (formerly Navigator) 
or Touch CRM for Vision. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.SetupCustomtabs.Client.dll 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 
 

Defect 502143: In Configuration » General » User Defined Components, when you added 
user defined tabs that can be accessed in iAccess (formerly Navigator) or Touch CRM, you 
received an error. 

Customers Impacted: This defect applies to Vision 7.4 if you use iAccess or Touch CRM for 
Vision. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.SetupCustomTabs.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Dashboard 
Defect 520147: This applies if you use Vision Performance Management, Tableau Server 8.2, 
and Vision 7.4. When Tableau Server is configured using local authentication and SSL, you 
received a “cannot generate trusted ticket” error when you viewed Vision Performance 
Management dashparts. This was due to the recent change made in Tableau Server 8.2. When 
you used SSL in Tableau Server versions earlier than 8.2, the request to Tableau Server to 
generate the trusted ticket that was made over an HTTP connection was redirected to HTTPS. In 
Tableau Server 8.2, the redirect no longer occurs, which caused the error. Previously Vision sent 
everything as HTTP regardless of HTTP/HTTPS configuration. Now Vision sends HTTP for HTTP 
and HTTPS for HTTPS. 

Customers Impacted: This defect applies if you use Vision Performance Management, Tableau 
Server 8.2, and Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Dashboard.Server.dll 

Deltek.Framework.PerformanceDashboard.Server.dll 

Deltek.Framework.PerformanceDashboard.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Defect 520458: When a field from a User-Defined Info Center was hidden or locked in the Screen 
Designer, the Vision Dashboard would not load. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Dashboard.Client.dll 

Deltek.Vision.UDIC.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

iAccess (Navigator) 
Defect 484324: When a Resource Planning condition generated an email or dashboard alert that 
included an iAccess hyperlink, clicking the hyperlink resulted in an error. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 

Deltek.Vision.Alerts.Server.DLL 

Deltek.Vision.Globals.Server.DLL 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 486553: When a picture was uploaded and saved in the Project Info Center and 
Opportunity Info Center, the Modification Date was not updated. This resulted in an old image 
displaying in iAccess. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.EmployeeInfoCenter.Server.dll 

Deltek.Vision.OpportunityInfoCenter.Server.dll 
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Deltek.Vision.ProjectInfoCenter.Server.dll 

Other Applications Affected 
 

Database Changes 
The VendorPhoto table was added. 

System File Dependencies 

Installation 
Defect 518973: After upgrading Vision, you received the error: "Parameter 'PreInvoice' does not 
exist on this report." when you previewed Billing invoices. 

Customers Impacted: This applies to Vision 7.4 and Deltek First Vision Essentials 7.4. 

Workaround Before Fix: Reload the reports to your Vision report server using Vision Utilities » 
Report Administration.  

Additional Notes: None. 

Files Updated 

DeltekVisionCMD.exe 

Deltek.Framework.Report.Server.dll 

Deltek.Vision.Report.Server.dll 

Other Applications Affected 
 

Changes 
 

System File Dependencies 
 

Planning 
Defect 503957: When a plan did not have any expense resource rows, the Actual Direct 
Expense fields displayed a zero amount on the Cost Analysis and Billing Analysis tabs. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None.  

Additional Notes: None.  

Files Updated 

Deltek.Vision.ResourcePlanning.Client.dll 

DeltekVision74GACU006.sql 

Other Applications Affected 
 

Database Changes 

The following procedure was updated: 
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pmGetRPPlan  

System File Dependencies 

Reporting 
Defect 502209: When the Only List Activities that Match Selections option was selected on 
the General tab of the Employee List Options dialog box in Reporting » Employee » 
Employee List, the Employee List report was blank when it was generated. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Do not select the Only List Activities that Match Selections option to 
filter the results. 

Additional Notes: None. 

 

Files Updated 

Deltek.Vision.Report.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Transaction Center 
Defect 503036: If you use multiple currencies in Vision and you tried to post an Invoice 
transaction file that had gain or loss entries in it (due to currency exchange rate differences), the 
posting process hung and would not complete. This applies only for invoice transaction files 
created in Transaction Entry, not for invoice files created in Interactive Billing or Batch Billing. 

Customers Impacted: This defect applies to Vision 7.2, 7.3, and 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Posting.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Transaction Entry and Transaction Posting 
Defect 479344: When the Unit Table field on the Accounting tab of the Project Info Center was 
set to <DEFAULT>, the Unit Table in Unit Transaction Entry did not automatically populate with< 
DEFAULT>.  
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Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: You must manually select the <DEFAULT> unit table in Unit 
Transaction Entry.  

Additional Notes: None. 

Files Updated 
Deltek.Vision.DataEntryGlobals.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Utilities 

Advanced Utilities » Data Import 
Defect 521781: When importing contacts linked to clients, if validation indicated an error for a 
duplicate record, the error report displayed the Client ID/Number. The error report now displays 
the Client Name.  

Customers Impacted: This defect applies to clients using Deltek CRM 2.1 with Vision 7.4. 

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 
Deltek.Vision.ImportUtility.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 521782: An error message displayed when contacts where a State description was used 
instead of the State Code.

 

Customers Impacted: This defect applies to Vision 7.4.
 

Workaround Before Fix: Use the State Code in the file instead of the Description.
 

Additional Notes: None.
 

Files Updated 

Deltek.Vision.ImportUtility.Server.dll
 

Other Applications Affected 
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Database Changes 
 

System File Dependencies 
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Software Issues Resolved 
Accounting » Accounts Receivable » Invoice Review 

Defect 485464: When you entered a client on the Invoice Review form, you had to click Refresh 
for the client's information to populate in the grid. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ARReview.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

Billing 

Defect 501243: This issue applies if your Vision report server is located in a different time zone 
than some or all of your Vision users' machines. The time stamp on the Billing Backup report 
displayed the time based on the time zone of the Vision report server instead the time zone of a 
user's client machine. 

Customers Impacted: This applies to Vision 7.4. 

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportingInvoice.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Info Center » Opportunities 

Defect 499294: In Screen Designer for the Opportunity Info Center, when you moved fields from 
one standard tab to the Competition tab, the fields were now missing from the Opportunity Info 
Center. In Configuration » User Defined Components, the tab that was now referenced for the 
missing fields was "ultratabpagecontrol1."  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.OpportunityInfoCenter.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Planning 

Defect 500559: When a plan had multiple mapped projects, the overhead cost calculation was 
incorrect because the overhead was not combined for all mapped projects. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ResourcePlanning.client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 502224: When a Plan with a Task Dependency relationship had a parent row that was a 
predecessor or successor to any other row, the invalid relationship would result in an error. This 
has been fixed so the plan is now loaded on the Schedule tab of Project Planning but does not 
include the invalid dependency relationships.  

Customers Impacted: This defect applies to Vision 7.4. 
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Workaround Before Fix: None. 

Additional Notes: None. 

 Files Updated 

Deltek.Vision.ResourcePlanning.Client.DLL 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Planning » Project Planning 

Defect 264697: When shifting dates on the Labor tab of Project Planning for a plan that had 
assigned resources, the Comp. amount did not move to accommodate the change in dates.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ResourcePlanning.Client.DLL 

Deltek.Vision.ResourcePlanning.Data.Client.DLL 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Reporting » Project Planning 

Defect 489600: When a calculated field was created for the Labor Resource Forecast report 
using the [Total Monthly Plan Hours] field, the following error occurred:  
Invalid field '[Plan Hours Beyond]' type for calculation. Text [fields] can only be used in 
conditions. They cannot be used in calculations. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Include the fields in the calculation as report columns and then export 
to Excel to create the calculated field.  

Additional Notes: None. 
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Files Updated 

Resource Planning Forecast.rdl 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Text Editor 

Defect 500834: When you right-clicked a misspelled word that was similar to a word that was 
added to the dictionary, you received an error. 

Customers Impacted: This defect applies to Vision 7.3 and 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

tx21_bmp.flt 

tx21_css.dll 

tx21_doc.dll  

tx21_dox.dll  

tx21_gif.flt  

tx21_htm.dll  

tx21_ic.ini  

tx21_jpg.flt  

tx21_pdf.dll  

tx21_png.flt  

tx21_rtf.dll  

tx21_tif.flt  

tx21_xml.dll  

TXDocumentServer.dll  

TXDocumentServer.Windows.Forms.dll  

txic.dll  

txkernel.dll  

txpdf.dll  

TXSpell.dll  

TXSpell.Windows.Forms.dll  
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TXTextControl.dll  

TXTextControl.Server.dll  

TXTextControl.Windows.Forms.dll  

txtools.dll  

TXSpell.resources.dll 

TXTextControl.resources.dll 

 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 500837: The font and size that are specified in configuration are not honored when you 
insert a new line in the Text Editor dialog box. 

Customers Impacted: This defect applies to Vision 7.3. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

FrameworkReportSystemCode.Xml 

Deltek.Framework.ExternalReferences.Client.dll 

Deltek.Framework.ControlDialogs.Client.dll 

 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Time and Expense » Timesheet 

Defect 501241: This issue applies if your Vision report server is located in a different time zone 
than some or all of your Vision users' machines. The time stamp on the Detailed Timesheet 
report displayed the time based on the time zone of the Vision report server instead the time zone 
of a user's client machine. 

Customers Impacted: This applies to Vision 7.4. 

Workaround Before Fix: None.  
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Additional Notes: None. 

Files Updated 

Timesheet.rdl 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

VisionXtend 

Defect 484322: This applies if you use VisionXtend. The new columns that were added in Vision 
7.3 to the Contract Details table were missing from the API schema, which prevented the 
columns from being updated and inserted in Vision. 

Customers Impacted: This defect applies to Vision 7.3 and 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Projects_Schema.xsd 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Cumulative Update 04 — Released April 17, 2015 

Software Enhancements 

Upgrading Custom Reports in Your Vision Database to the Latest RDL 
Schema 
On the Custom Reports tab in Utilities » Report Administration, a new Upgrade option has 
been added to the toolbar of the Load Custom Reports grid. Use this option to upgrade custom 
reports to the Microsoft SQL Server Reporting Services RDL 2010 schema that is the only 
schema that Vision 7.4 supports. This option applies only if your custom reports are already 
saved in your Vision 7.4 database and only for custom reports that have an RDL 2008 schema. 
The upgrade process opens the report, upgrades the report schema, resaves the report in the 
Vision database, and uploads the report to the Vision report server. 

The new Upgrade option is different from the Apply Schema Update to Customer Report File 
section on the Custom Reports tab in the Report Administration utility. The Apply Schema 
Update to Customer Report File section allows you to upgrade the RDL schema from RDL 
2008 to RDL 2010 for custom reports that are stored on a local machine and they are not yet 
saved in your Vision database. 

To upgrade custom reports that are saved in your Vision 7.4 database with an RDL 2008 
schema to the RDL 2010 schema, complete the following steps: 

1. From the Vision Navigation menu, click Utilities » Report Administration. 
2. On the Report Administration form, click the Custom Reports tab. 
3. On the Custom Reports tab, click the Upgrade option on the toolbar of the Load Custom 

Reports grid. 

 The Upgrade option displays on the toolbar only if you have a saved custom report in 
the Vision database. 

 If all your existing custom reports already use the latest RDL 2010 schema, you 
receive the following message: "All existing custom reports stored in your database 
are already using the latest schema." 

4. Click Yes on the dialog box that says: "This will upgrade all existing custom reports 
currently stored in your database to the latest schema. Would you like to continue?" This 
starts the upgrade. 

 During the upgrade, Vision backs up the custom reports that are saved in the Vision 
application server’s Report\Backup folder. 

 When the upgrade finishes, you receive the following message: "All custom reports 
have been successfully upgraded to the latest schema." 

 A log file—RDLProcessing.log—is saved in the Vision application server's 
Report\Backup\<database name> folder. Check the log file for any errors. 

For more information, see the Deltek Vision 7.4 Custom Reports and Microsoft SQL Server 
Reporting Services guide. 
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Files Updated 
Deltek.Framework.ReportAdministration.Client.dll 

Deltek.Framework.Report.Server.dll 

DeltekVisionCMD.exe 

Performance Management 
The Configuration tab in Configuration » General » Performance Management was enabled 
for users of the Deltek First Vision Essentials cloud version of Vision. The Configuration tab is 
now disabled for users of the Deltek First Vision Essentials cloud version of Vision. 

Files Updated 
Deltek.Framework.PerformanceDashboard.Client.dll 

Software Issues Resolved 

Accounting » Accounts Payable » Create Voucher from PO 
Defect 489193: When you posted a voucher in Create Voucher from PO, you received an error 
message and the voucher did not post if a line item entered for a purchase order had its cost 
distribution split between more than one project. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Set the cost distribution to only one project per line item/row. Create 
multiple item rows for the same item so 100% of that row is for one project. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Posting.Server.dll 

Deltek.Vision.PORoutines.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Billing 
Defect 485652: This issue applies if you do not have invoice approvals enabled and you have 
percent complete or cumulative units fee type billing for a project. The Prior Fee Billing field on 
the Fees tab in Billing Terms was not updated after invoices were accepted. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Enable invoice approvals using the default approval process that is 
provided by Vision. You do not have to assign the default approval process to any project’s billing 
terms. You only need to enable the feature. 
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Additional Notes: None. 

Files Updated 
Deltek.Vision.Billing.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 486067: When the Hide Detail check box was selected on the Billing Phase Grouping 
dialog box on the Fees tab of Billing » Billing Terms, the current fee billing of each phase group 
was copied from the previous fee billing. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Edit the fee directly in Microsoft Word. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.ReportingInvoice.Server.dll 

InvoiceFee.rdl 

 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 478691: When a project’s expense or consultant terms (on the Exp/Con/Unit tab in Billing 
Terms) had a multiplier and the terms also had the Show Purchase Order Line Item Detail 
check box selected, but did not have the Show Multiplier check box selected, Billing invoices 
displayed the correct billed amount, but the unit rate on the invoice was not updated to reflect the 
multiplied amount. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Billing.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Billing » Invoice Approvals 
Defect 485196: The contact and client names were not showing on a billing invoice if you 
updated fees for the invoice in the Invoice Approvals application.  

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: Make any change to billing terms in Interactive Billing and the invoice 
will correct itself. Or, use Interactive Approvals to update fees. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.InvoiceApprovalSummary.Client.dll 

Deltek.Vision.Billing.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Billing » Interactive Billing 
Defect 478692: For purchase order line items in Billing » Interactive Billing, you could modify 
the quantity of an item but not the unit price. This was changed to allow modification of quantity 
and unit price, both of which will then display on the invoice. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.interactiveBilling.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Configuration » Approvals » Approvals Configuration 
Defect 474661: Some scheduled alerts (email and dashboard) were not sent for approval 
workflow steps if you entered a language for an alert (in the Language field in the Step Actions 
grid on the Workflow tab in Approvals Configuration). None of the French Canadian scheduled 
alerts were sent for purchase orders. None of the Spanish scheduled alerts were sent for 
inventory item request. No past due notification were sent for any of the applications for any 
language, except for purchase orders in the French European language. 
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Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Workflow.Server.dll 

Deltek.Vision.ApprovalsEngine.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Configuration » Organization » Individual 
Defect 484818: You could enter not duplicate approval roles on the General tab of 
Configuration » Organization » Individual. This restriction has been removed. However, if you 
have duplicate approval roles for an organization, Vision will not allow you to use the same 
employee for the role. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.OrgIndividual.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Configuration » Workflow » Scheduled Workflows 
Defect 496083: Conditions for a scheduled workflow for approval workflows were removed in the 
Scheduled Workflows grid on the Scheduled Workflow form in Configuration » Workflow » 
Scheduled Workflows if an approval workflow had more than one reminder notification entered 
for it on the Workflow tab in Configuration » Approvals » Approvals Configuration. Conditions 
were also removed in Scheduled Workflows Configuration if an existing approval workflow with 
only one reminder notification was edited by adding additional reminder notifications. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Add only one reminder notification for an approval workflow. If you 
have existing approval workflows with more than one reminder notification, delete all scheduled 
notification and save the change. Then add back the scheduled notifications, but add only one 
reminder notification. 
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Additional Notes: None. 

Files Updated 
Deltek.Framework.ApprovalItems.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Installation 
Defect 484822: You could only configure the credit card Status field as Active in Configuration 
» Accounting » Credit Cards. The Dormant option was not available.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

DeltekVision74GACU004.sql 

Other Applications Affected 
 

Database Changes 
If Vision detects incorrect data in the CFGCreditCardStatusData and 
CFGCreditCardStatusDescriptions tables, the default data is automatically reloaded.  

System File Dependencies 

Login/Off 
Defect 487356: When you opened Vision 7.4 for the first time, you were unable to enter your 
user ID and password in the Vision login screen if the Automatically Check Windows 
Authentication Check Box in Vision Login Screen check box was selected in the Vision 
Weblink utility. The User ID and Password fields were empty and not enabled. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Clear and then reselect the Windows Authentication check box in 
Vision login screen. The User ID field will populate, and you can enter your password. 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Frame.Client.dll 

Other Applications Affected 
 

Database Changes 
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System File Dependencies 
 

Mobile Time 
Defect 488252: In Touch Time and Expense, you received the following error message "There 
was no response from the server. Need to refresh the application." under the following conditions:  

 You opened a period timesheet in Time and clicked the + button to add a second project 
to the timesheet.  

 The project had few phases (work breakdown structure level 2) and many tasks (work 
breakdown structure 3). 

Customers Impacted: This defect applies to Deltek Touch version 1.3.3. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Planning 
Defect 486408: When shifting dates on the Labor tab of Project Planning for a plan that had no 
assigned resources, the compensation related amounts did not move to accommodate the 
change in dates.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ResourceGlobals.Client.dll 

Deltek.Vision.ResourcePlanning.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Defect 485233: When trying to budget resources on the Labor tab of Project Planning, the plan 
did not automatically calculate the planned cost and/or planned bill. The issue occurred with both 
generic and named resources.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Click the Refresh Rates option for Labor Cost and Labor Billing on the 
Rates tab of Project Planning. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.ResourcePlanning.Data.Client.DLL 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Proposals » Custom Proposals 
Defect 482304: When attempting to merge a custom proposal template with very long text (for 
example, a 70+ page document), the following errors occurred:  

 The record you are trying to save has been updated by another user since you first 
selected it. In order to save your changes, you must re-select the record and make your 
changes again. 

 The underlying connection was closed: A connection that was expected to be kept alive 
was closed by the server. 

 Object reference not set to an instance of an object. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.MergeBO.Common.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Defect 483765: When merging data with custom proposals, carriage returns and hard returns 
displayed.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 
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Additional Notes: None. 

Files Updated 
Deltek.Vision.MergeBO.Common.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 

Purchasing 
Defect 474169: Alerts and notifications for approval workflows could be sent a day earlier or later 
than expected, or some users could receive them on different days. This was possible if users 
accessed Vision from a workstation that was in a different time zone than the Vision application 
server. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Workflow.Server.dll 

Deltek.Vision.Approvals.Server.dll 

Deltek.Vision.ApprovalsEngine.Server.dll 

Deltek.Vision.Workflow.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Purchasing » Purchase Orders 
Defect 485327: This issue applies if you: 

 Set up approval workflows in Configuration » Approvals » Approvals Configuration to 
approve records in the Purchasing application.  

 Set up conditions for approval workflow steps that require Vision to skip to the next step 
when a step's condition is not met. 

During the approval process for a Purchasing record, if the conditions for approval steps one and 
two were not met, Vision should have skipped to step 3, but it did not. The approval process 
remained in step 2, and the step 2 approver was assigned to approve the record.  

IMPORTANT CU INSTALLATION INSTRUCTIONS: After you install the CU 04 software: In 
Configuration » Approvals » Approvals Configuration, you must edit and save any approval 
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workflows with steps that have conditions that required Vision to skip to the next step when a 
step's conditions are not met. Make any small change to the approval workflow, such as changing 
the entry in the Default Due Date (Number of Days after Creation Date) field on the General 
tab of the Approvals Configuration form. After you save the change, any erroneous entries for the 
approval process in Configuration » Workflows » User Initiated Workflows are fixed. Then 
edit and save the approval workflows again to reverse the small change you made.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: In Configuration » Approvals » Approvals Configuration, edit any 
approval workflows that have steps with conditions that skip to the next step when the conditions 
are not met. In the Approval Steps grid on the Workflow tab, change the entry in the Action if 
Conditions Not Met field from Skip to Next Step to Approve Step. For approvals that begin 
after you make these changes, Vision will automatically approve the steps for which the 
conditions are not met and move past these steps. However, any alerts that you set up for the 
approval steps with the conditions will be sent, even though you want those steps skipped 
completely (with no alerts sent). 

Additional Notes: None. 

Files Updated 

Deltek.Framework.ApprovalItems.Client.dll 

Deltek.Framework.Workflow.Server.dll 

Deltek.Vision.ApprovalsEngine.Server.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Purchasing » Purchase Requisitions 
Defect 485295: This issue applies if you have an approval workflow for purchase requisitions 
whose final step has a condition that is configured to approve the step if the condition is not met. 
When the last step of the approval process for a purchase requisition was not met, the state 
correctly changed to Approved, but the status remained Submitted. The approval process could 
not complete. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: In Approvals Configuration, for the final step of the purchase 
requisitions approval workflow, select Mark as Final Approved in the Action if Condition Not 
Met field in the Approval Steps grid on the Workflow tab. An approval alert will not be triggered for 
this step if the condition is not met, so you must insert a Completed Notification action in the Step 
Actions grid for the final step of the workflow and make the notification look like an approval alert.  

Additional Notes: None.  

Files Updated 
Deltek.Vision.Approvals.Server.dll 

 

Other Applications Affected 



Cumulative Update 04 — Released April 17, 2015 

 

Release Notes: Technical Considerations 181 

 

 

Database Changes 
 

System File Dependencies 
 

Reporting 
Defect 487103: After you upgraded to Vision 7.3, some reports that you had saved as favorites 
displayed HTML tags for memo fields.  

The reports are: 

 Client List 

 Contact List 

 Contract Management 

 Employee List 

 Lead List 

 Marketing Campaign List 

 Opportunity Forecast 

 Opportunity List 

 Project Earnings 

 Project List 

 Vendor List 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: Recreate the saved favorite reports. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Globals.Common.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

 

Text Editor 
Defect 486060: When using Time & Expense » Timesheet, an error was encountered when the 
window size of Vision is too small to display the Comment memo field. Because the Comment 
memo field automatically resizes to a width that is too narrow while trying to fit in the Vision 
window.  
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Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Before using Time & Expense » Timesheet, resize the Vision window 
wider so that the Comment memo field has enough space to be displayed with a wider size. 

Additional Notes: None. 

Files Updated 
Deltek.Framework.ExternalReferences.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
 

Time and Expense » Timesheet 
Defect 495401: This applies if you use the French (Canada) language in Vision. Project, client, 
and labor code information in the section in the lower left corner of a timesheet was truncated and 
not completely visible due to narrow field widths. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
Deltek.Vision.Timekeeper.Client.dll 

Other Applications Affected 
 

Database Changes 
 

System File Dependencies 
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Cumulative Update 03 — Released March 13, 2015 

Software Enhancements 

Info Center List Reports 
A new Only List <xxxxxx> That Match Selections check box was added to the General tab of 
the options dialog box for the following Info Center list reports: 

 Account List  

 Client List 

 Contact List 

 Employee List 

 Leads List 

 Marketing Campaign List 

 Opportunity List 

 Opportunity Hit Rate List 

 Project List 

 Text Library List 

 Vendor List 

 UDIC List 

This check box applies for the grid that you select in the Grid Type field to the left of the check 
box. The name of the check box matches the grid that you select in the Grid Type field. For 
example, for the Employee List report, when you select Licenses in the Grid Type field, the 
name of the check box is Only List Licenses That Match Selections. 

When you select this check box, the report will include only the records that match the advanced 
search criteria that you enter in the record lookup dialog box for the grid field. In addition, the grid 
columns in the report will display only the grid field data that matches the advanced search 
criteria, instead of displaying all the different entries in the grid field for a record. 

For example, if you want a list of all the employees who have one specific type of professional 
license and you want to see only that one type of license listed on the report, you must select the 
new check box. If you do not select the check box, the report will list only the employees who 
have the one type of license, but the report will list all the different licenses that each employee 
has. 

 

Example: 

You want to see a list of all active employees that have a Registered Architect license and you 
want to see only Registered Architect in the License column of the report. (You enter an 
employee’s licenses in the License grid on the Experience tab in the Employee Info Center.) 

1. From the Navigation menu, click Reporting » Employee.  

2. On the Employee Reporting form, click in the Options field for the Employee List report. 

3. On the General tab of the Employee List Options dialog box, enter Licenses in the Grid 
Type field, and select the Only List Licenses That Match Selections check box. 
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If you do not select the check box, the report will include only the employees with a 
Registered Architect license type. However the report will list all the license types an 
employee has. 

4. On the Columns tab of the Employee List Options dialog box, select the Licenses - 
License column, and click Apply. 

5. On the Employee Reporting form, click the Search icon in the Selection field for the 
Employee List report. 

6. In the Employee Lookup dialog box, select Advanced in the Display Type field. 

7. In the Search Criteria grid, enter a row for each of the following criteria and click Apply: 

 Search Field = Status, Operator = Equals, and Search List = Active 

 Search Field = License, Operator = Equals, and Search List = Registered Architect 

8. Preview or print the report. 

Only employees who have a Registered Architect license are included on the report. Only 
Registered Architect displays in the License column in the report. 

 

Files Updated 
Deltek.Framework.Lookup.Client.dll 

Deltek.Framework.Report.Client.dll 

Deltek.Vision.Report.Client.dll 

Account List.rdl 

Client List.rdl 

Contact List.rdl 

Employee List.rdl 

Lead List.rdl 

Marketing Campaign List.rdl  

Opportunity List.rdl 

Project List.rdl 

Text Library List.rdl 

UDIC List.rdl 

Vendor List.rdl 

Deltek.Vision.ReportingClient.Server.dll 

Deltek.Vision.ReportingLead.Server.dll 

Deltek.Vision.ReportingMarketingCampaign.Server.dll 

Deltek.Vision.ReportingOpportunity.Server.dll 

Deltek.Vision.ReportingVendor.Server.dll 
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Software Issues Resolved 

Language Translations 
This applies if you use languages other than English in Vision. A number of language translations 
that were missing were fixed. This includes the specific defects listed below as well as other 
unlisted language translation fixes. 

Reload all Vision Reports 
You must reload all Vision reports for each non-English language that you have enabled in 
Vision. Use the Report Administration utility to reload reports. 

Some of the Language Issues Resolved 
Defect 481329: On the Billing Backup tab in Billing » Billing Terms, the A/P Voucher 
Description check box label was not translated to both of the French languages, Spanish, and 
Dutch. Also, the drop-down list in the Include Labor for field was not wide enough to display 
complete text for options in the list. 

Customers Impacted: This issue applies if you use languages other than English in Vision 7.2 
and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.BillingTerms.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 481331: This defect applies if you log onto Vision using the French (Canadian) language 
link. On the Fees tab in Billing » Billing Terms, the Prior Fee Billing field was not completely 
visible. It was covered by the field label. 

Customers Impacted: This applies to Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.BillingTerms.Client.dll 

Other Applications Affected 

 

Database Changes 
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System File Dependencies 

 

Defect 472753: The text for the Print Invoices without Current Activity field label in Billing » 
Billing Terms was changed to Print Invoices with Zero Amount Due but the translation was 
not updated accordingly.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportLabels.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 473760: When viewing Prior Invoices as the Section Order on the Sections tab in Billing 
» Invoice Template, the following labels were not translated: Total Prior Invoices, Subtotal, 
Fee Amount, and Other Amount. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.BillingTemplateEditor.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

Defect 472737: The Enable Pre Invoices, Pre Invoice Offset Account, and Overtime 
Indicator fields were added to the Miscellaneous tab of Configuration » Billing » General but 
were not translated. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
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Deltek.Vision.ReportLabels.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
 

Defect 474345: The Help button on the Edit Cost Group dialog box (Info Center » 
Opportunities » Fee Estimate Tab » Functional Groups Grid » Create Phases Grid button) 
was not translated. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.dlgFESelectPhases.Client.dll 

Deltek.Vision.OpportunityInfoCenter.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 
Defect 481332: This applies if you use the Dutch or French language in Vision. For the Contract 
Management, Project List, or CRM Project Summary reports in Reporting » Projects, the 
Charge Type label on the Columns tab in the Report Options dialog box was not translated to the 
correct language. 

Customers Impacted: This defect applies to Vision 7.1 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportLabels.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Defect 481717: If you use languages other than English in Vision, the Timesheet report heading 
was not translated to other languages. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ReportLabels.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

Defect 473243: In User Options, the Allow field selection for Info Center dashparts check box 
label was not translated into languages other than English. 

Customers Impacted: This issue applies if you use languages in Vision other than English in 
Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.dlgUserPreferences.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Accounting » Bank Reconciliation 
Defect 482284: The amount of the in-process account for employee expense payment checks 
that had tax amounts was different on the posting log than it was on the Bank Reconciliation 
screen. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 
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Deltek.Vision.BankReconciliation.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

Configuration 
Defect 482341: In Workflow Configuration, when you used a hard return (Enter key on your 
keyboard) to add a space between lines in an email alert, the character Â displayed instead of a 
blank line. 

Customers Impacted: None. 

Workaround Before Fix: Use a soft return (Shift + Enter).  

Additional Notes: None. 

Files Updated 

Deltek.Framework.SysEmail.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Human Resources » Payroll 
Defect 483102: The pay stub amounts for hourly employees were inaccurate when the Print pay 
rates for hourly employees option was selected after upgrading to Vision 7.4.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

EarningsHourly_Three.rdl 

EarningsHourly_Two.rdl 

Other Applications Affected 

 

Database Changes 
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System File Dependencies 
 

 

Defect 482098: Running the Draft Payroll Journal multiple times without exiting the payroll 
processing screen resulted in the following error message: “Not enough storage space is 
available to process this command.”  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Exit and re-open payroll. 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Report.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Info Center » Clients 
Defect 479755: On the Contacts tab of the Client Info Center, you could select more than five 
contacts per client to synchronize with the Ajera application. Vision should have provided an error 
message when more than five were selected. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ClientInfoCenter.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Info Center » Projects 
Defect 479756: On the Contacts tab of the Project Info Center, you could select more than five 
contacts per project to synchronize with the Ajera application. Vision should have provided an 
error message when more than five were selected. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.ProjectInfoCenter.Client.dll 

Other Applications Affected 

Database Changes 

 

System File Dependencies 
 

 

Planning 
Defect 484801: You could not use the Actions » Import Plan from MS Project or Export Plan 
to MS Project toolbar options in Planning when running Microsoft Project versions 2010 or 2013. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Microsoft.Office.Interop.MSProject.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Reporting 
Defect 480656: After you upgraded to Vision 7.3, some reports that you had saved as favorites 
displayed HTML tags for memo fields. 

This applies for the following reports: 

 Client List 

 Contact List 

 Contract Management 
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 Employee List 

 Lead List 

 Marketing Campaign List 

 Opportunity Forecast 

 Opportunity List 

 Project Earnings 

 Project List 

 Vendor List 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: Recreate the saved favorite reports. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Globals.Common.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

Transaction Center 
Defect 479350: When you voided an A/P disbursement check in Accounting » Void Check, this 
caused an out-of-balance posting. The difference was the tax amount. 

Customers Impacted: This defect applies to Vision 7.2 and later releases if you use taxes. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Posting.Server.dll 

Deltek.Vision.VoidCheck.Server.dll 

DeltekVision74GACU002.sql 

Other Applications Affected 

Database Changes 

Code was added to insert the PP C tax records into the LedgerAPTax table. 

System File Dependencies 
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Transaction Center » Transaction Entry and Transaction Posting 
Defect 471813: This issue applies if you use multiple companies, pre-invoices, and taxes in 
Vision. You were unable to enter cash receipts for pre-invoices that had taxes if the tax code 
account that was associated with the tax amount on the pre-invoice was mapped on the A/R 
Mapping Accounts tab in Configuration » Accounting » Accounts Receivable. You received 
the following error: "An Invoice Number is required with this AR Account." 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.DataEntry.Client.dll 

Deltek.Vision.DataEntryGlobals.Client.dll 

Deltek.Vision.DataEntryGlobals.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

 

Touch CRM 
Defect 484930: In Touch CRM, you received the following error when you clicked Opportunities 
on the slideout menu and then clicked the Mine tab: "There was no response from the server. 
Need to refresh the application." 

Customers Impacted: This applies to Touch CRM and Vision 7.3 and later versions. 

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 

Deltek.Vision.VisionServices.Server.DLL 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Cumulative Update 02 — Released February 13, 
2015 

Regulatory Enhancements 

2015 District of Columbia Income Tax Withholding 
The percentage withholding method, effective Jan. 1, 2015, was revised by the Office of Tax and 
Revenue. This supersedes the withholding method that was finalized Jan. 6. 

The new method reflects a cost of living adjustment. The standard deduction should continue to 
be excluded in withholding calculations, and the personal exemption increases from $1,725 to 
$1,775. 

For more information, refer to: 

http://otr.cfo.dc.gov/sites/default/files/dc/sites/otr/publication/attachments/FR-
230_012215_v4.pdf. 

Files Updated 

Deltek.Vision.PayrollBO.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

2015 Louisiana SUTA Electronic Filing 
Louisiana specifications have been modified in accordance with the Social Security 
Administration’s guidelines in an effort to minimize required data. 
See http://www.laworks.net/Downloads/UI/WageUploadInstructions.pdf for more information. 

To accommodate this change, Vision added the following to the Miscellaneous tab of the 
Quarterly Processing screen: 

 Multiple County Industry — Enter 1 in this field if your company has employees in more 
than one county/industry included in Form BLS 3020 (Multiple Worksite Report); 
otherwise, leave the field blank. 

 Multi-State Employers — Select this check box if your company has employees 
reporting wages to Louisiana and to other states. 

RA, RE, and RS records have also been modified, with the following details: 

RA Record 

 Secured File Transfer Protocol — POS 3–11. Required — Submitter’s FEIN number. 

 Filler — POS 12–216. Fill with blanks. 

http://otr.cfo.dc.gov/sites/default/files/dc/sites/otr/publication/attachments/FR-230_012215_v4.pdf
http://otr.cfo.dc.gov/sites/default/files/dc/sites/otr/publication/attachments/FR-230_012215_v4.pdf
http://www.laworks.net/Downloads/UI/WageUploadInstructions.pdf
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 State Abbreviation — POS 340–341. Optional — Enter the state for the organization to 
whom the notification of unprocessable data should be sent. Use a postal abbreviation as 
shown in Appendix A. For a foreign address, leave blank. 

 Contact Telephone — POS 423–437. Optional – Enter the telephone number for the 
contact name. Left justify and fill with blanks. 

 Filler — POS 443-445. Fill with blanks. 

 Secured File Transfer Protocol — POS 446–485. Required – Submitter’s email 
address for SFTP. 

 Filler — POS 486-488. Fill with blanks. 

RE Record 

 Agent Indicator — POS 7. Optional — Fill with blanks. 

 Agent for EIN — POS 17–25. Fill with blanks. 

 Establishment Number — POS 27–30. Fill with blanks. 

 Other EIN — POS 31-39. Fill with blanks. 

 Employer State Abbreviation — POS 163–164. Optional — Enter the employer state. 
Use postal abbreviation. 

 Foreign State/Province — POS 179–201. Fill with blanks. 

 Foreign Postal Code — POS 202–216. Fill with blanks. 

 Country Code — POS 217–218. Fill with blanks. 

 Tax Jurisdiction Code — POS 220. Fill with blanks. 

 Multiple County Industry — POS 250. Required — If employing entity is currently a 
multiple worksite reporter and has chosen to submit Form BLS 3020 (multiple worksite 
report) as a fixed file format via electronic upload. Enter “1” if this firm has employees in 
more than one county/industry included in this report; otherwise, enter “0.” 

 Multi-state Employers Indicator — POS 254. Required — If any of your employees 
report wages to Louisiana and to other states; enter a “Y” if yes; enter a “N.” 

 Blank — POS 255–512. Leave blank. 

RS Record 

 Social Security Number (SSN) — POS 10–18. Required — Enter the employee’s social 
security number. If an employee has not received a SSN, do not include a wage record 
for him/her on the report with a fictitious number. Have him/her call 1‐800‐772‐1213 or 
visit the local social security office to obtain a SSN. Once a valid SSN is issued, file an 
amended wage and tax report. Duplicate SSNs will not be accepted within the same 
employer’s record. 

 Suffix — POS 69-72. Fill with blanks. 

 Location Address — POS 73–94. Fill with blanks. 

 Delivery Address — POS 95–116. Fill with blanks. 

 City — POS 117-138. Fill with blanks. 

 State Abbreviation — POS 139–140. Fill with blanks. 

 Zip Code — POS 141–145. Fill with blanks. 

 Zip Code Extension — POS 146–149. Fill with blanks. 
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 Foreign State/Province — POS 155–177. Fill with blanks. 

 Foreign Postal Code — POS 178–192. Fill with blanks. 

 State Quarterly Taxable Wage — POS 214–224. Right justify and zero fill or fill with 
blanks. 

 Number of Weeks — POS 225–226. Fill with blanks. 

 State Employer Account Number — POS 248–267. Fill with blanks. 

Files Updated 

Deltek.Vision.pyFormQuarterly.Client.dll 

Deltek.Vision.QTRMagMedia.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Software Issues Resolved 

Accounting » Project Review 
Defect 479981: Purchase requisitions and purchase orders did not display on the Purchasing tab 
in Accounting » Project Review as they should have in any of the following situations: 

 Purchase requisitions and purchase orders that were entered and approved in versions 
earlier than Vision 7.4 did not display.  

 Purchase orders did not display if an approval workflow was not enabled for purchase 
orders.  

 Purchase requisitions did not display if an approval workflow was not enabled for 
purchase requisitions.  

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Billing 
Defect 474537: When you selected Totals and Section Totals in the Currency Display field on 
the Misc tab of the Invoice Template Editor form for a credit memo template, the totals and 
section totals did not display with a currency symbol or currency code. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 



Cumulative Update 02 — Released February 13, 2015 

 

Release Notes: Technical Considerations 197 

 

Files Updated 

Deltek.Vision.ReportingInvoice.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 474538: Billing credit memos incorrectly displayed 0.00 in the invoice total header when 
you selected the Print Total in Invoice Header check box on the Totals tab in Billing » Invoice 
Template Editor for a credit memo template. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

CreditInvoice.rdl 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Billing » Billing Terms 
Defect 474350: Phase groups that you entered in the grid on the Billing Phase Grouping dialog 
box (that opens when you click the Phase Grouping button on the Fees tab in Billing Terms for a 
phase) were deleted from the grid even though you used these phase groups to make entries in 
the Billing Phases grid on the Fees tab.  

Customers Impacted: This defect applies to Vision 7.4.  

Workaround Before Fix: None.  

Additional Notes: None. 

Files Updated 

Deltek.Vision.BillingTerms.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Info Center 
Defect 475554: Text that you entered in memo fields in the Info Center (such as in the Notes 
field in the Contacts Info Center) was not wrapping correctly.  

Customers Impacted: This defect applies to Vision 7.3 and later releases. 

Workaround Before Fix: Use the bottom scroll bar, or open the Text Editor dialog box.  

Additional Notes: None. 

Files Updated 

Deltek.Framework.Controls.Client.dll 

Deltek.Framework.ExternalReferences.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Info Center » Employees 
Defect 475671: The drop-down list in the Cost Table and Pay Table fields in the Cost and Pay 
Rates section of the Time tab in the Employee Info Center included tables with a currency that did 
not match the functional currency of the employee's home company. Only tables that match the 
functional currency of an employee's home company should display in the list. 

Customers Impacted: This defect applies to Vision 7.0 and later releases. 

Workaround Before Fix: Log in to the employee's home company to select a cost rate table. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.EmployeeInfoCenter.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Kona 
Defect 479762: Kona was sometimes not launching within Vision when you used Internet 
Explorer 11. WAAD Authentication (Windows Azure Active Directory) was sometimes not working 
when you signed timesheets in Vision. 
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Customers Impacted: This defect applies if you use Internet Explorer 11 or WAAD 
Authentication in Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Framework.Globals.Server.dll 

Deltek.Framework.SysLogin.Server.dll 

Deltek.Vision.VisionServices.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Defect 481123: Kona attempted to launch, even when no credentials were supplied on the Misc. 
tab of User Options. It appears as if you can log into Kona, but you cannot. 

Customers Impacted: This defect applies if you use Vision 7.4 and Kona. 

Workaround Before Fix: Enter your Kona credentials in User Options. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.FrameUI.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Microsoft Office Desktop Integration 
Defect 477731: If the MODI add-in for Microsoft Word was enabled and you tried to use the 
Adobe “Word to PDF” add-in feature, the Adobe add-in caused Word to stop working. However, 
the PDF was still created. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

DeltekMicrosoftOfficeAndDesktopIntegration.msi 

Other Applications Affected 
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Database Changes 

 

System File Dependencies 

 

Navigator 
Defect 479766: If you had a certain combination of access rights, you received a system error 
when you displayed a Navigator plan, opened the Project Settings menu, and clicked Plan 
Settings.  

Customers Impacted: This defect applies to Navigator 1.9 and later versions. 

Workaround Before Fix: None. 

Additional Notes: None. 
 

Files Updated 

Deltek.Vision.VisionServices.Services.DLL 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Proposals 
Defect 475586: When you used the merge feature, additional spaces were inserted between the 
text and the bullets. 

Customers Impacted: This defect applies to Vision 7.3 and later versions. 

Workaround Before Fix: You can manually fix the spacing after the merge. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.MergeBO.Common.dll 

Deltek.Vision.MergeBO.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 



Cumulative Update 02 — Released February 13, 2015 

 

Release Notes: Technical Considerations 201 

 

Purchasing 
Defect 477273: This applies if you use approval workflows for Purchasing applications. 

The status of a purchase requisition (on the General tab of the Purchase Requisitions form) 
changed after you made an entry on the Vendors tab on the Purchase Requisitions form. The 
status should not have changed. 

The purchase requisitions, purchase orders, and request for price quotes that were approved 
before you installed Vision 7.4 incorrectly displayed Start in the State field on the General tab of 
the entry form. It should have been blank. 

Customers Impacted: This defect applies to Vision 7.4.  

Workaround Before Fix: None. 

Additional Notes: None. 
 

Files Updated 

Deltek.Vision.PriceQuoteRequest.Client.dll 

Deltek.Vision.PurchaseOrder.Client.dll 

Deltek.Vision.PurchaseRequest.Client.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Reporting 
Defect 474999: Previously, user-defined fields always displayed in the Reporting application as 
options on the Sorting/Grouping tab and the Columns tab in the report options dialog box for a 
report. Now, in Roles Security, you can select to hide user-defined fields, so they do not display 
on the Sorting/Grouping and Columns tabs for report options. 

In Configuration » Security » Roles, user-defined fields now display in the list of available fields 
to hide in the List Columns dialog box and the Group Fields dialog box.  

To access these dialog boxes for a report, complete the following steps: 
1. In Configuration » Security » Roles, open the Access Rights tab. 

2. In the Functional Area field, select Reports. 

3. In the Report Type field, select a report type. 

4. Clear the Full access to all reports check box. 

5. Click the Set Group/Column Access button. 

6. On the Report Group and Column Fields dialog box: 

 Click the Set Group Security Set option. In the group fields dialog box, the Available 
Group Fields list includes user-defined fields. 
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 Click the Set Column Security option. In the list columns dialog box, the Available 
Columns list includes user-defined fields. 

After You Install the CU 02 Release 

After you install the CU 02 release and you hide any user-defined fields on reports for security 
roles, users must save any favorite reports that included the user-defined fields that are now 
hidden. If the reports are not re-saved after you change access rights to the user-defined fields, 
these fields will continue to display in the Sorting/Grouping tab and the Columns tab in the report 
options dialog box. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.dlgSecReportingColumns.client.dll 

Deltek.Vision.dlgSecReportingGroups.client.dll 

Deltek.Vision.Report.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Reporting » Project 
Defect 474998: The Billing Amount column on the Project Detail report showed the currency 
code and currency symbol of the billing currency instead of the project currency. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: None. 

Additional Notes: The report does not look at the Use Billing Currency not Project Currency 
check box for the Reporting at Billing Rates setting on the Reporting tab in Configuration » 
Accounting » System Settings when displaying currency code. 

Files Updated 

Deltek.Vision.ReportingProject.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 
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Reporting » Project Planning 
Defect 479180: The calculations in the Detail Lines Sum Up Calc Amts column of the Project 
Planning Analysis report were incorrect for the Expense, Consultant, and Unit Lines rows if no 
labor assignments were assigned to the planning rows. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Add a labor assignment for the affected planning row. 

Additional Notes: None. 

Files Updated 

Resource Planning Analysis.rdl 

Deltek.Vision.ReportingResourcePlanning.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Transaction Center 
Defect 478282: When you posted an expense report with intercompany transactions, the debit 
that was posted to the project’s company was also posted to the intercompany suspense 
account. This created an unbalanced transaction for the project's company. 

Customers Impacted: This defect applies to Vision 7.3 and later releases. 

Workaround Before Fix: None. 

Additional Notes: None. 

Files Updated 

Deltek.Vision.Posting.Server.dll 

Other Applications Affected 

 

Database Changes 

 

System File Dependencies 

 

Utilities » Key Conversions » Phases 
Defect 477372: When you used the Key Conversion utility to change a phase number, the phase 
was then unmapped from the plan in Project Planning. 

Customers Impacted: This defect applies to Vision 7.4. 

Workaround Before Fix: Manually remap the plan. 
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Additional Notes: None. 

Files Updated 

DeltekVision74GACU002.sql 

Other Applications Affected 

 

Database Changes 

The following stored procedures were updated: 

 KeyConvertWBS2 

 KeyConvertWBS3 

System File Dependencies 

 



 

 

Deltek is the leading global provider of enterprise software and information solutions for professional 
services firms, government contractors, and government agencies. For decades, we have delivered 
actionable insight that empowers our customers to unlock their business potential. Over 14,000 
organizations and 1.8 million users in approximately 80 countries around the world rely on Deltek to 
research and identify opportunities, win new business, optimize resource, streamline operations, and deliver 
more profitable projects. Deltek – Know more. Do more.®  

deltek.com 

http://www.deltek.com/
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